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1. Mentions légales

« The mtPaint Handbook », Copyright (C) 2006-2009 Mark Tyler et Dmitry Groshev.

L’autorisation est accordée de copier, distribuer et/ou modifier ce document
selon les termes de la Licence de Documentation Libre GNU, Version 1.2
ou toute autre version ultérieure publiée par la Free Software Foundation ;
sans sections invariantes, sans textes de couverture avant et sans textes de couverture arrière.
de couverture arrière. Une copie de la licence est présentée ci-dessous :

Licence de documentation libre GNU

Version 1.2, novembre 2002

Copyright (C) 2000,2001,2002 Free Software Foundation, Inc.
51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA
Tout le monde est autorisé à copier et à distribuer des copies conformes de ce document de licence.
de ce document de licence, mais il est interdit de le modifier.

0. PRÉAMBULE

L’objet de la présente Licence est de rendre un manuel, un livre ou tout autre document fonctionnel et utile
« libre » au sens de la liberté : assurer à chacun la liberté effective de le copier et de le redistribuer, avec ou sans
modification, à titre commercial ou non commercial. En second lieu, cette Licence préserve pour l’auteur et
l’éditeur un moyen d’être crédités pour leur travail, tout en n’étant pas considérés comme responsables des
modifications apportées par d’autres.

Cette Licence est une sorte de copyleft, ce qui signifie que les travaux dérivés du document doivent eux-mêmes
être libres dans le même sens. Elle complète la Licence Publique Générale GNU, qui est une licence copyleft
conçue pour les logiciels libres.

Nous avons conçu cette Licence afin de l’utiliser pour les manuels de logiciels libres, car les logiciels libres ont
besoin d’une documentation libre : un programme libre doit être accompagné de manuels offrant les mêmes
libertés que le logiciel. Mais cette Licence n’est pas limitée aux manuels de logiciels ; elle peut être utilisée
pour tout ouvrage textuel, quel que soit son sujet ou le fait qu’il soit publié sous forme de livre imprimé. Nous
recommandons cette Licence principalement pour les ouvrages dont le but est l’instruction ou la référence.

1. APPLICABILITÉ ET DÉFINITIONS

La présente Licence s’applique à tout manuel ou autre ouvrage, quel qu’en soit le support, qui contient une
notice placée par le titulaire du droit d’auteur indiquant qu’il peut être distribué selon les termes de la présente
Licence. Une telle notice accorde une licence mondiale, libre de droits, illimitée dans le temps, pour l’utilisation
de ce travail dans les conditions énoncées dans le présent document. Le terme « Document », ci-dessous, fait
référence à un tel  manuel ou ouvrage. Tout membre du public est  un licencié, et  est  désigné par le terme
« vous ». Vous acceptez la licence si vous copiez, modifiez ou distribuez le travail d’une manière nécessitant
une autorisation en vertu de la loi sur le droit d’auteur.

Une « Version modifiée » du Document désigne tout travail contenant le Document ou une partie de celui-ci,
soit copié mot à mot, soit avec des modifications et/ou traduit dans une autre langue.
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Une « Section secondaire » est une annexe nommée ou une section de premier plan du Document qui traite
exclusivement de la relation des éditeurs ou des auteurs du Document avec le sujet général du Document (ou
avec des sujets connexes) et qui ne contient rien qui puisse relever directement de ce sujet général. (Ainsi, si le
Document  est  en  partie  un  manuel  de  mathématiques,  une  Section  secondaire  peut  ne  pas  expliquer  de
mathématiques). La relation peut être une question de lien historique avec le sujet ou avec des sujets connexes,
ou de position juridique, commerciale, philosophique, éthique ou politique à leur égard.

Les « Sections invariantes » sont certaines Sections secondaires dont les titres sont désignés, comme étant ceux
de Sections invariantes, dans la notice qui indique que le Document est publié sous cette Licence. Si une section
ne correspond pas à la définition ci-dessus du terme « secondaire », elle n’est pas autorisée à être désignée
comme « invariante ». Le Document peut ne contenir aucune section invariante. Si le Document n’identifie
aucune section invariante, alors il n’y en a pas.

Les « Textes de couverture » sont de courts passages de texte qui sont listés, en tant que Textes de couverture
avant ou arrière, dans la notice indiquant que le Document est publié sous cette Licence. Un texte de couverture
avant ne doit pas comporter plus de 5 mots et un texte de couverture arrière ne doit pas comporter plus de 25
mots.

Une copie « transparente » du Document est une copie lisible par une machine, représentée dans un format dont
la spécification est disponible pour le grand public, qui permet de réviser le document directement avec des
éditeurs de texte génériques ou (pour les images composées de pixels) des programmes de peinture génériques
ou (pour les dessins) un éditeur de dessin largement disponible, et qui convient à la saisie dans des formateurs
de texte ou à la traduction automatique dans une variété de formats convenant à la saisie dans des formateurs de
texte. Une copie réalisée dans un format de fichier autrement Transparent dont le balisage, ou l’absence de
balisage, a été conçu pour contrecarrer ou décourager toute modification ultérieure par les lecteurs n’est pas
Transparente. Un format d’image n’est pas Transparent s’il est utilisé pour une quantité substantielle de texte.
Une copie qui n’est pas transparente est dite opaque.

Parmi les exemples de formats appropriés pour les copies transparentes, citons l’ASCII simple sans balisage, le
format d’entrée Texinfo,  le format  d’entrée LaTeX, le SGML ou le XML utilisant  une DTD accessible au
public, et le HTML simple conforme aux normes, le PostScript ou le PDF conçu pour la modification humaine.
Parmi  les  exemples  de  formats  d’image  transparents,  citons  PNG,  XCF  et  JPG.  Les  formats  opaques
comprennent les formats propriétaires qui ne peuvent être lus et  modifiés que par des traitements de texte
propriétaires, le SGML ou le XML pour lequel la DTD et/ou les outils de traitement ne sont pas généralement
disponibles, et le HTML, PostScript ou PDF généré par machine produit par certains traitements de texte à des
fins de sortie uniquement.

La  « page  de titre »  désigne,  pour  un livre imprimé,  la  page  de titre  elle-même,  plus  les  pages  suivantes
nécessaires pour contenir, de manière lisible, le matériel que la présente Licence exige de faire figurer sur la
page de titre. Pour les œuvres dans des formats qui n’ont pas de page de titre en tant que telle, la « page de
titre » désigne le texte près de l’apparition la plus visible du titre de l’œuvre, précédant le début du corps du
texte.

Une section « Intitulée XYZ » désigne une sous-unité nommée du Document dont le titre est précisément XYZ
ou contient XYZ entre parenthèses à la suite d’un texte qui traduit XYZ dans une autre langue. (Ici,  XYZ
représente  un  nom de  section  spécifique  mentionné  ci-dessous,  tel  que  « Remerciements »,  « Dédicaces »,
« Approbations » ou « Histoire »). « Préserver le titre » d’une telle section lorsque vous modifiez le Document
signifie qu’elle reste une section « Intitulée XYZ » selon cette définition.

Le Document peut inclure des clauses d’exonération de garantie à côté de l’avis indiquant que la présente
Licence s’applique au Document. Ces clauses d’exonération de garantie sont considérées comme incluses par
référence dans la présente Licence, mais uniquement en ce qui concerne l’exonération de garantie : toute autre
implication  que  ces  clauses  d’exonération  de  garantie  pourraient  avoir  est  nulle  et  n’a  aucun  effet  sur  la
signification de la présente Licence.
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2. COPIE IN EXTENSO

Vous pouvez copier et distribuer le Document sur n’importe quel support, que ce soit à des fins commerciales
ou non, à condition que la présente Licence, les avis de droits d’auteur et l’avis de licence indiquant que la
présente  Licence  s’applique  au  Document  soient  reproduits  dans  toutes  les  copies,  et  que  vous  n’ajoutiez
aucune autre condition à celles de la présente Licence. Vous ne pouvez pas utiliser de mesures techniques pour
obstruer ou contrôler la lecture ou la copie ultérieure des copies que vous faites ou distribuez. Toutefois, vous
pouvez accepter une compensation en échange de copies. Si vous distribuez un nombre suffisamment important
de copies, vous devez également respecter les conditions de l’article 3.

Vous pouvez également prêter des copies, dans les mêmes conditions que celles mentionnées ci-dessus, et vous
pouvez afficher publiquement des copies.

3. COPIE EN QUANTITÉ

Si vous publiez des copies imprimées (ou des copies sur des supports qui ont généralement des couvertures
imprimées) du Document, dont le nombre est supérieur à 100, et que la notice de licence du Document exige
des  Textes  de  couverture,  vous  devez  inclure  les  copies  dans  des  couvertures  qui  portent,  clairement  et
lisiblement, tous ces Textes de couverture : Les textes de couverture avant sur la couverture avant, et les textes
de  couverture  arrière  sur  la  couverture  arrière.  Les  deux  couvertures  doivent  également  vous  identifier
clairement et lisiblement comme l’éditeur de ces exemplaires. La première de couverture doit présenter le titre
complet,  tous  les mots  du titre étant également  mis en évidence et  visibles.  Vous pouvez en outre ajouter
d’autres  éléments  sur  les  couvertures.  La copie  avec  des  changements  limités  aux couvertures,  tant  qu’ils
préservent le titre du Document et satisfont à ces conditions, peut être traitée comme une copie in extenso à
d’autres égards.

Si les textes requis pour l’une ou l’autre couverture sont trop volumineux pour être lisibles, vous devez placer
les premiers textes énumérés (autant que possible) sur la couverture proprement dite, et poursuivre le reste sur
les pages adjacentes.

Si vous publiez ou distribuez plus de 100 copies opaques du Document, vous devez soit inclure une copie
transparente lisible par machine avec chaque copie opaque, soit indiquer dans ou avec chaque copie opaque un
emplacement de réseau informatique à partir duquel le grand public utilisateur du réseau peut télécharger, en
utilisant des protocoles de réseau standard publics, une copie transparente complète du Document, exempte de
matériel  ajouté.  Si  vous  utilisez  cette  dernière  option,  vous  devez  prendre  des  mesures  raisonnablement
prudentes, lorsque vous commencez à distribuer des copies Opaques en quantité, pour vous assurer que cette
copie Transparente restera ainsi accessible à l’emplacement indiqué jusqu’à au moins un an après la dernière
fois que vous distribuez une copie Opaque (directement ou par l’intermédiaire de vos agents ou détaillants) de
cette édition au public.

Il est demandé, mais non obligatoire, de contacter les auteurs du Document bien avant de redistribuer un grand
nombre de copies, afin de leur donner une chance de vous fournir une version actualisée du Document.

4. MODIFICATIONS

Vous pouvez copier et distribuer une Version modifiée du Document dans les conditions des sections 2 et 3 ci-
dessus, à condition que vous publiiez la Version modifiée précisément sous cette Licence, la Version modifiée
remplissant le rôle du Document, autorisant ainsi la distribution et la modification de la Version modifiée à
quiconque en possède une copie. En outre, vous devez faire les choses suivantes dans la Version Modifiée :
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A. Utiliser dans la Page de titre (et sur les couvertures, le cas échéant) un titre distinct de celui du Document, et
de ceux des  versions  précédentes  (qui  devraient,  s’il  y  en a eu,  être  listées  dans  la  section  Historique  du
Document). Vous pouvez utiliser le même titre qu’une version précédente si l’éditeur original de cette version
vous en donne l’autorisation.
B.  Indiquez sur la Page de titre, en tant qu’auteurs, une ou plusieurs personnes ou entités responsables des
modifications de la Version modifiée, ainsi qu’au moins cinq des principaux auteurs du Document (tous ses
principaux auteurs, s’il en a moins de cinq), à moins qu’ils ne vous dispensent de cette obligation.
C. Indiquez sur la page de titre le nom de l’éditeur de la Version modifiée, en tant qu’éditeur.
D. Conservez toutes les mentions de copyright du Document.
E.  Ajoutez  une  notice  de  copyright  appropriée  pour  vos  modifications,  adjacente  aux  autres  notices  de
copyright.
F. Incluez, immédiatement après les avis de droits d’auteur, un avis de licence donnant au public la permission
d’utiliser la Version modifiée selon les termes de la présente Licence, sous la forme indiquée dans l’Addendum
ci-dessous.
G.  Préserver  dans  cette  notice  de  licence  les  listes  complètes  des  Sections  invariantes  et  des  Textes  de
couverture requis figurant dans la notice de licence du Document.
H. Inclure une copie non modifiée de la présente Licence.
I. Préserver la section intitulée « Historique », préserver son titre et y ajouter un élément indiquant au moins le
titre, l’année, les nouveaux auteurs et l’éditeur de la Version modifiée tels qu’ils figurent sur la Page de titre.
S’il n’y a pas de section intitulée « Histoire » dans le Document, créez-en une indiquant le titre, l’année, les
auteurs et l’éditeur du Document tels qu’ils figurent sur la Page de titre, puis ajoutez un élément décrivant la
Version modifiée comme indiqué dans la phrase précédente.
J. Préservez l’emplacement du réseau, s’il y en a un, indiqué dans le Document pour l’accès public à une copie
transparente du Document, ainsi que les emplacements du réseau indiqués dans le Document pour les versions
précédentes sur lesquelles il était basé. Ces emplacements peuvent être placés dans la section Historique. Vous
pouvez omettre un emplacement de réseau pour une œuvre publiée au moins quatre ans avant le Document lui-
même, ou si l’éditeur original de la version à laquelle il fait référence vous en donne l’autorisation.
K.  Pour  toute  section  intitulée  « Remerciements »  ou  « Dédicaces »,  conservez  le  titre  de  la  section,  et
conservez  dans  la  section  toute  la  substance  et  le  ton  de  chacun  des  remerciements  et/ou  dédicaces  des
contributeurs qui y figurent.
L. Conserver toutes les sections invariables du document, sans modification de leur texte ni de leur titre. Les
numéros de section ou leur équivalent ne sont pas considérés comme faisant partie des titres des sections.
M. Supprimer toute section intitulée « Approbations ». Une telle section ne peut pas être incluse dans la Version
Modifiée.
N. Ne pas changer le titre d’une section existante pour qu’elle s’intitule Approbations ou qu’elle entre en conflit
avec une section invariante.
O. Préservez toute clause de non-responsabilité en matière de garantie.

Si la Version modifiée inclut de nouvelles sections ou annexes de premier plan qui peuvent être qualifiées de
Sections secondaires et ne contiennent aucun élément copié du Document, vous pouvez, à votre discrétion,
désigner tout ou partie de ces sections comme étant invariantes. Pour ce faire, ajoutez leurs titres à la liste des
Sections invariantes dans la notice de licence de la Version modifiée. Ces titres doivent être distincts de tous les
autres titres de section.

Vous pouvez ajouter une section intitulée Approbations, à condition qu’elle ne contienne rien d’autre que des
approbations de votre Version Modifiée par diverses parties – par exemple, des déclarations d’examen par les
pairs ou que le texte a été approuvé par une organisation en tant que définition faisant autorité d’une norme.

Vous pouvez ajouter un passage de cinq mots maximum en tant que texte de première de couverture et un
passage de 25 mots maximum en tant que texte de quatrième de couverture, à la fin de la liste des textes de
couverture de la version modifiée. Un seul passage du Texte de couverture et un seul passage du Texte de
quatrième de couverture peuvent être ajoutés par (ou par le biais d’arrangements pris par) une même entité. Si le
Document comprend déjà un texte de couverture pour la même couverture, précédemment ajouté par vous ou
par un arrangement fait par la même entité pour laquelle vous agissez, vous ne pouvez pas en ajouter un autre  ;
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mais vous pouvez remplacer l’ancien texte, sur autorisation explicite de l’éditeur précédent qui a ajouté l’ancien
texte.

Les auteurs et les éditeurs du Document ne donnent pas, par la présente Licence, l’autorisation d’utiliser leurs
noms à des fins publicitaires ou pour affirmer ou impliquer l’approbation d’une quelconque Version modifiée.

5. COMBINAISON DE DOCUMENTS

Vous pouvez combiner le  Document avec d’autres  documents  publiés  sous  cette  Licence,  selon les  termes
définis  dans  la  section  4  ci-dessus  pour  les  versions  modifiées,  à  condition  que  vous  incluiez  dans  la
combinaison toutes les Sections Invariables de tous les documents originaux, sans modification, et que vous les
citiez  toutes  comme Sections  Invariables  de votre  travail  combiné  dans  sa  notice  de licence,  et  que vous
préserviez toutes leurs clauses de non-responsabilité.

Le travail combiné ne doit contenir qu’une seule copie de la présente Licence, et plusieurs Sections Invariables
identiques peuvent être remplacées par une seule copie. S’il existe plusieurs Sections Invariables portant le
même nom mais ayant un contenu différent, rendez le titre de chacune de ces sections unique en ajoutant à la fin
de celui-ci, entre parenthèses, le nom de l’auteur ou de l’éditeur original de cette section s’il est connu, ou bien
un numéro unique. Faites le même ajustement aux titres des sections dans la liste des sections invariantes dans
l’avis de licence de l’œuvre combinée.

Dans la combinaison, vous devez combiner toutes les sections intitulées « Histoire » dans les divers documents
originaux,  formant  une  section  intitulée  « Histoire » ;  de  même,  combinez  toutes  les  sections  intitulées
« Remerciements » et  toutes les sections intitulées « Dédicaces ». Vous devez supprimer toutes les sections
intitulées Approbations.

6. COLLECTIONS DE DOCUMENTS

Vous pouvez créer une collection constituée du Document et d’autres documents publiés sous cette Licence, et
remplacer les copies individuelles de cette Licence dans les différents documents par une seule copie incluse
dans la collection, à condition que vous suiviez les règles de cette Licence pour la copie mot à mot de chacun
des documents à tous autres égards.

Vous  pouvez  extraire  un  seul  document  d’une  telle  collection,  et  le  distribuer  individuellement  sous  cette
Licence, à condition d’insérer une copie de cette Licence dans le document extrait, et de suivre cette Licence
dans tous les autres aspects concernant la copie mot à mot de ce document.

7. AGRÉGATION AVEC DES ŒUVRES INDÉPENDANTES

Une compilation du Document ou de ses dérivés avec d’autres documents ou travaux séparés et indépendants,
dans ou sur un volume d’un support de stockage ou de distribution, est appelée « agrégat » si le droit d’auteur
résultant de la compilation n’est pas utilisé pour limiter les droits légaux des utilisateurs de la compilation au-
delà de ce que les travaux individuels permettent. Lorsque le Document est inclus dans un agrégat, la présente
Licence ne s’applique pas aux autres travaux de l’agrégat qui ne sont pas eux-mêmes des travaux dérivés du
Document.

Si l’exigence relative au Texte de couverture de la section 3 est applicable à ces copies du Document, alors si le
Document représente moins de la moitié de l’agrégat entier, les Textes de couverture du Document peuvent être
placés  sur  les  couvertures  qui  encadrent  le  Document  dans  l’agrégat,  ou sur  l’équivalent  électronique  des
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couvertures  si  le  Document  est  sous  forme  électronique.  Sinon,  ils  doivent  figurer  sur  des  couvertures
imprimées qui encadrent l’ensemble de l’agrégat.

8. TRADUCTION

La traduction étant considérée comme une sorte de modification, vous pouvez distribuer des traductions du
Document selon les termes de la  section 4.  Le remplacement  des  Sections  Invariables par des traductions
nécessite une autorisation spéciale de la part de leurs détenteurs de droits d’auteur, mais vous pouvez inclure les
traductions de certaines ou de toutes les Sections Invariables en plus des versions originales de ces Sections
Invariables. Vous pouvez inclure une traduction de la présente Licence, ainsi que de tous les avis de licence
figurant dans le Document, et de toute clause de non-responsabilité en matière de garantie, à condition d’inclure
également la version originale en anglais de la présente Licence et les versions originales de ces avis et clauses
de non-responsabilité. En cas de désaccord entre la traduction et la version originale de la présente Licence ou
d’un avis ou d’une clause de non-responsabilité, la version originale prévaudra.

Si  une section du Document  est  intitulée « Remerciements »,  « Dédicaces » ou « Historique »,  l’obligation
(section 4) de préserver son titre (section 1) nécessitera généralement de modifier le titre réel.

9. RÉSILIATION

Vous ne pouvez pas copier, modifier, accorder une sous-licence ou distribuer le Document, sauf dans les cas
expressément prévus par la présente Licence. Toute autre tentative de copie, de modification, de sous-licence ou
de distribution du Document est nulle et met automatiquement fin à vos droits dans le cadre de cette Licence.
Toutefois, les parties qui ont reçu des copies ou des droits de votre part dans le cadre de la présente Licence ne
verront pas leurs licences résiliées tant que ces parties resteront en pleine conformité.

10. FUTURES RÉVISIONS DE LA PRÉSENTE LICENCE

La Free Software Foundation peut publier de temps à autre de nouvelles versions révisées de la GNU Free
Documentation  License.  Ces  nouvelles  versions  seront  similaires  dans  l’esprit  à  la  présente  version,  mais
pourront  différer  dans  les  détails  pour  répondre  à  de  nouveaux  problèmes  ou  préoccupations.  Voir
http://www.gnu.org/copyleft/.

Chaque version de la Licence reçoit un numéro de version distinctif. Si le Document spécifie qu’une version
numérotée particulière de la présente Licence « ou toute version ultérieure » s’applique à lui,  vous avez la
possibilité de suivre les termes et conditions soit de cette version spécifiée, soit de toute version ultérieure qui a
été publiée (pas en tant que projet) par la Free Software Foundation. Si le Document ne spécifie pas de numéro
de version de la présente Licence, vous pouvez choisir n’importe quelle version publiée (et non à l’état de
projet) par la Free Software Foundation.
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2. Introduction

J’ai décidé d’écrire ce manuel pour aider tous les utilisateurs de mtPaint à tirer le meilleur parti du programme.
Comme tout logiciel, mtPaint est un outil, et afin de l’utiliser efficacement, vous devrez étudier ce qu’il fait, et
comment il fonctionne. Si vous souhaitez comprendre certaines des décisions de conception que j’ai prises,
vous serez peut-être intéressé de lire pourquoi j’ai créé mtPaint.

2.1 La vie avant mtPaint

J’ai commencé à m’intéresser aux programmes de peinture et à l’infographie en 1984. Comme beaucoup de
jeunes de cette époque, les ordinateurs m’intéressaient à cause des jeux vidéo et des hobbies créatifs comme la
programmation, l’art et la musique.

C’est à cette époque que j’ai vu pour la première fois AMX Art sur la BBC Micro, puis AMX Super Art peu
après. En 1988, j’ai commencé à utiliser Neochrome sur l’Atari ST, puis un an plus tard, j’ai utilisé Animatic
Sprite Master, que j’ai apprécié parce que je pouvais expérimenter l’animation.

Dans les années 1990, j’ai commencé à explorer de nouveaux programmes d’édition RVB 24 bits. Bien qu’ils
soient excellents pour l’édition de photos, j’ai été frustré par leur faible prise en charge des images à base de
palettes et du pixel art. En réponse, j’ai écrit quelques petits programmes de peinture pour combler cette lacune,
mais malheureusement, je n’ai pas eu le temps ou la volonté de les développer correctement avant 2004.

2.2 Projet Genesis

Le 4 juillet 2004, j’ai décidé de commencer à réfléchir à la création de mon propre programme de peinture à
utiliser sur mes systèmes GNU/Linux. Pendant quelques semaines, j’ai envisagé d’utiliser d’autres programmes
de peinture libres comme point de départ, mais j’ai décidé que mes objectifs n’étaient pas compatibles avec
ceux des autres et qu’il valait mieux partir de zéro.

J’ai commencé le travail de programmation le 7 août 2004 et j’ai mis à la disposition du public une version
utilisable le 13 septembre 2004. Ce développement rapide n’a été possible qu’après avoir utilisé et étudié un
excellent programme appelé mhWaveEdit, écrit par Magnus Hjorth, au printemps 2004. En plus d’être un très
bon programme d’édition de vagues, j’ai également appris de nombreuses leçons précieuses de ce programme.

Par exemple, pour garder mtPaint portable, je l’ai conçu pour utiliser la boîte à outils GTK+, version 1 ou 2.
Cela signifie  qu’il  fonctionnera sur  la  plupart  des  systèmes d’exploitation  libres,  même s’ils  ont  plusieurs
années et fonctionnent sur du matériel plus ancien avec moins de ressources CPU et mémoire.

2.3 Philosophie générale

J’ai toujours voulu que mtPaint soit petit, fiable, rapide et facile à utiliser, car je pense que ce sont les qualités
qui  me donneront  le  meilleur  outil  de peinture pour  mes  besoins.  Cependant,  mtPaint  n’est  pas  un effort
d’entreprise, et ce n’est pas un clone d’un autre programme, donc il peut ne pas se conformer aux besoins de
peinture de tout le monde.

Une décision importante que j’ai prise avec mtPaint est de le publier en tant que logiciel libre en utilisant la
licence  publique  générale  GNU.  Cela  donne  à  tous  les  utilisateurs  de  mtPaint  diverses  libertés  qui  sont
bénéfiques à la fois pour eux et pour moi. Si vous n’êtes pas au courant de ces libertés et du travail du projet
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GNU, je vous encourage vivement à les lire ici : http://www.gnu.org/. Grâce à l’utilisation de cette licence pour
mtPaint, de nombreuses personnes ont pu apporter des idées et du code source qui ont amélioré le programme.

2.4 Chronologie du développement

Le projet  mtPaint  a  grandi  et  s’est  développé de façon constante  tout  au long de son existence.  Voici  un
graphique qui décrit sa progression :
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2.4.1 Version 0.23 – 0.37

La version 0.23 était la première version publique, et elle ressemblait à ceci :

Pendant les 3 premiers mois de développement, je n’étais intéressé que par le développement d’un programme
de peinture à palette indexée, j’ai donc totalement ignoré le support des images RVB. A ce stade embryonnaire,
il n’y avait que quelques outils disponibles et une interface utilisateur très basique existait. La chose la plus
importante pour moi à ce stade était d’obtenir une fonctionnalité correcte de la palette,  car c’est  ce que la
plupart des programmes de peinture modernes négligent. Par exemple, je voulais avoir un moyen très rapide et
facile de protéger certaines couleurs sur la toile, j’ai donc conçu un système simple de croix à côté de chaque
couleur dans la zone verticale de la palette.

Après  la  version 0.30,  j’ai  décidé  que j’aimais  vraiment  le  programme et  que je  voulais  l’utiliser  sur  des
systèmes Windows lorsque je n’avais pas accès à mes systèmes d’exploitation libres habituels. Cette tâche était
assez facile puisque GTK+ a été porté sur Windows et que les sources de mtPaint sont en pur langage C. Je
n’avais donc besoin que d’un simple environnement de développement MinGW.

2.4.2 Version 0.40 – 0.97

Une fois mes objectifs de palette indexée atteints, j’ai décidé que je voulais être capable d’éditer des photos
numériques et d’autres images RVB 24 bits. J’ai également ajouté plusieurs autres outils tels que le collage de
texte et le maculage.

C’est au cours de cette phase de développement que j’ai commencé à recevoir des commentaires de personnes
sur  leurs  expériences  avec  mtPaint,  et  sur  la  façon  dont  je  pouvais  améliorer  les  choses.  Voir  la  section
CREDITS du fichier README pour des informations spécifiques sur ces contributions. Bien que je développe
principalement mtPaint pour mes propres besoins, je n’ai pas le monopole des bonnes idées et cette aide a été
reçue avec reconnaissance.

2.4.3 Version 2.00 – 2.30

La version 2.00 était une avancée majeure, c’est pourquoi j’ai entièrement sauté la version 1.xx. Passer de la
version 0.97 à la 1.00 n’aurait pas reflété le saut quantique en termes de fonctionnalité dû à l’implémentation
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des couches.  Les calques sont extrêmement utiles  lors de la création d’une œuvre d’art,  j’ai  donc été très
heureux de mettre en œuvre cette fonctionnalité.

La version 2.00 est sortie le 7 août 2005 pour coïncider avec le premier anniversaire du début de mon travail sur
mtPaint.

2.4.4 Version 3.00

Le grand changement de la version 3 de mtPaint a été l’introduction des canaux. J’avais envisagé d’introduire
les canaux dans la version 2.00 car ils sont très utiles, mais j’ai décidé que c’était trop complexe pour mon
cerveau simple à mettre en œuvre correctement.

Heureusement pour moi et pour les autres utilisateurs de mtPaint, l’aide est venue d’un autre programmeur
appelé Dmitry Groshev, qui a été capable d’implémenter les canaux alpha, de sélection et de masque. Cela a
impliqué une énorme réécriture du code, qui a nécessité le saut de la version 2 à 3.

Bien que j’aie utilisé le code d’autres personnes pour diverses parties de mtPaint, c’était la première fois que
quelqu’un d’autre commençait à travailler directement sur le code source. Dans le passé, j’ai utilisé du code
pour des choses comme les fichiers ini et la quantification des couleurs, mais il s’agissait de logiciels libres que
j’ai découverts sur Internet et modifiés moi-même pour mes besoins.

Une autre étape importante de la version 3 a été de retravailler l’interface utilisateur afin d’améliorer les menus
et de rendre les barres d’outils plus orientées vers les tâches.

Enfin, et surtout, j’ai décidé d’écrire ce manuel. En raison de la puissance et de la polyvalence accrues de
mtPaint, j’ai décidé qu’il était temps de créer un document HTML entièrement illustré pour expliquer comment
tout fonctionne.

Malgré tous ces ajouts, le noyau du programme mtPaint reste petit, fiable, rapide et facile à utiliser.

La version 3.00 de mtPaint a été ma dernière en tant que mainteneur, par manque de temps et d’énergie.

2.4.5 Version 3.10 – 3.40

Après que Mark Tyler m’ait passé la main, je n’ai pas fait de changements radicaux à mtPaint pendant un
certain temps ; au lieu de cela, il y a eu une amélioration graduelle, alors que mtPaint obtenait plus de tout –
plus d’effets  et  de modes de dessin,  plus de formats de fichiers image supportés,  plus de traductions dans
d’autres  langues,  des  implémentations  plus  efficaces  pour  les  outils  existants,  et  beaucoup  de  nouvelles
fonctionnalités, plus ou moins utiles.

Certains  de  ces  nouveaux  ajouts  peuvent  sembler  opaques  aux  utilisateurs  qui  n’aiment  pas  lire  la
documentation ; mais tout dans le traitement de l’image ne peut pas être rendu explicite, en particulier si l’on
essaie de garder le programme petit.  Les fonctionnalités qui ne sont pas évidentes sont expliquées dans le
manuel ; le temps passé à les rechercher sera bien récompensé par le fait de ne pas perdre de temps à apprendre
des choses par essais et erreurs.
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3. Pixel Art

Le Pixel Art est la tâche principale pour laquelle mtPaint est conçu. Cette forme d’art est essentiellement très
simple et similaire à la peinture dans le monde réel. Par exemple, vous avez une toile sur laquelle peindre, un
pinceau pour peindre et une palette de couleurs pour le pinceau.

Voici à quoi ressemble la fenêtre principale de mtPaint :

Les barres d’outils en haut et la palette à gauche peuvent être activées ou désactivées à l’aide des touches F5-F8
pour s’adapter au mieux à votre travail.

3.1 Créer un nouveau canevas

La première décision que vous devez prendre avant de commencer un projet est de savoir avec quel type de
toile vous voulez travailler. mtPaint supporte deux types de toile :

• Palette indexée
• RVB 24 bits

Les images à palette indexée utilisent une palette de 2 à 256 couleurs. Chacune de ces couleurs peut être définie
par l’utilisateur et est enregistrée avec le canevas dans le fichier image. Les images RVB n’enregistrent pas la
palette, mais elles ont l’avantage de pouvoir utiliser plusieurs millions de couleurs dans l’image. Pour tout type
de travail lié aux photographies numériques, vous devrez utiliser un canevas RVB.

Au démarrage de mtPaint, vous disposez automatiquement d’une toile vide avec la même géométrie que votre
travail précédent. Si vous voulez autre chose, vous devez utiliser la fenêtre de la nouvelle image qui est appelée
en appuyant sur Ctrl-N, en utilisant le menu Fichier ou en appuyant sur l’icône de la nouvelle image. Elle vous
permet de :

• créer une nouvelle toile vide (jusqu’à 16384 x 16384 pixels)
• de faire une capture d’écran du bureau actuel
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• d’importer une image à partir du presse-papiers du système (ou du presse-papiers interne si le presse-
papiers du système est vide).

Si vous cochez l’option Réversible lors de la création d’une nouvelle image, il devient possible de l’annuler
comme toute autre opération d’édition. Ceci est particulièrement utile lorsque vous faites des captures d’écran –
vous pouvez en faire plusieurs, puis les enregistrer toutes en une seule fois en utilisant l’option «  Exporter les
tampons d’annulation… » du menu Fichier.

3.2 Outils de peinture

mtPaint dispose de plusieurs outils de peinture différents que vous pouvez utiliser. Pour commencer à utiliser
ces outils, sélectionnez l’icône correspondante dans la section Outils de la barre d’outils située en haut de la
fenêtre de mtPaint.

Si, à tout moment, vous faites une erreur, vous pouvez toujours utiliser les fonctions annuler et refaire via les
touches Ctrl-Z et  Ctrl-R, le menu Édition ou la barre d’outils  principale.  Par défaut,  vous pouvez annuler
jusqu’à 100 actions – moins si l’espace d’annulation n’est pas suffisant. La fenêtre des préférences (Ctrl-P) vous
permet d’allouer plus de mémoire à l’espace d’annulation, ou d’augmenter la limite d’annulation jusqu’à 1000
actions.

En général, vous avez besoin d’un espace d’annulation d’au moins deux fois la taille non comprimée de la plus
grande image que vous voulez traiter – c’est-à-dire (largeur x hauteur x 6) pour les images RVB, ou (largeur x
hauteur x 2) pour les images indexées.

3.2.1 Peinture

L’outil Peinture est l’outil de peinture le plus simple. La façon la plus simple de l’utiliser est de sélectionner
l’un des paramètres de brosse prédéfinis en appuyant sur F3 ou en cliquant sur la zone d’aperçu de la brosse au-
dessus de la palette. Vous disposez alors d’une sélection de formes de pinceaux parmi lesquelles choisir :

Si vous souhaitez ajuster manuellement la taille du pinceau ou le flux du spray, vous pouvez le faire en utilisant
la barre d’outils des réglages ou propriétés (touche F7).

3.2.2 Aléatoire

L’outil de brassage échange des pixels aléatoires dans la zone du pinceau. Il est utile pour mélanger deux blocs
de couleur sur la toile et créer une texture pixellisée comme celle-ci :

Page 17/113



La taille et le débit de l’outil affectent la manière dont le mélange fonctionne sur le canevas.

3.2.3 Remplissage par déluge

Le remplissage par inondation fonctionne en remplissant une zone où tous les pixels sont de la même couleur.
Si vous cliquez avec le bouton droit de la souris sur l’icône de remplissage, vous pouvez mieux contrôler les
actions de remplissage.

En sélectionnant « Par canal d’image », vous pouvez remplir une zone sur un canal utilitaire en utilisant le canal
d’image comme référence pour la zone de remplissage.

Un mode flou peut être utilisé en réglant le nombre sur une valeur supérieure à 0. Ce mode vous permet de
remplir une zone de pixels similaires à celui sur lequel vous avez cliqué en premier, plutôt que de compter sur
des pixels identiques, ce qui est utile pour les photographies.

La case à cocher « Cube RVB » permet au mode flou d’utiliser le modèle de cube RVB plutôt que la sphère
L*X*N* par  défaut,  ce qui  peut  être utile  dans  certaines  situations  (voir  3.5.4 pour plus  de détails  sur la
différence entre les méthodes du cube et  de la sphère).  L’option 'Gradient-driven'  permet au mode flou de
prendre en compte la différence entre les pixels adjacents, plutôt que le pixel de départ original et chaque pixel
candidat.

3.2.4 Ligne droite

Pour dessiner une ligne droite dans mtPaint, il suffit de :

• Sélectionner l’outil ligne droite dans la barre d’outils
• Cliquez gauche et relâchez à l’endroit où vous voulez que la ligne commence.
• Déplacez le pointeur à l’endroit où vous voulez que la ligne se termine et faites un clic gauche.

La procédure de ligne se poursuivra alors jusqu’à ce que vous appuyiez sur le bouton droit de la souris ou sur la
touche Echap pour l’arrêter. L’épaisseur de cette ligne est définie par la taille de l’outil.

3.2.4.1 Dessiner des flèches

L’outil ligne droite peut également dessiner une tête de flèche à l’extrémité de la ligne actuelle si vous appuyez
sur les touches A ou S pour une tête ouverte () ou fermée (). La taille de la tête est déterminée par le flux de
l’outil (paramétrage dans la barre des réglages→option Couler à régler selon votre besoin).
(article complété lors de la traduction notamment le symbôle des flèches et la partie entre parenthèses à la fin du présent article. Source don570 en
Ontario (Canada) : sujet du 19 dec 2011 à 22:14 sur https://oldforum.puppylinux.com/viewtopic.php?t=74437)

3.2.5 Tampon

L’outil  d’estompage  est  uniquement  disponible  lorsque  vous  modifiez  une  image  RVB.  Il  fonctionne  en
estompant  une  zone de  pixels  définie  par  la  taille  de  l’outil.  En  faisant  glisser  la  souris  dans  différentes
directions, vous obtiendrez un effet de bavure différent.
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Voici un exemple d’estompage :

Cet effet est obtenu avec le mode Continu activé et le mode Opacité désactivé.
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3.2.6 Clone

L’outil de clonage est utilisé pour copier des morceaux d’une partie de l’image à l’autre. Après avoir sélectionné
l’outil Clone, vous devez définir la taille de l’outil, puis déplacer le curseur de la souris sur la zone de la toile.
Maintenez ensuite la touche Ctrl enfoncée et déplacez la souris afin d’éloigner le périmètre de l’outil (noir et
blanc) du périmètre du clone (noir et rouge). Après avoir relâché la touche Ctrl, vous pouvez alors appuyer sur
le bouton gauche de la souris pour copier les pixels du périmètre rouge et noir vers le périmètre blanc et noir.
Voici un exemple :

3.2.7 Texte

Si vous souhaitez coller du texte sur le canevas, vous devez appuyer sur la touche T ou cliquer sur l’icône de
l’outil texte dans la barre d’outils. Un formulaire s’affiche alors, dans lequel vous devez saisir le texte que vous
souhaitez coller sur le canevas ; pour un texte de plusieurs lignes, appuyez sur Ctrl+Entrée pour insérer un
caractère de nouvelle ligne. Vous pourrez modifier le type de police et sa taille.

Si vous utilisez GTK+2 et que vous éditez une image RVB, vous avez également la possibilité d’avoir un texte
anticrénelé pour des bords plus lisses. Les utilisateurs de GTK+2.6 ont la possibilité de faire pivoter le texte
dans n’importe quel angle.

Une fois que vous êtes satisfait du texte dans la zone de prévisualisation, vous pouvez faire glisser le texte et le
positionner où vous le souhaitez. Vous pouvez ensuite modifier la couleur du texte en cliquant sur une couleur
de la palette ou vous pouvez modifier le motif. Vous pouvez à tout moment faire pivoter le texte par pas de 90
degrés à l’aide des icônes de rotation de la sélection dans la barre d’outils ou en utilisant le menu Sélection.
Vous engagez le texte sur le canevas comme vous le feriez pour une opération de collage normale, c’est-à-dire
en faisant un clic droit ou en appuyant sur la touche Entrée.

3.2.7.1 Texte (FreeType)

En  plus  d’utiliser  les  fonctions  de  rendu  de  texte  standard  de  GTK+,  mtPaint  peut  également  utiliser
directement la bibliothèque de rendu de texte FreeType afin de bénéficier des avantages suivants :

• Les polices bitmap peuvent être utilisées, y compris la mise à l’échelle et la rotation.
• Les polices sont chargées directement à partir de fichiers, et n’ont donc pas besoin d’être installées sur le

système d’exploitation hôte.
• Les polices scalables sans style italique ou oblique peuvent être inclinées afin d’obtenir un effet oblique.
• Le rendu est identique quel que soit le système d’exploitation ou la version de GTK+.
• La qualité du rendu et de la rotation est plus élevée sur certains systèmes, comme Windows.
• La rotation du texte est disponible pour les systèmes GTK+1 et GTK+2.0 – GTK+2.4.
• La version GTK+1 de mtPaint peut maintenant coller du texte anti-aliasé.
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Malgré ces  avantages,  le  rendu de  texte  standard de GTK+ est  conservé dans  mtPaint  car  il  présente  ces
avantages :

• Certains systèmes peuvent offrir des facilités de substitution de police qui rendent possible l’utilisation
de différents alphabets dans une même chaîne.

• C’est un dialogue plus simple que certaines personnes peuvent préférer si elles n’ont pas besoin de la
puissance et de la qualité supplémentaires qu’offre le rendu FreeType.

La première étape de l’utilisation de l’outil  de texte  FreeType consiste à remplir  l’onglet « Répertoire des
Polices  de  caractères ».  Lorsque  le  dialogue  est  lancé  pour  la  première  fois,  mtPaint  tente  de  trouver
automatiquement  toutes les  polices  présentes  sur  votre  système.  Si  cela  échoue,  vous  devrez  saisir
manuellement  chaque répertoire  contenant  les  polices  que  vous  souhaitez  utiliser.  Une fois  que  vous  êtes
satisfait de vos répertoires, vous devez appuyer sur le bouton « Créer index » qui créera l’index des polices.

À ce stade,  vous devriez être  en mesure de revenir  à l’onglet  Texte et  de sélectionner  la  police que vous
souhaitez utiliser.

3.3 La palette

La palette se trouve à gauche de la fenêtre mtPaint et sert à sélectionner les couleurs à peindre. Si vous faites un
clic gauche sur une couleur, elle sera choisie comme couleur A et un clic droit  choisira la couleur B. Les
couleurs A et B sont visualisées dans une petite zone au-dessus de la palette. Vous pouvez intervertir A et B en
appuyant sur la touche X.

3.3.1 Modification de la palette

Vous pouvez éditer les couleurs A et B en appuyant sur Ctrl-E, ou en cliquant sur l’aperçu des couleurs A/B.

Si l’image est indexée et que les couleurs A et B sont les mêmes, vous devez modifier la couleur B pour que
l’entrée de la palette change.

Vous pouvez modifier toute la palette en appuyant sur Ctrl-W, ou en cliquant sur l’index des couleurs dans la
fenêtre de la palette – dans ce cas, l’éditeur de palette démarre avec la couleur cliquée sélectionnée.
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Lorsque  vous  éditez  toute  la  palette,  vous  pouvez  créer  des  échelles  de  couleurs  entre  deux  couleurs
sélectionnées ; réglez les spins De et Vers aux extrémités de l’échelle, sélectionnez le mode d’interpolation, et
appuyez sur le bouton Créer. En appuyant sur les boutons De et Vers, vous définissez le spin correspondant à
l’indice de couleur actuel.

Les échelles peuvent être construites en interpolant les couleurs des points d’extrémité en RVB, sRVB (RVB
linéaire,  voir 6.8.2), HSV, ou en utilisant le gradient actuellement sélectionné ; dans ce dernier cas, les points
d’extrémité sont également modifiés. Si vous souhaitez une échelle HSV ou un gradient inversé, définissez les
points d’extrémité dans un ordre inverse (l’indice Vers est plus petit que l’indice De).

Si le bouton Aperçu est activé, les modifications apportées seront immédiatement visibles dans la fenêtre de la
palette, et sur le canevas si l’image est indexée.

3.3.2 Chargement et enregistrement de la palette

Vous pouvez enregistrer et charger la palette actuelle en accédant à la fonction correspondante dans le menu
Palette. mtPaint supporte les formats de fichiers de palette GPL (palette GIMP) et TXT (texte simple), et peut
également lire la palette à partir de fichiers d’images indexées dans n’importe quel format d’image supporté.

Si vous souhaitez qu’un fichier de palette soit utilisé comme palette par défaut de mtPaint, vous pouvez le
définir dans la section Chemins de la fenêtre Préférences.

3.3.3 Trier et ajuster la palette

Il est possible de trier la palette entière en utilisant l’option de menu Palette. Vous pouvez déplacer une seule
entrée de la palette d’un index à un autre en procédant comme suit :

• Déplacez le pointeur de la souris sur la couleur que vous souhaitez déplacer.
• Appuyez sur la touche Maj et maintenez-la enfoncée
• Appuyez sur le bouton gauche de la souris et maintenez-le enfoncé
• Faites glisser le pointeur vers l’index souhaité
• Relâchez le pointeur de la souris pour valider l’opération.

Lorsque vous effectuez cette opération avec une image indexée, les couleurs de la toile seront ajustées pour
tenir compte de la modification.

La couleur générale de la palette peut être ajustée lors de l’édition d’une image RVB en appuyant sur la touche
Insertion et en ajustant les paramètres avec la bascule de la palette.
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3.3.4 Protection des couleurs

Il existe une fonction de masque de protection des couleurs qui empêche la peinture de certaines couleurs sur le
canevas. Cette fonction est très utile lorsque vous avez dessiné un contour et que vous souhaitez ensuite remplir
les  lignes  entre  elles  avec  d’autres  couleurs  sans  affecter  le  contour.  Pour  protéger  une  couleur  contre  la
peinture, il suffit de faire un clic gauche à droite de sa couleur dans la fenêtre de la palette – une croix devrait
alors apparaître. Cliquez à nouveau et le masque sera supprimé et cette couleur pourra être modifiée sur le
canevas comme d’habitude. Le menu de la palette vous permet de définir ou de supprimer le masque pour
toutes les couleurs. Cette protection affecte tous les outils de base comme la peinture normale ou le collage
(images  RVB et  indexées)  et  également  les  fonctions  globales  comme les  effets  et  les  transformations  de
couleurs.

3.3.5 La couleur transparente

Lorsque vous éditez certains types de fichiers tels  que XPM, GIF ou PNG, vous pouvez souhaiter qu’une
couleur particulière soit définie comme transparente. Pour ce faire, appuyez sur Ctrl-P pour ouvrir la fenêtre des
Préférences, puis allez dans la section Fichiers et définissez le numéro de la couleur de la palette que vous
souhaitez rendre transparente. Une valeur de -1 désactivera la transparence. Vous avez également la possibilité
de définir ce paramètre lorsque vous utilisez l’option « Enregistrer sous ».

3.3.6 Choisir une couleur dans le canevas

Pendant que vous peignez, il est parfois utile de sélectionner une couleur dans le canevas pour la couleur A ou
B. Pour cela, maintenez la touche Ctrl enfoncée et appuyez sur le bouton gauche de la souris pour choisir la
couleur A ou sur le bouton droit pour la couleur B.

Ctrl+double clic sélectionnera la couleur moyenne corrigée par gamma sous le rectangle de sélection, ou s’il n’y
a pas de sélection, sous le carré de la brosse. Là encore, un double-clic sur le bouton gauche sélectionne la
couleur A, et le bouton droit, la couleur B. Vous pouvez utiliser cette méthode pour sélectionner des couleurs
pour l’anticrénelage.

Si vous avez choisi une couleur RVB dans le canevas et que vous voulez en trouver une semblable dans votre
palette, vous pouvez le faire en faisant Ctrl+clic moyen. Cela changera la couleur A en la couleur de palette la
plus proche, et choisira la couleur B et le motif pour produire ensemble la meilleure approximation possible de
la couleur d’origine A. Si vous n’avez pas besoin du tramage, mais seulement de la couleur unie la plus proche,
alors Ctrl+clic médian une deuxième fois – cela définira la couleur B comme étant la même que la couleur A, et
le motif comme étant uni.

Pendant  que  vous  modifiez  l’ensemble  de  la  palette,  vous  pouvez  sélectionner  n’importe  quelle  couleur
n’importe où sur l’écran de votre ordinateur en appuyant sur l’icône de la pipette.

3.3.7 Copier dans la palette

Si vous modifiez une image RVB ou indexée, le menu Édition vous permet de copier la sélection actuelle, ou le
contenu du presse-papiers s’il n’y a pas de sélection, dans la palette. Cette opération définit également la taille
de la palette en conséquence.
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3.3.8 Coller la palette

Le menu Édition vous permet de mettre la palette actuelle dans le presse-papiers, que vous pouvez ensuite
coller sur le canevas. Si vous sélectionnez d’abord une zone avec l’outil de sélection, vous pouvez faire en sorte
que la zone à coller ait une largeur différente.

3.3.9 Choisir un dégradé

L’option « Pick Gradient… » du menu Palette assemble la meilleure approximation possible d’un dégradé de la
couleur A vers B en utilisant les couleurs de la palette actuelle, et la place dans le presse-papiers sous la forme
d’une ligne de pixels. Le gradient peut être approximé dans l’espace couleur RVB, sRVB ou LXN (voir la
section 6.8.2 pour leurs forces et faiblesses relatives).

3.3.10 Sélecteur de couleurs

Pour choisir rapidement une nouvelle couleur dans la palette, vous pouvez appuyer sur E pour appeler la fenêtre
du sélecteur de couleurs à la position du curseur de la souris. Un clic gauche sur une couleur permet de choisir
la couleur A, un clic droit la couleur B ; pour fermer la fenêtre sans rien changer, cliquez en dehors de la fenêtre
ou appuyez sur n’importe quelle touche.

3.4 Motifs

Les actions de peinture utilisent normalement une couleur plate, mais il est possible d’utiliser différents motifs.
Pour choisir un motif différent, vous pouvez appuyer sur F2 ou cliquer sur la zone de prévisualisation du motif
juste  au-dessus de la  palette.  Vous verrez alors apparaître  les  motifs  suivants,  parmi lesquels  vous pouvez
choisir :
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La section   A.6.1   explique comment personnaliser ces motifs.

3.5 Modes de peinture

Les modes de peinture peuvent être utilisés pour modifier le comportement général des actions de peinture. Ces
modes sont activés et désactivés à l’aide des icônes de la barre d’outils des paramètres, comme illustré ici :

Tous les modes ne sont pas applicables à tous les outils. Voici un tableau détaillant les modes qui affectent
chacun des outils :

Peindre Mélanger Remplir Étaler Cloner Coller

Continu Oui Oui

Opacité Oui Oui Oui Oui Oui

Teinte Oui Oui Oui

Masque Oui Oui Oui Oui Oui Oui

Dégradé Oui Oui

Blend Oui Oui Oui

La  peinture  comprend  les  pinceaux,  les  pulvérisations,  les  lignes  droites,  les  remplissages  de  formes  de
sélection et les contours.

3.5.1 Continu

Si le mode continu est activé, lorsque vous faites glisser la souris sur le canevas et que vous peignez également,
les espaces entre les mouvements sont remplis. Si vous utilisez le mode non continu, vous pouvez cliquer avec
le bouton droit de la souris sur l’icône du mode et définir l’espacement de la brosse (Brush spacing) entre les
engagements de l’outil. Une valeur de 0 signifie que l’espacement est désactivé et qu’un outil est engagé à
chaque fois qu’il est signalé à mtPaint. Voici un exemple de ce qui peut être réalisé :

La première ligne a été créée en utilisant le mode continu. La deuxième ligne a été créée en utilisant le mode
non-continu avec un espacement de brosse de 0, et la dernière ligne a été créée avec un espacement de brosse de
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5. La variation de l’espacement des brosses non-continu rend également les résultats de l’utilisation de l’outil de
pulvérisation plus déterministes, quelle que soit la vitesse de déplacement de la souris.

3.5.2 Opacité

Lorsque vous peignez avec une opacité inférieure à 255, et que le mode d’annulation de l’opacité est activé,
l’opération de peinture modifiera chaque pixel en fonction de cette valeur de manière uniforme, comme dans cet
exemple :

Si le mode d’opacité est désactivé, l’opacité sera augmentée chaque fois que l’outil peint sur un pixel, comme
dans cet exemple :

3.5.3 Teinte

Si  le  mode teinte  est  activé  lors  de  l’édition  d’une  image RVB,  au  lieu  de  remplacer  la  couleur  entière,
l’opération augmentera ou diminuera le canal de couleur individuel par rapport aux couleurs A et B. Avec une
image indexée, ce sera l’index qui sera augmenté ou diminué. Pour les opérations de peinture, le fait d’appuyer
sur le bouton gauche augmentera et le bouton droit diminuera. Pour les opérations de remplissage basées sur la
sélection,  vous  devrez  également  régler  le  commutateur  Tint  +-  pour  déterminer  dans  quelle  direction  la
coloration aura lieu. Voici un exemple de coloration avec des ellipses bleues sur une image en niveaux de gris :

3.5.4 Sélection des couleurs

Le mode de sélection des couleurs est un type spécial de masque qui régit les opérations de peinture en fonction
de la couleur des pixels du canevas. Vous configurez les paramètres du mode en cliquant avec le bouton droit de
la souris sur le bouton de basculement qui fait apparaître la boîte de dialogue suivante :
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La capture d’écran représente un gradient gris lisse d’un coin à l’autre, et la sélection de couleur porte sur une
section centrale de ce gris. La zone d’aperçu verte indique les pixels qui seront protégés des opérations de
peinture (activez le bouton Aperçu pour l’afficher). En sélectionnant le bouton Inverse, vous désignerez les
pixels qui seront disponibles pour la peinture.

L’option sphère est la sphère L*X*N* (la même que les remplissages flous) et utilise la distance euclidienne
dans un espace de couleur uniforme du point de vue de la perception, ce qui est plus conforme à la vision
humaine des couleurs. Cependant, elle utilise des calculs coûteux et son utilisation peut entraîner des retards.
L’option Cube utilise la plus grande des différences entre les composantes de couleur rouge, verte et bleue, elle
est donc plus rapide mais moins discriminante, et pourrait être utilisée au mieux pour, par exemple, des zones
de même couleur tout en ignorant le bruit dans les bits de poids faible des couleurs RVB, ou pour remplir des
zones si grandes que le mode par défaut devient trop lent.

3.5.5 Masque

Le bouton de désactivation de tous les masques est utilisé pour désactiver temporairement les masques actuels.
Cela affecte le canal du masque, toutes les couleurs de la palette qui ont été protégées et également le masque
de sélection des couleurs.

3.5.6 Dégradé

Lorsque vous sélectionnez le mode gradient en cliquant sur le bouton de gradient horizontal,  vous pouvez
peindre des zones graduées de pixels sur le canevas. Par défaut, le gradient utilise les couleurs A et B, mais vous
pouvez définir vos propres couleurs, ce qui est expliqué plus loin. Une fois le mode activé, il y a trois façons de
l’utiliser :

• Comme un dégradé placé à une position fixe en utilisant l’outil de sélection de dégradé suivi d’un outil
de peinture.

• Comme un gradient de trait à l’aide des formes de pinceau.
• Comme un dégradé de forme en utilisant l’un des outils de remplissage.
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Un clic droit sur le bouton du dégradé, ou sur l’icône de l’outil de placement du dégradé, fait apparaître la
fenêtre de configuration du dégradé, dans laquelle vous pouvez modifier diverses propriétés du dégradé. La
fenêtre se présente comme suit :

Le sens de tout cela :

• Le type de dégradé contrôle la forme du dégradé :
◦ Linéaire : il suit la ligne de placement du début à la fin.
◦ Bilinéaire va dans les deux sens à partir du début de la ligne de placement.
◦ Radial forme un cercle avec la ligne de placement comme rayon.
◦ Carré crée un carré avec une ligne de placement allant de son centre à un coin.
◦ Angulaire fait 360 degrés dans le sens des aiguilles d’une montre à partir de la ligne de placement.
◦ Conique : 180 degrés dans le sens des aiguilles d’une montre et dans le sens inverse.

• La longueur, si elle est différente de zéro, remplace la longueur par défaut ci-dessus.
• L’excentrage est la distance à laquelle le gradient commencera à partir du point de départ ; il est soustrait

de la longueur.
• La longueur de répétition,  si  elle est  différente de zéro,  spécifie la longueur du gradient  lui-même,

indépendamment du décalage (le paramètre de longueur est alors ignoré).
• Le type d’extension contrôle ce qui sera dessiné en dehors de la zone définie du dégradé :

◦ Aucun : laisse les pixels extérieurs inchangés.
◦ Niveau : les remplit avec la première ou la dernière couleur du gradient, respectivement.
◦ Répéter : répète le gradient encore et encore.
◦ Mirroir : répète le dégradé à l’envers, puis à l’endroit, et ainsi de suite.

• Le cartouche Dégradé permet de sélectionner le type de gradient :
◦ A vers B (RVB) : va de la couleur A à la couleur B, en interpolant entre leurs valeurs RGB.
◦ A vers B (sRGB) ; va de A à B en interpolant dans sRGB (RVB linéaire, voir 6.8.2).
◦ A vers B (TSV) : va de A à B en interpolant entre leurs valeurs HSV.
◦ A vers B (TSV inversé) fait la même chose mais interpole les valeurs de teinte dans le sens inverse

sur le cercle chromatique.
◦ Seulement A : ne dessine qu’avec la couleur A (pas de gradient du tout).
◦ Personnaliser : dessine un dégradé personnalisé.
◦ Éditer personnalisé ouvre un éditeur de dégradé, pour configurer ce dégradé personnalisé.

• La case à cocher Inverser permute les extrémités du dégradé (de B vers A, ou de la fin vers le début pour
un dégradé personnalisé).

• Le cartouche Opacité permet de sélectionner l’opacité à utiliser pour le dégradé :
◦ Courant seulement : dessine tout ce qui a l’opacité actuelle.
◦ Courant jusqu’à 0 : va de l’opacité actuelle à la transparence totale.
◦ Personnaliser : applique un gradient d’opacité personnalisé.
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Remarque     :   la longueur du gradient est définie comme la distance entre les points d’extrémité, de sorte qu’un
gradient couvre en réalité une rangée de pixels de plus (2 rangées pour une longueur de 1 pixel, etc.), sauf en
mode Miroir.

Maintenant, quelques exemples de ce qui peut être fait en mode dégradé.

3.5.6.1 Dégradés placés

Vous placez un dégradé en sélectionnant l’outil Dégradé dans la barre d’outils, puis vous placez les points de
début et de fin en cliquant sur la souris. Une fois que cela a été fait, vous verrez un aperçu temporaire du
gradient  résultant  et  vous devrez ensuite  sélectionner  un outil  de  peinture et  peindre sur  la  toile.  Afin de
configurer le gradient, vous devez appuyer sur l’icône de placement du gradient dans la barre d’outils avec le
bouton droit de la souris. Voici un exemple d’un simple dégradé linéaire du rouge au jaune peint à l’aide de
l’outil  polygone pour  créer un triangle.  L’image de gauche affiche les lignes de construction de l’outil  de
placement du dégradé et de l’outil polygone, tandis que l’image de droite représente les pixels exacts sur la
toile :

En utilisant plusieurs des paramètres de la boîte de dialogue de configuration des dégradés, vous pouvez obtenir
toutes sortes d’effets créatifs. Par exemple, voici un arc-en-ciel que j’ai peint :

Cette image a été créée en suivant les étapes suivantes à partir d’une nouvelle session mtPaint :

• Créez une nouvelle image RVB.
• Sélectionnez le rouge comme couleur A (indice 1) et le magenta comme couleur B (indice 5).
• Utilisez l’outil de placement de gradient pour placer les deux points près du centre inférieur de l’image.
• Cliquez avec le bouton droit de la souris sur l’icône Dégradé pour configurer les éléments suivants :

◦ Longueur de 75 – La largeur totale de l’arc-en-ciel.
◦ Décalage de 50 – Crée le trou au milieu.
◦ Type de gradient radial.
◦ Utilisez le gradient 'A vers B (TSV)' en utilisant le bouton inverseur – Cela crée le balayage complet

du spectre de couleurs.
• Utilisez la barre d’outils des paramètres pour activer le mode dégradé.
• Sélectionnez l’outil de sélection du rectangle et peignez la moitié supérieure de l’arc-en-ciel en utilisant

l’icône « Remplir la sélection ».

3.5.6.2 Dégradés de traits

Pour que les dégradés de traits fonctionnent, vous devez d’abord effacer toute ligne de dégradé que vous avez
positionnée sur le canevas en appuyant sur Echap ou sur le bouton droit de la souris avec l’outil Dégradé activé.
Ensuite, vous devez définir le trait en appuyant sur le bouton droit de l’icône Dégradé dans la barre d’outils. À
titre d’exemple, l’image suivante a été créée à l’aide d’un dégradé rouge-blanc d’une longueur de 50 et d’un
type d’extension « miroir » :
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Voici un exemple utilisant des paramètres similaires, mais avec le type d’extension Aucun et une brosse plus
petite :

3.5.6.3 Dégradés personnalisés

Si vous souhaitez créer  un gradient  ou une opacité  composée de plusieurs  points  d’extrémité,  vous devez
sélectionner le type de gradient Personnalisé, puis appuyer sur le bouton « Modifier la personnalisation ». Vous
pouvez alors définir jusqu’à 256 points sur le gradient, qui seront ensuite placés à égale distance les uns des
autres. Voici un exemple de gradient personnalisé simple :

Voici les étapes que j’ai suivies pour créer cette image :

• Créez une nouvelle image.
• Configurez le dégradé pour qu’il soit de type Radial et qu’il ait un type d’extension Répéter.
• Sélectionnez Personnaliser pour le dégradé et appuyez ensuite sur le bouton « Édition personnalisée ».
• Sélectionnez 5 couleurs, chacune étant définie comme « constante » afin que seules des couleurs de bloc

soient utilisées.
• Utilisez l’outil  Dégradé pour placer le premier point au centre de l’image et  le second point à une

certaine distance du centre et des bords de l’image.
• Appuyez sur  Ctrl-A pour  sélectionner  toute  l’image,  puis  sur  l’icône  « Remplir  la  sélection »  pour

remplir toute l’image avec le dégradé.
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3.5.6.4 Dégradés de canaux utilitaires

Il est possible de peindre des dégradés sur les canaux utilitaires en utilisant les mêmes méthodes que pour la
peinture sur le canal image. Par exemple, voici l’image ci-dessus avec un dégradé peint sur le canal alpha :

Voici les étapes que j’ai suivies pour créer cette image :

• Sélectionnez « Éditer le canal alpha » dans le menu « Canal » et « OK » tous les pixels.
• Utilisez l’outil Dégradé pour placer le premier point au centre et le deuxième point dans le coin.
• Appuyez sur  Ctrl-A pour  sélectionner  toute  l’image,  puis  sur  l’icône  « Remplir  la  sélection »  pour

peindre le dégradé (n’oubliez pas de vérifier que le mode dégradé est activé dans la barre d’outils des
paramètres).

3.5.6.5 Dégradés en forme d’ellipse

Si  vous  dessinez  une  ellipse  remplie,  remplissez  une  zone  rectangulaire  ou  polygonale,  ou  effectuez  un
remplissage par inondation en mode dégradé sans placer un dégradé avec l’outil Dégradé, vous pouvez créer
des dégradés en forme d’éclats comme ceci :

3.5.7 Mélange

Le Mode mélange fonctionne en mélangeant certaines parties des pixels source avec le canevas. Pour utiliser ce
mode, vous devez le configurer en appuyant sur le bouton droit de la souris sur le bouton Mode mélange dans la
Barre de réglages. Ce mode ne peut être utilisé que sur des images RVB et (à l’exception de quelques mélanges
spécifiques à la RVB) sur des canaux utilitaires ; dessiner sur une image indexée dans ce mode ne donnera rien.
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Dans cet exemple, j’ai peint 2 ellipses sur un fond en niveaux de gris. L’ellipse de gauche a été peinte en
utilisant un rouge pur (RVB 255,0,0) avec un mélange Couleur affectant le rouge, le vert et le bleu. L’ellipse de
droite a été créée en utilisant à nouveau un rouge pur, avec un mélange Normal affectant le rouge et le bleu.

Le mélange dans l’icône du mode de fusion peut être réalisé en 3 étapes :

• Peignez un cercle rouge en utilisant un mélange normal affectant uniquement le canal rouge.
• Peignez un cercle vert en utilisant un mélange normal affectant uniquement le canal vert.
• Peindre un cercle bleu à l’aide d’un mélange normal n’affectant que le canal bleu.

En utilisant le mode de fusion, vous pouvez reproduire les effets des « modes de calque » de GIMP ; choisissez
le mode de fusion nommé comme le mode de calque que vous voulez, et collez ce qui aurait été le calque
supérieur sur ce qui aurait été le calque inférieur. Dans le cas où les deux calques sont la même image (ce qui
est le plus courant), copiez simplement l’image et collez-la sur elle-même.

mtPaint n’a pas de mélange Overlay, car il fait la même chose que « Lumière douce » ; quand vous avez besoin
de Overlay, utilisez « Lumière douce » à la place.
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4. L’outil de sélection

L’outil de sélection est utilisé pour délimiter des zones sur le canevas. Une fois ces zones définies, vous pouvez
effectuer diverses opérations telles que remplir, dessiner un contour ou copier et coller. Ces opérations sont
accessibles via le menu Sélection ou dans la barre d’outils. Le menu Édition comporte les options couper et
coller.

La fonction de copie peut être grandement améliorée par l’utilisation d’un canal de sélection qui vous permet de
spécifier les pixels qui seront copiés. Par exemple, il est possible de copier et de coller des formes elliptiques.
Voir le chapitre sur les canaux pour plus d’informations et des exemples de fonctionnement.

La fonction Coller de mtPaint fonctionne d’une manière quelque peu inhabituelle ; vous positionnez la zone de
collage sur le canevas et vous validez le collage par un clic droit ou en appuyant sur Entrée – et vous pouvez le
faire de manière répétée jusqu’à ce que vous rejetiez le collage en appuyant sur Echap. La sélection d’un autre
outil annule le collage, mais ne le valide pas, sauf si cette option est activée dans la section Interface de la
fenêtre Préférences.

4.1 Sélections de rectangles

La sélection de rectangle fonctionne en cliquant sur le canevas et en faisant glisser d’un coin à l’autre. Après
avoir effectué une sélection, un nouveau clic n’importe où sur le canevas déplacera le coin le plus proche de la
sélection vers la position du curseur, et vous pourrez alors le faire glisser pour le placer plus précisément. Si
l’option du curseur de la souris  est  activée,  vous verrez la flèche d’angle correspondante pour indiquer ce
nouveau comportement.  De cette façon, une nouvelle sélection peut être effectuée sans glisser,  en cliquant
simplement sur deux coins opposés d’une zone.

Si vous souhaitez sélectionner l’ensemble de l’image, appuyez sur Ctrl-A. Pour effacer cette sélection, appuyez
sur Echap, le bouton droit de la souris, Ctrl+Shift-A ou utilisez le menu Édition. La boîte de sélection peut être
déplacée pixel  par  pixel  à  l’aide des  touches fléchées.  Si  vous appuyez sur la  touche Shift  et  les  touches
fléchées, la boîte de sélection sera déplacée d’un nombre de pixels déterminé par la fenêtre des préférences.

4.2 Sélections de polygones

Après avoir sélectionné cet outil, cliquez avec le bouton gauche de la souris sur le canevas à l’endroit où vous
souhaitez commencer à former la forme du polygone. Vous pouvez ensuite maintenir le bouton gauche enfoncé
pour obtenir une forme à main levée ou le relâcher pour obtenir un long bord droit. Pour terminer, appuyez sur
le bouton droit. Vous pouvez également créer un polygone en maintenant le bouton droit de la souris enfoncé,
puis en le faisant glisser. Dans ce cas, le fait de relâcher le bouton droit complète le polygone. Pour annuler la
forme, appuyez sur la touche Echap.

4.3 Le lasso

Une fois qu’une sélection a été effectuée, vous pouvez utiliser l’outil lasso pour rétrécir les bords de la sélection
avec la  même couleur.  Cette  fonction  fonctionne en remplissant  par  inondation  les  pixels  transparents,  en
commençant par le premier point de la sélection polygonale ou le haut gauche de la sélection rectangulaire. Par
exemple :
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• Sélectionnez une zone grossière autour d’une forme :

• Appuyez sur l’icône du lasso :

• Collez la forme sur un nouveau fond :

En utilisant  le  menu  Sélection,  vous  pouvez  également  « couper  au  lasso »  une  zone qui  remplit  la  zone
sélectionnée au lasso sur le canevas.

Si  vous n’avez effectué aucune sélection  sur  le  canevas,  l’outil  lasso rétrécira  le  presse-papiers  actuel  (en
commençant en haut à gauche, comme pour une sélection rectangulaire).

4.4 Masquage des couleurs

Pendant le collage, il est possible de rendre certaines couleurs invisibles dans le collage.
Par exemple :
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• Collage d’une forme solide :

• Sélectionnez  le  blanc  comme  couleur  A  et  le  jaune  comme  couleur  B,  et  sélectionnez
Sélection→Masquer les couleurs A, B. Cela rendra ces zones colorées transparentes :

Vous  pouvez  le  faire  avec  autant  de  couleurs  que  vous  le  souhaitez,  il  suffit  de  répéter  la  procédure.
Sélectionnez Selection→Enlever le masque pour supprimer entièrement le masque.

4.5 Mélange alpha

Le copier-coller normal implique la copie de pixels entiers d’une zone à une autre. Cependant, il est possible
d’utiliser un canal alpha pour fusionner certaines zones de manière plus fluide. Par exemple, voici une image
RVB plate qui a été exportée d’Inkscape et qui contient plusieurs bords et mélanges de couleurs lisses :

Si je faisais un lasso sur les objets et que je les collais sur un fond rouge, cela ressemblerait à ceci :

Comme vous pouvez le constater, les bords des objets sont bizarres et les mélanges ne sont pas à leur place. Il
existe une fonction dans mtPaint qui vous permet d’extraire les propriétés de mélange d’un collage et de les
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placer sur n’importe quel fond tout en conservant la fluidité. Comme exemple, utilisez la première image ci-
dessus comme point de départ et ensuite :

• Sélectionnez les formes noires avec une boîte de sélection rectangle, copiez et collez avec Ctrl-C et Ctrl-
V.

• Sélectionnez le noir comme couleur A et le blanc comme couleur B dans la palette.
• Choisissez l’option de menu « Sélection→Mélange avec transparence A, B ».
• Faites glisser la boîte de collage sur la zone rouge et validez le collage en appuyant sur ENTER.

Vous devriez alors voir :

• Effacez la boîte de collage avec la touche Echap. Sélectionnez, copiez et collez les formes jaunes en
suivant la même procédure que ci-dessus, mais choisissez le jaune comme couleur A.

Si vous appliquez ce deuxième collage sur le premier, vous devriez obtenir quelque chose comme ceci :

Cette technique fonctionne pour tout mélange simple d’une couleur de premier plan à une couleur d’arrière-
plan. Elle fonctionne bien avec l’anticrénelage que l’on trouve autour du texte et des formes géométriques créés
avec des programmes comme Inkscape et exportés dans un format sans perte comme le PNG. Notez que vous
devez exporter une image PNG depuis Inkscape avec un arrière-plan de couleur plate, et non un arrière-plan
transparent.
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4.5.1 Variation d’une seule couleur

Si les couleurs A et B sont identiques, vous pouvez transformer cette couleur en alpha dans la sélection et
mélanger toutes les autres couleurs en nuances d’alpha. Par exemple, si vous prenez l’image ci-dessus, copiez la
partie supérieure, définissez les couleurs A et B en tant que blanc pur, puis collez le résultat après avoir appliqué
« Sélection→Mélange avec transparence A, B », vous obtiendrez le résultat suivant :

Cette méthode fonctionne bien lorsque la source a un arrière-plan d’une seule couleur, avec plusieurs couleurs
d’avant-plan d’un type de couleur totalement différent.

4.6 Presse-papiers multiples

mtPaint permet à l’utilisateur de stocker jusqu’à 12 images dans un presse-papiers à images multiples. Cela
fonctionne en enregistrant un fichier PNG contenant l’image du presse-papiers, puis en utilisant le menu Édition
pour charger ces images selon les besoins.

Cette fonctionnalité signifie également que vous pouvez avoir deux programmes mtPaint indépendants en cours
d’exécution  et  être  en  mesure  de charger  et  d’enregistrer  les  données  du presse-papiers  entre  les  deux en
appuyant sur un bouton. De plus, tant que les fichiers ne sont pas supprimés, vous aurez accès à ces images du
presse-papiers après avoir fermé et redémarré mtPaint, ou même redémarré le système.

Il est possible de coller un presse-papiers RVB sur une image RVB et un presse-papiers à palette indexée sur
une image à palette indexée ou RVB. Comme les fichiers du presse-papiers sont des fichiers PNG standard,
l’utilisateur peut également les ouvrir dans un autre processus mtPaint et les modifier. Les fichiers du presse-
papiers sont stockés dans l’emplacement défini dans la fenêtre des Préférences.

mtPaint  utilise  son  propre  presse-papiers  interne  que  les  autres  programmes  ne  peuvent  pas  toucher  sans
permission. Dans le menu Édition, vous pouvez utiliser la commande « Importer presse-papiers du système »
pour copier le contenu du presse-papiers d’un autre programme dans mtPaint, ou « Exporter presse-papiers du
système » pour permettre à d’autres programmes de coller le contenu du presse-papiers de mtPaint.
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4.7 Collage au pinceau

Pendant que vous collez, vous pouvez maintenir les boutons gauche et droit de la souris en même temps pour
obtenir un effet de collage au pinceau. Si vous collez un objet dont le bord n’est pas rectangulaire, vous pouvez
obtenir des effets intéressants comme celui-ci :

Ici, j’ai collé un orbe semi-transparent dont le mode d’opacité est désactivé.

4.8 Rampes

En utilisant l’outil de sélection du rectangle et les options de rampe du menu de sélection, vous pouvez créer
une rampe verticale ou horizontale entre 2 points ou lignes sur le canevas. Dans cet exemple zoomé, j’ai créé
une rampe entre une ligne rouge et une ligne jaune pour créer un gradient parfaitement lisse :

Outre les effets de toile, la rampe peut également être combinée avec la copie de palette présentée à la section
3.3.7 pour créer des palettes à une ou deux dimensions parfaitement espacées.

4.9 Échange de collage

Lors  de  l’édition  d’une  image  contenant  de  nombreuses  tuiles  de  taille  fixe,  il  est  intéressant  de  pouvoir
échanger deux zones de la toile avec un minimum d’effort. Pour ce faire, vous pouvez utiliser le collage de
l’échange :

• Sélectionnez la première zone avec l’outil de sélection du rectangle.
• Appuyez sur Ctrl+C ou Ctrl+X pour copier ou couper la zone d’origine.
• Déplacez la zone à coller à l’endroit où vous souhaitez effectuer la permutation.
• Appuyez sur Shift+Enter pour valider la permutation.
• Déplacez la nouvelle zone de collage à l’endroit  où vous avez copié ou coupé la zone d’origine et

validez le collage.

Vous  pouvez  répéter  ces  étapes  plusieurs  fois  pour  échanger  plusieurs  tuiles  en  séquence.  Dans  certaines
situations où il n’y a pas de lignes directrices sur le canevas, il est plus utile de couper la zone d’origine, car
cela laisse un trou que vous pouvez viser plus tard lorsque vous collez l’élément final.
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5. Visualisation d’images

Il est possible de visualiser et de manipuler des images de base sans avoir à afficher toutes les barres d’outils.
Vous pouvez activer ou désactiver une barre d’outils à l’aide du menu Affichage, ce qui vous permet de rendre
l’interface beaucoup moins encombrée lorsque vous n’avez pas besoin de ces fonctionnalités supplémentaires.
Voici une capture d’écran de ce à quoi mtPaint ressemble avec seulement la barre d’outils principale activée :

Toutes les manipulations de base de l’image peuvent être effectuées en quelques clics de souris ou quelques
frappes de clavier : Zoom, panoramique, recadrage, mise à l’échelle et ajustement des couleurs. Si vous prenez
le temps d’apprendre ces raccourcis clavier et souris, ils peuvent réellement augmenter votre satisfaction au
travail et votre productivité.

5.1 Zoom et panoramique

Vous pouvez à tout moment effectuer un zoom avant ou arrière à l’aide des touches + ou -. Vous pouvez
également effectuer un zoom sur une valeur prédéfinie en appuyant sur les touches numériques 1 à 9. Il est
parfois utile de naviguer dans l’image en appuyant sur la touche End (ou Fin) pour faire apparaître la fenêtre
panoramique. Cette fenêtre affiche une vignette de l’image actuelle que vous pouvez utiliser pour positionner la
vue actuelle. Pour ce faire, vous pouvez soit appuyer sur les touches fléchées pour vous déplacer, soit cliquer
sur la vignette à l’aide de la souris. La taille de la vignette est définie dans la fenêtre Préférences.

5.1.1 Zoom sur une zone particulière

Si vous souhaitez effectuer un zoom sur une zone particulière de l’image, vous pouvez le faire en positionnant
le pointeur de la souris sur la zone que vous souhaitez centrer, puis en appuyant sur le bouton central de la
souris.  Si vous effectuez ensuite un zoom avant,  ce point sur le canevas sera le nouveau centre de la vue
actuelle.

5.2 Mode d’affichage complet

À tout moment, vous pouvez masquer tous les menus, les barres d’outils, la palette et la barre d’état afin de
visualiser la plus grande partie possible de l’image. Pour ce faire, il suffit d’appuyer sur la touche Home (ou
Début ou Accueil). Si vous appuyez à nouveau sur la touche Home (ou Début ou Accueil), vous retrouverez les
commandes.
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5.3 Liste des fichiers image

Si vous avez lancé mtPaint en passant plus d’un nom de fichier à la ligne de commande, par exemple 'mtpaint
*.jpg', ces noms de fichiers seront placés dans une liste dans une fenêtre. Ensuite, chaque fois que vous cliquez
sur le  nom du fichier,  cette image sera chargée dans mtPaint.  Cela peut  être utile  pour  éditer  des  images
d’animation, ou pour travailler avec plusieurs photos numériques.

Dans la version Windows de mtPaint, cette fonction peut être utilisée en sélectionnant les fichiers d’image
dans l’Explorateur, en faisant un clic droit et en utilisant l’option « Envoyer vers » pour les envoyer à mtPaint ;
ou sinon, mtPaint peut prendre un motif de caractères génériques et trouver les fichiers par lui-même si vous
utilisez l’option « -w », comme ceci :  mtpaint – w  "*.jpg". Cette option peut s’avérer utile sur un système
GNU/Linux  également,  au  cas  où  il  y  aurait  trop  de  fichiers  correspondants  pour  tenir  dans  la  ligne  de
commande (plutôt improbable, étant donné sa limite de taille de 64 Ko, mais possible).

Voici un exemple de ce que vous pouvez faire en utilisant cette procédure, avec une fenêtre panoramique et la
fenêtre principale basculée en plein écran :

Pour désactiver la zone de dock, appuyez sur F12 ou utilisez le menu Affichage→Show Dock.

5.4 La fenêtre de visualisation

Lorsque vous modifiez une image avec un zoom élevé, il est parfois utile d’avoir une deuxième image à 100 %
pour voir à quoi elle ressemble, mais sans avoir à zoomer en avant et en arrière. C’est ce que la fenêtre de
visualisation vous permet de faire. La fenêtre d’affichage peut être activée ou désactivée en appuyant sur la
touche V ou en utilisant le menu Affichage. Le paramètre de zoom de la fenêtre d’affichage est défini à l’aide de
la deuxième liste déroulante de la barre d’outils principale. Par défaut, lorsque vous déplacez une barre de
défilement dans la fenêtre d’édition principale, cela déplace également le foyer de l’image dans la fenêtre de
visualisation. Pour désactiver cette fonction, vous devez basculer l’option dans le menu Affichage.

Page 40/113



Voici un exemple d’utilisation de la fenêtre de visualisation :

5.5 Traçage d’image

Au lieu de dessiner de mémoire, vous pouvez créer une image de traçage pour vous aider à en reproduire les
contours et les couleurs. Une image de traçage peut aider même une personne qui n’a pas de talent artistique à
créer une image de tuile ou une icône passable.

Tout d’abord, vous devez préparer l’image que vous voulez tracer. Chargez-la dans mtPaint, et si vous ne voulez
qu’une partie de l’image comme image de traçage, recadrez-la ou copiez cette partie dans le presse-papiers.

Sélectionnez ensuite « Tracing Image » dans le menu Affichage. Sélectionnez ensuite « Image » ou « Presse-
papiers » comme source, en fonction de l’emplacement de votre image préparée. Ensuite, définissez l’échelle
relative si vous souhaitez que la nouvelle image du canevas soit plus petite que l’image originale. Par exemple,
si vous tracez une image de 640x480 sur un canevas de 80x60 pixels, l’échelle relative sera de 8. Cochez
ensuite la case Montrer et appuyez sur OK.

Créez maintenant une nouvelle image, puis définissez le fond noir comme transparent en appuyant sur Ctrl+P et
en définissant l’indice de transparence sur 0 dans l’onglet Fichiers. Vous pouvez également créer un canal alpha
vide  en  utilisant  « Canal→Nouveau ».  L’image  de  traçage  apparaîtra  alors  à  travers  votre  image  de  toile
désormais transparente.

La capture d’écran ci-dessous montre la configuration typique pour le traçage :
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Voyez la fenêtre du canevas sur un zoom élevé, affichant une image de traçage superposée par une tuile 32x32
partiellement dessinée et une grille de zoom ; et la fenêtre de vue affichant cette même tuile à l’échelle 1:1.

Remarquez également les différentes couleurs de la grille sur la partie dessinée, la partie transparente et à leur
limite ; c’est la fonction « Smart grid » en action. Elle existe pour vous aider à voir quels pixels sont déjà
dessinés, et lesquels sont encore transparents. Vous pouvez l’activer, et choisir les trois couleurs à utiliser, dans
la boîte de dialogue « Configurer la grille… » du menu Affichage.

Notez que mtPaint ne se contente pas de vous montrer l’image de traçage, mais vous permet d’en choisir les
couleurs. Si vous faites Ctrl+clic sur un pixel transparent au-dessus de l’image de traçage, la couleur est choisie
à partir du pixel de l’image de traçage sous le curseur. Et si vous faites Ctrl+double-clic, la couleur choisie est
une moyenne corrigée du gamma de tous les pixels de l’image de traçage situés sous le pixel du canevas sur
lequel vous avez cliqué ; ceci est utile lorsque l’échelle relative est supérieure à 1, comme dans l’exemple ci-
dessus.

Vous pouvez également déplacer l’image de traçage en utilisant Ctrl + les touches fléchées, si le calque actuel
est l’arrière-plan. Sinon, vous pouvez modifier son origine dans la fenêtre « Tracing Image ».

Vous pouvez voir ci-dessous les étapes finales de la transformation d’une image de traçage en une petite tuile :

Et la tuile terminée elle-même :

5.6 Grille de zoom
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La grille de zoom facilite l’édition des images avec un zoom élevé. Vous pouvez l’activer ou la désactiver en
utilisant l’option de menu 'Affichage→Grille de zoom'.

En utilisant la boîte de dialogue « Configurer la grille » dans le même menu Affichage, vous pouvez choisir la
couleur de la grille, et le facteur de zoom minimum auquel la grille devient visible. Si l’option « Smart grid »
(ou Grille intelligente) est cochée, la grille est affichée en trois couleurs différentes – la couleur Opaque est
utilisée pour les lignes de la grille entre les pixels opaques, Bordure pour les lignes séparant un pixel opaque et
un pixel transparent, et Transparent, pour les lignes entre les pixels transparents. Si l’option n’est pas cochée,
seule la couleur Opaque est utilisée.

Dans  la  même  boîte  de  dialogue,  vous  pouvez  également  activer  la  grille  de  tuiles,  utile  pour  séparer
visuellement les tuiles dans un jeu de tuiles, configurer sa couleur et son espacement horizontal et vertical.
Contrairement à la grille de zoom, la grille de tuiles, si elle est activée, est affichée pour tous les facteurs de
zoom.

Activez le bouton Aperçu si vous souhaitez voir de façon dynamique comment les modifications que vous
apportez à la grille s’afficheront sur le canevas.

5.7 Volet d’accueil

Lorsque la barre d’outils des paramètres ou la fenêtre des calques ne sont pas affichées sous forme de fenêtres
distinctes, elles se trouvent dans le volet d’ancrage, qui se trouve sur le côté droit de la fenêtre principale. Cette
disposition est parfois plus pratique, notamment sur les écrans larges. La liste des fichiers image, si elle est
présente, occupe un onglet séparé dans le volet d’ancrage.

La zone d’ancrage peut être activée ou désactivée par la touche F12, ou par le menu Affichage. Sa largeur peut
être  modifiée  en  faisant  glisser  le  séparateur  entre  la  fenêtre  principale  et  la  zone  d’accueil,  et  elle  est
mémorisée d’une session à l’autre.

Lorsqu’une fenêtre de la zone d’ancrage est sélectionnée et qu’elle reçoit des données, les touches fléchées
permettent de naviguer dans ses champs, au lieu de déplacer le curseur de la souris sur le canevas. Pour libérer
l’entrée du dock, appuyez sur la touche Echap.
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6. Manipulation d’images

mtPaint possède plusieurs fonctions générales de manipulation d’images qui sont utiles pour diverses tâches.
Ces fonctions se trouvent dans les menus Image et Effets.

6.1 Recadrage

Pour  recadrer  une  image,  créez  une  sélection  rectangulaire  pour  la  zone  de  l’image  que  vous  souhaitez
conserver et appuyez sur la touche Suppression (ou Del ou Delete ou Suppr…).

6.2 Mise à l’échelle

Pour mettre rapidement une image à l’échelle, il suffit d’appuyer sur la touche « Page précédente » (ou Pg up
ou…) et de saisir la nouvelle géométrie de l’image souhaitée. Si vous mettez à l’échelle une image RVB, vous
avez le choix entre plusieurs méthodes. Dans la plupart des cas, la méthode par défaut sera la plus appropriée,
mais les autres méthodes sont disponibles si vous avez besoin de quelque chose de plus spécialisé, comme par
exemple une légère accentuation de l’image, utile pour la mise à l’échelle d’une image de taille vignette.

6.2.1 Correction gamma

Lorsque vous mettez à l’échelle une image RVB, vous avez la possibilité d’utiliser la correction gamma pour
ajuster l’image. L’œil humain est plus sensible aux différences entre les couleurs sombres qu’aux différences
entre  les  couleurs claires.  Cette  non-linéarité  est  utilisée dans le  codage RVB, de sorte  que la  quantité  de
lumière émise par les phosphores de l’écran dépend des valeurs RVB non pas linéairement, mais par le biais
d’une fonction de puissance. En général, il n’est pas nécessaire de le savoir et d’en tenir compte, mais dans le
traitement graphique, lorsque plusieurs pixels sont mélangés, le fait de mélanger naïvement leurs codes RVB
conduit à ce que certaines parties de l’image résultante soient plus sombres qu’elles ne devraient l’être, et à ce
que de petits détails lumineux soient perdus. Pour contrer ce problème, il faut utiliser la correction gamma.

Les niveaux de lumière réels dépendent des paramètres d’affichage, tels que la luminosité et le contraste, et la
sensibilité humaine aux différentes couleurs de la  lumière varie également beaucoup – certaines personnes
voient même les couleurs avec leur œil gauche différemment de leur œil droit. Pour en tenir compte, les travaux
graphiques professionnels nécessitent un étalonnage de l’écran, et les formats d’image incluent des données de
profil de couleur ; mais le pixel art ne se trimballe pas avec des profils de couleur, et est vu par des non-
professionnels sur des écrans non étalonnés – donc pour travailler avec lui, la meilleure approche est celle qui
fonctionne bien en moyenne. Et la formule de la recommandation ITU-R 709, qui est utilisée dans mtPaint, est
une formule qui fonctionne bien dans le cas moyen. La correction gamma est effectuée en convertissant chaque
composante RVB de chaque pixel en son niveau de lumière correspondant en utilisant la formule ci-dessus, en
mélangeant ces niveaux de lumière comme l’exige une opération particulière de traitement de l’image, et en
reconvertissant le résultat en RVB.

La  correction  gamma  est  facultative,  au  lieu  d’être  utilisée  par  défaut,  car  l’utilisateur  peut  souhaiter  la
désactiver pour mieux préserver les petits détails sombres sur un arrière-plan lumineux, qui seraient autrement
perdus dans l’éblouissement. De même, parce que la plupart des autres logiciels, tels que GIMP, ne disposent
pas de la correction gamma, et que l’utilisateur pourrait vouloir des résultats identiques à ceux produits par ces
logiciels.
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Vous pouvez faire en sorte que la correction gamma soit utilisée par défaut en activant la case à cocher dans la
fenêtre des préférences. Voici une image qui a été mise à l’échelle avec et sans correction gamma :

La correction gamma de ce type est également utilisée dans d’autres fonctions comme la rotation libre, l’effet de
masque de flou et l’effet de niveaux de gris.

6.3 Rotation

Il  est  possible  de  faire  pivoter  rapidement  l’image par  des  mouvements  de  90  degrés,  ou  selon  un angle
quelconque. Par exemple, vous pouvez avoir une photo qui n’est pas tout à fait droite, auquel cas vous pouvez
essayer cette procédure :

• Calculez l’angle de rotation nécessaire en utilisant la sélection du rectangle glissé d’une extrémité de la
ligne droite à l’autre (du bas à gauche au haut à droite), et l’angle apparaîtra dans la barre d’état – 12,1
degrés dans cet exemple :

• Faites une rotation en utilisant le menu Image et entrez l’angle négatif nécessaire pour redresser l’image,
c’est-à-dire -12,1 ici :
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6.4 Redimensionnement de la toile

Si vous souhaitez augmenter ou diminuer la largeur ou la hauteur de l’image, vous pouvez le faire en appuyant
sur la touche « Page suivante ».

6.4.1 Effets de tuiles

La boîte de dialogue de redimensionnement permet également d’activer diverses fonctions de tuiles. En voici
quelques exemples :

Original Image.

Excentrage -32, -32 with Tile.

Excentrage  -32,  -32  avec  'Effet  miroir'  et  retaillée  à
320x320.

6.5 Réglage de l’image Gamma, Luminosité,  Contraste,  Saturation,
Teinte

Si vous souhaitez ajuster la couleur d’une image, vous pouvez le faire en appuyant sur la touche Insertion (ou
Inser). Cela vous permet également d’utiliser la fonction de postérisation (ou isohélie) pour réduire le nombre
de couleurs de l’image.

Le  bouton  « Afficher  les  détails »  permet  d’afficher  des  commandes  supplémentaires :  choisir  le  type  de
postérisation (posterize type) ; faire en sorte que l’ajustement affecte la palette (l’ensemble ou une gamme de
couleurs spécifique) ou n’affecte pas l’image ; et laisser certaines composantes RVB non modifiées.

6.6 Appliquer des effets

Le menu Effets vous permet d’appliquer des effets au canevas actuel. Le type d’effets disponibles dépend du
fait que vous éditez une image à palette indexée ou une image RVB.
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6.6.1 Bactéries

Voici ce que l’effet bactéries peut faire à une image convenablement préparée :

6.6.2 Niveaux de gris

mtPaint dispose de deux méthodes pour générer une image en niveaux de gris. Il y a la méthode de base en
niveaux de gris et aussi une version corrigée en gamma comme expliqué dans la section 6.2.1.
Voici une comparaison visuelle :

Image originale

Niveau de gris (Ctrl-G)

Niveau de gris (correction gamma) (Maj+Ctrl-G)

6.6.3 Masque de flou

Le  masque  flou  est  un  type  spécial  de  méthode  d’accentuation  de  la  netteté  qui  convient  mieux  aux
photographies que l’effet  standard d’accentuation de la  netteté en raison du plus grand contrôle  dont vous
disposez.

La valeur du Rayon contrôle le nombre de pixels qui seront utilisés dans le processus d’accentuation. Si une
photo présente des détails plus fins, une valeur plus petite sera plus souhaitable. Si le rayon est trop élevé, des
halos peuvent apparaître sur les bords de la photo.

La valeur Montant contrôle le degré de netteté de l’image. Plus la valeur est élevée, plus l’image obtenue sera
nette.

La valeur Threshold (Seuil) définit la différence minimale en pixels avant d’appliquer l’accentuation. Cette
valeur peut être utilisée pour protéger les zones de gradients de couleur lisses, comme un ciel bleu, contre le
processus d’accentuation de la netteté.
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6.6.4 Flou gaussien

Voici un exemple visuel du flou gaussien avec les différentes combinaisons X/Y :

Image originale

X = 10, Y = 0

X = 0, Y = 10

6.6.5 Flou de Kuwahara-Nagao

Le  flou  de  préservation  des  bords  Kuwahara-Nagao  lisse  les  petits  détails  tout  en  préservant,  voire  en
accentuant,  les contours à plus grande échelle.  Il  peut être utilisé soit  comme un effet  artistique, soit  pour
prétraiter l’image pour la segmentation ou la détection des bords.

Les images d’exemple montrent l’effet du flou Kuwahara-Nagao (corrigé en gamma) avec un rayon de 1, 3 et
10.

En activant l’option « Protéger les détails », les irrégularités à plus petite échelle des contours ne seront pas
lissées.

6.6.6 Détection des bords

mtPaint dispose de 8 filtres de détection des bords, qui diffèrent par la largeur de leur réponse et  par leur
résistance au bruit des pixels. Essayez-les pour choisir celui qui convient le mieux à votre tâche.
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Habituellement, les résultats de la détection des bords sont améliorés si l’image est d’abord traitée avec un filtre
Kuwahara-Nagao de rayon 1 corrigé en gamma. L’exemple ci-dessous montre les résultats  du détecteur de
bords de Roberts avec et sans prétraitement.

6.7 Transformations isométriques

Le menu Effets vous permet de transformer une image plate en une version isométrique. Par exemple, voici
l’image de départ suivie de l’élément de menu « Côté gauche vers le bas » :

Cette image est créée en prenant l’image originale ci-dessus, puis en utilisant les éléments de menu « Côté
inférieur à droite » et « Côté gauche vers le bas » :

6.8 Conversion d’une image RVB en Palette Indexée

Il peut être souhaitable, pour des raisons techniques ou artistiques, de convertir une image RVB en une image
de palette indexée.  mtPaint  dispose de plusieurs outils  pour y parvenir  en utilisant  l’option « Convertir  en
couleurs indexées » du menu Image. Ce processus comporte deux parties : Premièrement, un nombre donné de
couleurs de palette est mis en place ; Deuxièmement, les pixels sont tracés en utilisant cette palette pour se
rapprocher de l’image RVB originale. Comme il s’agit d’une approximation, il n’existe pas de solution parfaite
et les résultats peuvent varier énormément en fonction des paramètres prescrits par l’artiste.

6.8.1 La palette

La première décision que vous devez prendre est le nombre de couleurs que vous souhaitez avoir dans la palette
(entre 2 et 256). Plus il y a de couleurs, plus l’image obtenue ressemblera à l’image RVB originale. Si vous
n’avez pas déjà préparé une palette, vous pouvez utiliser un quantificateur pour créer une palette approximative
pour vous. Chacun des quantificateurs utilisés par mtPaint a des avantages et des inconvénients différents, il est
donc préférable d’expérimenter pour découvrir celui qui fonctionne le mieux sur une image donnée.

Wu est un quantificateur rapide qui fonctionne généralement bien pour les grandes palettes.
PNN est un quantificateur plus lent que Wu, bien qu’il crée généralement de meilleures palettes.
Max-Min est un quantificateur rapide qui fonctionne mieux avec de petites palettes, combiné avec une forme de
tremblement de pixels comme Floyd-Steinberg ou Stucki.  Pour les petites palettes,  il  crée une palette plus
saturée et contrastée que Wu ou PNN.
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Pour  les  quantificateurs  Wu  et  PNN,  vous  pouvez  également  activer  l’option  « Pondération  basée  sur  le
diamètre ».  Celle-ci  attribue  plus  d’importance  aux  couleurs  moyennement  fréquentes,  ce  qui  permet
généralement d’obtenir une palette correspondant mieux aux couleurs des détails de l’image.

6.8.2 Les pixels

Une fois la palette préparée, les pixels peuvent être calculés sur le nouveau canevas de la palette indexée. La
méthode la plus simple consiste à choisir la couleur de la palette la plus proche de chacun des pixels, ce qui
correspond à l’option Aucun de la section Tramage. Les autres méthodes utilisent toutes des techniques de
tramage pour répartir les pixels et rendre l’image finale plus agréable à l’œil.

Les modes « Tramage (effet) » et « Dispersé (effet) » sont comme des effets spéciaux car leurs résultats sont
assez stylisés et peuvent ne pas ressembler à l’original. Pour une utilisation pratique, le mode « Floyd-Steinberg
(rapide) » est rapide et donne de bons résultats pour les palettes mieux adaptées, comme celles produites par la
quantification à 64 couleurs ou plus.

« Floyd-Steinberg » et « Stucki » sont des modes plus avancés qui distribuent les pixels selon les paramètres
prescrits à l’aide du bouton « Settings ». Les motifs Stucki ont tendance à être plus grossiers, avec des pixels
hors-couleur plus espacés. Voici ce que fait chacune des autres options :

• L’espace colorimétrique définit  la manière dont les couleurs sont comparées. Il existe trois espaces,
chacun mettant l’accent  sur différents aspects des couleurs physiques – naturellement,  au détriment
d’autres aspects. De ce fait, chacun d’eux peut être le meilleur choix dans certains cas, et le pire dans
d’autres.

• sRGB est  une  mesure  de  la  lumière  émise  par  un  pixel  de  couleur.  Comme le  tramage  manipule
également  la  lumière,  les  couleurs  les  plus  proches  en  sRGB  produisent  le  moins  de  différences
possibles, ce qui conduit à un résultat plus lisse, pour autant que la palette soit bien adaptée. Mais pour
les palettes mal adaptées, cela devient un inconvénient, car l’œil humain perçoit les différences entre les
couleurs claires beaucoup moins nettement qu’entre les couleurs sombres, et donc, les couleurs les plus
proches dans sRGB peuvent ne pas sembler les plus proches à l’utilisateur.

• RGB est l’espace couleur que tout le monde utilise, même si la plupart ne savent pas ce qu’il est et
comment l’utiliser correctement. Contrairement à sRGB, les valeurs RVB se rapportent à la lumière
émise par les pixels de manière non linéaire – et bien qu’elles ne soient pas exactement la mesure de la
luminosité perçue par l’homme, elles en sont plus proches que les valeurs sRGB. Pour cette raison, les
comparaisons en RVB produisent des différences réelles plus importantes qu’en utilisant sRVB – mais le
résultat peut quand même être meilleur.

• LXN est  un  espace  couleur  qui  tente  de  fournir  une  mesure  de  la  façon dont  les  gens  perçoivent
réellement les différences de couleur. Si son succès est limité, il faut s’y attendre : il ne peut y avoir de
mesure unique, car la perception des couleurs n’est en aucun cas constante ; chaque personne voit les
choses différemment, la même chose est  perçue différemment dans différentes conditions, etc. Mais
lorsque le RVB sélectionne une couleur tellement proche que seul un aveugle serait d’accord, c’est LXN
qui vient à la rescousse ; il est beaucoup moins enclin à trouver que le vert est le plus proche du rouge
ou  à  faire  quelque  chose  d’aussi  absurde.  Mais  là  encore,  avec  le  LXN,  les  différences  réelles  à
distribuer par le tramage ont tendance à être encore plus grandes que dans le cas du RVB, de sorte que le
motif résultant peut devenir plus visible.

La mesure de différence définit ce qu’il faut considérer comme une distance entre deux couleurs dans l’espace
couleur sélectionné. La plupart du temps, elle peut être laissée telle quelle, la distance euclidienne traditionnelle
étant sélectionnée par défaut ; mais on peut l’utiliser comme une astuce de dernier recours, car il y a toujours de
l’espoir. « Le plus large (Linf) » utilise comme distance la plus grande différence de coordonnées entre les trois
coordonnées, et « Somme (L1) » utilise les valeurs absolues de ces trois différences additionnées.
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L’option « Réduire l’étalement des couleurs » a pour but d’empêcher la propagation des différences de couleur
de  devenir  nuisible  et  de  produire  des  artefacts  visuels  au  lieu  d’améliorer  l’aspect  de  l’image.  L’option
« Gamme » par défaut est celle qui interfère le moins ; elle limite chaque couleur plus la différence aux limites
de la  palette,  de sorte  que la  différence ne puisse pas  s’accroître  indéfiniment  –  cela  permet  de garder  la
différence résoluble dans un seul pixel, empêchant ainsi l’apparition de bordures non colorées autour des zones
de couleur plate. L’option « Faiblement » limite en outre la différence à la moitié de la luminosité maximale, et
l’option « Fortement » la limite encore plus, à un quart de la luminosité maximale. Cette option pourrait être
utilisée pour éviter que des pixels de couleur différente n’apparaissent là où ils font plus de mal que de bien,
mais je préfère régler la propagation des erreurs.

« Scan serpentine » signifie que chaque deuxième ligne de balayage est  traitée dans le  sens inverse.  C’est
généralement le meilleur choix, car les différences sont distribuées alternativement de gauche à droite et de
droite à gauche, sans s’accumuler du côté droit et produire des artefacts visibles. Mais il y a des cas où il est
préférable de déverser la différence accumulée quelque part à droite plutôt que de la ramener vers la gauche –
dans ce cas, le balayage en serpentin pourrait être désactivé.

La  propagation  des  erreurs  contrôle  le  pourcentage  de  la  différence  provenant  de  chaque  pixel  qui  est
redistribué. Habituellement, c’est la totalité – 100 % ; mais pour les palettes qui ne sont pas très bien adaptées,
cette différence ne peut souvent pas influencer les pixels les plus proches et s’accumulerait inutilement jusqu’à
ce  qu’un  pixel  éloigné  prenne  une  couleur  déplacée.  Pour  éviter  que  cela  ne  se  produise,  le  niveau  de
propagation peut être réduit. Le conseil le plus courant est de le régler à 75 %, mais j’ai trouvé que 85 % produit
pratiquement le même résultat ; les images deviennent beaucoup plus claires, mais un peu plus sombres dans
l’ensemble. En général, elles sont plus belles lorsqu’on utilise le tramage Stucki.

Mais réduire la propagation des erreurs sans discernement n’est pas toujours la meilleure solution ; la solution
idéale serait d’atténuer uniquement les cas inutiles et nuisibles, tout en préservant les différences qui améliorent
la qualité visuelle. La propagation sélective des erreurs s’en rapproche, autant que possible dans des contraintes
de temps et d’espace acceptables.

La propagation sélective tente de faire passer la différence de couleur pas plus loin que les pixels voisins ; si
elle n’y est pas intégrée, elle doit être abandonnée. Mais le problème est que la différence entrante et la couleur
originale du pixel récepteur sont additionnées, et après que la couleur du pixel ait été sélectionnée en fonction
de cela, alors comment décider quelle partie de la différence restante appartient au pixel lui-même et doit être
propagée plus loin, et quelle partie provient de la différence entrante et doit être abandonnée ? Les quatre modes
étranges que vous voyez sont quatre façons différentes de résoudre approximativement ce problème insoluble.

Dans tous les cas, la différence est divisée dans la proportion de la différence entrante par rapport à la différence
locale (cette dernière étant la différence qui resterait si la différence entrante était nulle). Mais dans les modes
Séparer, les composantes rouge, verte et bleue sont pondérées séparément et divisées en fonction de cela – et
dans les modes Longueur, les longueurs des vecteurs de différence sont utilisées comme poids, les mêmes pour
les trois composantes.

L’autre moitié des noms des modes est liée à la gestion de la différence entrante qui n’a pas d’effet sur la
couleur du pixel récepteur ; dans les modes Somme, les différences sont encore pondérées et divisées de la
manière  ci-dessus,  et  les  modes  Découper  abandonnent  simplement  la  différence  entrante  et  propagent  la
différence locale.

Bien que les quatre modes résultants ne soient que marginalement différents, il y a toujours des cas où l’un
d’entre eux fonctionne mieux ou moins bien qu’un autre ; mais celui qui convient le mieux à une image donnée
ne peut être déterminé que par essais et erreurs.

Lorsque la propagation sélective est activée, le pourcentage de propagation d’erreur contrôle le pourcentage de
la différence entrante à préserver malgré son abandon ; par défaut, il est de 0, mais peut être augmenté à 75 %
ou 85 % pour obtenir une variante plus discriminante de la propagation d’erreur globale réduite.
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Là où la propagation sélective est la plus nécessaire, c’est dans le cas d’images de fine résolution converties en
palettes pas tout à fait adaptées. Pour une petite image de sprite convertie d’une palette à une autre, il  est
infiniment préférable d’obtenir, par exemple, une zone rouge légèrement plus foncée mais toujours lisse, plutôt
que de voir cette même zone parsemée de pixels blancs. La propagation sélective permet d’éviter ce genre de
situations malheureuses, tout en restant capable de convertir, par exemple, une zone de couleur rose en un motif
en damier de pixels rouges et blancs.

6.8.3 Exemples

A – Original.
B – 8 colours, Using current palette, Floyd-Steinberg (quick).
C – 8 colours, Using current palette, Floyd-Steinberg.
D – 8 colours,  Using current palette,  Floyd-Steinberg,  RGB colour space,  Séparer/Découper at  50 % error
propagation.
E – 8 colours, PNN Quantizer, Floyd-Steinberg.
F  –  8  colours,  Max-Min  Quantizer,  Floyd-Steinberg,  LXN colour  space,  Séparer/Découper  at  75 % error
propagation.

6.8.4 Trucs et astuces

6.8.4.1 Saturation

Parfois, les quantificateurs produisent des résultats plus plats et moins colorés qu’il n’est souhaitable. Cela peut
parfois être évité en rendant l’image plus saturée en utilisant la fenêtre « Transformer la couleur » avant de
convertir  l’image RVB originale.  Le meilleur  quantificateur  pour maintenir  la  saturation et  le  contraste  de
l’image pour les petites palettes (par exemple 16) est le Max-Min combiné avec Floyd-Steinberg ou Stucki.

6.8.4.2 Sélection manuelle des couleurs

Si vous réduisez une image RVB à quelques couleurs seulement, comme 16, le quantificateur peut manquer
quelques couleurs importantes que vous voulez voir apparaître dans l’image indexée. Vous pouvez éviter ce
problème manuellement en procédant comme suit :

• Réduisez la taille de la palette à 14 en utilisant 'Palette→Définir la taille de la palette'.
• Sélectionnez « Palette→Réduction » en utilisant le quantificateur de votre choix.
• Augmentez la taille de la palette à 16.
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• À l’aide de l’outil pipette de l’éditeur de palette, sélectionnez les deux couleurs supplémentaires dans le
canevas.

• Utilisez 'Image→Convertir en couleurs indexées…' avec 'Utiliser la palette courante' et la méthode de
tramage de votre choix.

Si vous utilisez des méthodes de tramage plus avancées, comme celle de Floyd Steinberg, il peut parfois être
utile de sélectionner les 8 coins du cube de couleur (noir, rouge, vert, jaune, cyan, magenta, blanc). En faisant
cela, les résultats seront plus contrastés qu’en utilisant un quantificateur, ce qui dans certains cas est préférable.
En utilisant  seulement  ces  8  couleurs,  mtPaint  sera capable  d’approcher  assez  bien  la  plupart  des  images
photographiques.

6.8.4.3 Paramètres de tramage

Les paramètres de tramage pour Floyd-Steinberg et Stucki doivent être expérimentés pour chaque image afin
d’obtenir les meilleurs résultats, mais j’utilise les paramètres suivants en raison de leurs bons résultats sur de
nombreux types de photos différents :

• espace couleur sRGB, 75 % de propagation d’erreur, division séparée.
• Espace couleur RVB, propagation des erreurs à 50 %, division séparée.
• Espace couleur RVB, propagation des erreurs à 75 %.
• Espace couleur RVB, propagation des erreurs à 85 %.

6.9 Inclinaison

En utilisant l’option Biais du menu Image, vous pouvez incliner le canevas verticalement, horizontalement, ou
dans les deux directions à la fois (horizontalement puis verticalement, en une seule opération). La quantité
d’inclinaison peut être spécifiée de deux façons : soit sous forme d’angle, soit sous forme de décalage dans la
direction de l’inclinaison,  à une distance spécifiée.  Cette  dernière méthode rend facile  la  réalisation d’une
inclinaison précise au pixel près – au lieu d’avoir à calculer un angle à partir du décalage et de la distance, il
suffit de fournir les valeurs à mtPaint.

6.10 Segmentation

Avec l’option Segment du menu Image, vous pouvez faire une carte de segmentation de l’image. Les résultats
sont bien meilleurs (les limites des segments suivent plus précisément les contours des objets dans l’image) si
l’image est prétraitée avec un filtre Kuwahara-Nagao de rayon 1 corrigé en gamma.
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Plus la valeur du Seuil (Threshold) est grande, plus les zones dissemblables peuvent être fusionnées en un seul
segment. Niveau contrôle la finesse de la segmentation sur une échelle logarithmique, en fixant un nombre
minimum de fusions pour un segment ; cela signifie que généralement, le plus petit segment d’un niveau est
environ deux fois plus petit que celui du niveau supérieur. La taille minimale (minimum size) augmente la
grossièreté sur une échelle linéaire, elle n’est donc utile que pour les faibles valeurs de Niveau.

Le passage à un espace couleur différent, ou à une autre mesure de différence, peut améliorer la segmentation
pour certaines images. Cependant, cela réinitialise la valeur du seuil et vous devrez l’ajuster à nouveau.

Les meilleurs paramètres de segmentation pour un objet spécifique dans une image spécifique ne peuvent être
trouvés que par essais et erreurs, ce qui est facilité par l’activation de l’aperçu. Les limites du segment seront
alors superposées à l’image sous forme de lignes fines, et recalculées dynamiquement à chaque modification
des paramètres (la couleur peut être sélectionnée dans la boîte de dialogue « Configurer la grille… »).

Lorsque vous êtes satisfait de la segmentation, appuyez sur Appliquer pour remplacer l’image par la carte de
segmentation, chaque segment étant rempli par une couleur RVB distincte. C’est à vous d’utiliser cette carte.

6.10.1 Extraction d’objets

Une utilisation possible que j’aimerais décrire est le découpage d’un objet complexe dans l’image. Pour ce
faire, vous configurez trois couches de la manière suivante :

• Couche de fond contenant l’image originale.
• Couche contenant la carte de segmentation, avec un canal alpha vide ajouté – c’est-à-dire complètement

transparent pour l’instant.
• Couche contenant la carte de segmentation traitée par le filtre de détection des contours de Roberts, avec

la couleur transparente réglée sur le noir – c’est-à-dire transparente sauf pour les contours des segments.

Lorsque vous activez « Afficher tous les calques dans la fenêtre », cela ressemble à ceci :
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Ensuite,  vous  passez  au  calque  transparent,  définissez  votre  couleur  A  comme  magenta  opaque  (RGB
255/0/255, alpha 255), et la couleur B comme transparente, disons verte (0/255/0, alpha 0), et procédez au
remplissage des segments n’appartenant pas à votre objet avec la couleur A et des segments lui appartenant avec
la couleur B. Lorsque vous avez terminé, cela ressemblera à ceci :

Vous passez maintenant à l’édition du canal alpha, l’inversez et le copiez dans le presse-papiers. Passez ensuite
au calque d’arrière-plan, puis à l’édition de son canal alpha (en créant un canal vide) et collez-y le presse-
papiers. Maintenant que tout est transparent sauf votre objet, vous pouvez en faire ce que vous voulez.
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7. Canaux

mtPaint est capable de créer et d’utiliser jusqu’à trois canaux utilitaires – Alpha, Sélection et Masque. Le menu
Canaux comporte diverses options qui sont utilisées pour gérer ces caractéristiques. À tout moment, ces canaux
auront  la  même  géométrie  que  l’image  en  cours  d’édition.  Vous  pouvez  afficher  les  canaux  comme  des
superpositions et prescrire la couleur et l’opacité de ces superpositions en utilisant l’option « Configurer les
superpositions ».

Vous pouvez éditer n’importe lequel des canaux en le sélectionnant dans le menu, puis en utilisant les outils de
peinture normaux. La valeur des pixels à tracer est prise dans la « barre des réglages ».

7.1 Canal alpha

Une image utilise un canal alpha afin de déterminer le degré de transparence d’un pixel donné. Les canaux
alpha peuvent être utilisés pour estomper les bords d’une image lorsqu’elle est superposée à une autre image,
par exemple avec des calques. C’est très utile pour des choses comme le texte.

Dans la fenêtre d’édition principale, un pixel rendu transparent par le canal alpha affichera le motif en damier
situé en dessous, comme ceci :

Si vous souhaitez modifier uniquement le canal alpha, il peut être utile de masquer le canal image ou d’afficher
le canal alpha en tant que superposition. Ces options peuvent être activées ou désactivées dans le menu Canal.
Voici à quoi ressemble l’image ci-dessus lorsque ces options sont activées :

Si vous désactivez l’alpha dans le menu Canal, tous les pixels s’afficheront comme totalement opaques, et les
processus  qui  respectent  la  transparence  de  l’alpha  –  comme  la  mise  à  l’échelle  de  l’image,  la  rotation,
l’inclinaison ou le flou gaussien – l’ignoreront.
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7.1.1 Couplage des opérations RGBA

Lorsque vous avez un canal alpha et que vous peignez sur le canal image, il peut être pratique de coupler les ac-
tions de peinture entre les canaux image et alpha (ou de les garder séparés). Par exemple, voici les résultats de
la peinture d’un rectangle avec l’option « Opérations RVBA » activée et désactivée via le menu Canal :

Remarque     :   le flou gaussien d’une image RGBA affecte à la fois les canaux image et alpha lorsque cette option
est  activée  (respecte  la  transparence  des  canaux  alpha  lorsque  l’option  « Désactiver  le  canal  alpha »  est
désactivée, ou les floute séparément lorsqu’elle est activée).

7.1.2 Dissocier l’alpha

Les images RVB avec transparence alpha peuvent être stockées de deux manières différentes.  La première
consiste à stocker les valeurs RVB brutes et les valeurs alpha sous forme de canaux séparés et indépendants ;
cette méthode est appelée « alpha non associé ». Une autre façon est de stocker les valeurs RVB non brutes,
mais  prémultipliées  par  la  valeur  alpha correspondante,  ce qui  est  alors  appelé « alpha associé ».  mtPaint,
comme la plupart des autres programmes de traitement d’images, stocke les images avec un alpha non associé,
pour pouvoir manipuler RVB et alpha indépendamment l’un de l’autre, et ne pas perdre les données RVB lors
de la mise à zéro de l’alpha. D’autre part, les logiciels de rendu préfèrent l’alpha associé, car avec les valeurs
RVB déjà multipliées par l’alpha,  il  reste  moins de travail  à faire en temps réel lors du mélange d’alpha.
Certains formats d’image, tels que TIFF et TGA, supportent les deux types d’alpha, mais sont fréquemment mal
étiquetés ; d’autres formats, tels que PNG ou BMP, ne supportent qu’un seul type d’alpha, et ne définissent
généralement pas lequel – en pratique, cela signifie que les deux types peuvent être aussi probables l’un que
l’autre. mtPaint convertit automatiquement les images dont l’alpha associé est définitivement reconnu en alpha
non associé – mais le type d’alpha ne peut pas être auto-détecté de manière fiable, et lorsque l’auto-détection
échoue, « Dissocier Alpha » permet de convertir une image mal détectée avec alpha associé en non associé.

7.2 Sélection

Le canal de sélection est utilisé par la fonction de copie afin d’inclure seulement certaines parties de l’image.
Par exemple, vous pouvez copier et coller une zone de forme elliptique comme ceci :
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7.3 Masque

Le canal masque est utilisé pour protéger certaines zones de l’image contre toute modification par les outils de
peinture. Par exemple, vous pouvez protéger une zone de forme elliptique comme ceci pour éviter de pulvériser
des pixels dessus :

Le canal masque peut également être utilisé pour appliquer de manière sélective des effets tels que le flou, la
netteté ou tout type de transformation de couleur.

Normalement,  chaque pixel de masque est  complètement activé ou désactivé (255 ou 0), mais des valeurs
partielles intermédiaires peuvent être utilisées pour offrir une semi-protection. Voir la  section 7.5.8 pour un
exemple de ceci.

7.4 Traitement des fichiers

Si vous éditez une image avec un quelconque type de canal, mtPaint enregistrera ces données dans le format de
fichier PNG. Tout autre format n’enregistrera pas ces données, donc si vous devez conserver le canal, vous
devrez utiliser le format PNG ou enregistrer le canal individuellement en utilisant le menu Canal.

Techniquement, le canal est enregistré en tant que fragment privé compressé, ce qui signifie que mtPaint sera
capable de reconnaître ces données, mais pas les autres éditeurs d’images.
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7.5 Trucs et astuces

7.5.1 Convertir une transparence de couleur en transparence alpha

Créez un canal alpha en utilisant « Définir la couleur A rayon B », avec A=B=couleur transparente.
Inversez le canal alpha

Cette méthode échoue pour les images de palette indexées qui contiennent une autre couleur de palette non
transparente avec les mêmes valeurs RVB que la couleur transparente. Cela peut être évité en changeant d’abord
la RVB de la couleur transparente en quelque chose de non utilisé.

Une autre méthode consiste à :

• Masquer la couleur transparente (c’est-à-dire cliquer à droite de la couleur transparente sur la palette de
manière à faire apparaître le x).

• Créez un canal alpha effacé.
• Modifiez le canal alpha et appuyez sur Ctrl-A pour tout sélectionner.
• Sélectionnez un alpha de 255 dans la barre des réglages.
• Remplissez la sélection.

7.5.2 Convertir une transparence alpha en une transparence couleur

• Créez un canal de masque à partir de l’alpha et passez à l’édition de celui-ci
• Fixez un seuil à la valeur de votre choix (128 pour qu’une transparence supérieure à la moitié devienne

transparente).
• Passez à l’édition de l’image
• Définissez la couleur A comme étant la couleur transparente
• Sélectionnez tout
• Remplir la sélection

7.5.3 Séparer un canal rouge, vert ou bleu

• Réglez la couleur A sur le cyan, le magenta ou le jaune respectivement.
• Activez le mode teinte et le mode teinte +-.
• Sélectionnez tout
• Sélection du remplissage

7.5.4 Ajout d’un canal rouge, vert ou bleu

• Copiez l’image monochrome dans le presse-papiers
• Chargez l’image RVB depuis un endroit quelconque
• Réglez la couleur A sur le rouge, le vert ou le bleu respectivement.
• Activez le mode teinte et le mode teinte +-.
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• Sélectionnez tout
• Remplir la sélection
• Désactiver le mode teinte +-
• Coller

7.5.5 Convertir du rouge, du vert ou du bleu en toute autre couleur

• Créer un canal de sélection à partir de R, V ou B
• Remplissez l’image avec la couleur que vous voulez
• Copiez-la dans le presse-papiers
• Remplir l’image de noir
• Collez

7.5.6 Ajouter ou soustraire des masques

• Copiez un masque dans le presse-papiers
• Chargez ou créez l’autre masque
• Activez le mode teinte (pour la soustraction, activez simplement le mode teinte +-).
• Coller

7.5.7 Créer un masque à partir d’une seule couleur

• Choisissez  la  couleur  dans  le  canevas  en  utilisant  Ctrl+Clic  gauche/droit  pour  la  stocker  dans  les
couleurs A et B.

• Créez de nouveaux canaux en utilisant « Définir couleur A rayon B ».

7.5.8 Découper des formes de texte à partir d’une photo

Il est possible de découper des formes de texte à partir d’une photo comme ceci :

• Chargez la photo dans mtPaint
• Créez et éditez un nouveau canal de sélection vide
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• Collez du texte sur le canal de sélection avec un anticrénelage.
• Créez un nouveau canal de masque basé sur le canal de sélection.
• Inversez le canal de masque
• Modifier le canal principal de l’image
• Sélectionner l’image entière et couper en utilisant Ctrl+A et Ctrl+X
• Supprimer les canaux de masque et de sélection
• Coller le presse-papiers sur l’image

Cette  technique fonctionne avec toutes  les  images.  Par exemple,  vous pouvez l’utiliser  pour  découper des
formes dans un dégradé que vous avez créé.
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7.5.9 Création de découpes de texte pour les pages Web

Il est possible de découper des formes de texte à partir d’une photo et de les utiliser comme graphiques pour le
Web :

• Chargez la photo dans mtPaint
• Créez et éditez un nouveau canal alpha
• Collez du texte
• Recadrez l’image sur le texte
• Enregistrez  l’image  en  tant  que  fichier  PNG RVB,  afin  qu’elle  puisse  être  lue  par  les  navigateurs

utilisant le canal alpha PNG.

7.5.10 Bords effilochés

Il est possible d’utiliser l’effet de flou gaussien pour adoucir le bord de n’importe quel canal comme ceci :

• Chargez une image dans mtPaint
• Créez un nouveau canal de sélection et l’éditez*
• Utilisez l’outil de sélection pour peindre une ellipse remplie de la zone à copier/coller*
• Utilisez l’effet Flou Gaussien avec une valeur de 10
• Éditez le canal image puis appuyez sur Ctrl-C*
• Appuyez sur Ctrl-V, déplacez le collage où vous voulez et collez-le soit par clic-droit ou Entrée*
• Supprimez le canal Sélection*

(* complément apporté lors de la traduction afin de préciser la méthode)

Il est également possible d’utiliser un dégradé pour obtenir d’autres types de bords en plumes comme celui-ci :
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7.5.11 Bords soulignés

Il est possible d’utiliser un canal alpha pour créer des contours sur une image comme celle-ci :

• Chargez l’original dans mtPaint
• Ctrl+A, Ctrl-C, Ctrl+Shift+V pour créer un nouveau calque.
• Sélectionnez l’option de menu « Effets→Trouver les contours… ».
• Appuyez sur la touche Inser, réglez la saturation au minimum et augmentez le gamma à environ 300.
• Sélectionnez l’option de menu « Canal→Éditer le canal alpha » et créez le canal alpha rouge.
• Sélectionnez l’option de menu « Canal→Éditer l’image ».
• Sélectionnez « Effets→Inverse » (ignorez pour des bords blancs), puis « Canal→Seuil… » à la valeur

230.

Si vous voulez rendre les bords plus nets, sélectionnez « Canal→Éditer le canal alpha » et « Canal→Seuil… » à
la valeur 30.

Exportez l’image composite en utilisant « Calque→Enregistrer l’image composée… ».
Si vous voulez conserver l’image de contour et son canal alpha, utilisez « Fichier→Enregistrer sous… ».
Si vous voulez conserver le fichier de données des calques, utilisez « Calque→Enregistrer sous… ».
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7.5.12 Masquage partiel

Il est possible d’utiliser le masquage partiel pour créer des effets de transition d’image. Par exemple, j’ai créé
l’image suivante en procédant comme suit :

• Créez une image en utilisant un motif de damier.
• Créez un canal de masque vide.
• Peignez un dégradé sur le canal de masque.
• Collez une autre image sur le canal d’image (dans ce cas, des zigzags jaunes).

7.5.13 Sélections à la baguette magique

Il est possible d’émuler l’outil Baguette magique qui apparaît dans d’autres programmes graphiques en utilisant
un canal de sélection et l’outil de remplissage. Par exemple, voici l’image de départ :

Pour copier et coller l’étoile rouge, vous devez procéder comme suit :

• Créez un nouveau canal de sélection vide.
• Faites un clic droit sur l’icône de remplissage et cochez l’option « Par canal ».
• Sélectionnez l’outil de remplissage et assurez-vous que dans la barre des réglages, la valeur de sélection

est 255.
• Cliquez avec le bouton gauche sur l’étoile rouge.
• Revenez à l’édition du canal d’image.
• Utilisez l’outil de sélection du rectangle pour placer un carré autour de l’étoile rouge.
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Appuyez sur le bouton lasso et vous devriez être en mesure de déplacer l’étoile rouge sélectionnée, prête à être
collée comme ceci :

Il est également possible d’utiliser cette méthode de remplissage plusieurs fois avant de copier et coller afin
d’ajouter plusieurs zones de l’image originale à la sélection. Par exemple, je peux remplir les formes bleues et
jaunes pour obtenir ce résultat :

7.5.14 Remplacement des couleurs

Il est possible de remplacer une couleur sans toucher aux autres, en utilisant n’importe quel outil de dessin. En
mode indexé, vous pouvez le faire en utilisant le masque de couleur :

• Sélectionnez l’option de menu « Palette→Protéger toutes les couleurs » ; des marques « x » apparaîtront
à côté de toutes les couleurs dans la fenêtre de la palette.

• Cliquez sur la marque « x » à côté de la couleur que vous souhaitez remplacer, pour la démasquer.
• Dessinez.

En mode RVB, vous utilisez le mode de sélection des couleurs :

• Cliquez  avec le  bouton droit  de  la  souris  sur  l’icône  du  Mode couleur  sélective  dans  la  barre  des
réglages, pour ouvrir la boîte de dialogue de configuration.
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• Réglez la couleur Centrer sur la couleur que vous souhaitez remplacer.
• Sélectionnez le mode Cube, cochez l’option Inverse et réglez le rayon sur 0.
• Appuyez sur OK pour fermer la boîte de dialogue.
• Cliquez avec le bouton gauche sur l’icône du mode de sélection des couleurs pour activer le mode.
• Dessinez.
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8. Couches

Pour  certains  types  de  peinture  et  de  manipulation  d’images,  il  est  pratique  d’utiliser  plusieurs  couches
d’images plutôt qu’une seule image. Par exemple, vous pouvez superposer du texte ou des dessins sur une
photographie et être en mesure de déplacer ou de modifier chaque couche indépendamment.

8.1 Création

Pour créer un nouveau calque, vous pouvez utiliser la fenêtre Calques (touche « L » ou menu Affichage), ou le
menu Calque. Comme pour une nouvelle image, un nouveau calque peut être créé soit vide, soit à partir d’une
capture d’écran, soit à partir du presse-papiers. Vous pouvez ensuite éditer, manipuler, charger ou enregistrer ce
nouveau calque comme n’importe quelle autre image.

Le calque d’arrière-plan a quelques propriétés spéciales. Il se trouve sous tous les autres calques et ne peut pas
être déplacé, toute transparence est ignorée lors de la composition et la taille du calque d’arrière-plan détermine
la taille de l’image composite finale. Pourtant, tous les calques sont égaux – vous pouvez faire de n’importe
quel autre calque l’arrière-plan, ou transformer l’arrière-plan en un calque normal, en réorganisant les calques
(en les élevant ou les abaissant).

8.1.1 Glisser-déposer (Drag n Drop)

Si vous avez plusieurs images que vous voulez ouvrir en tant que calques, il est possible de le faire en utilisant
un gestionnaire de fichiers et sa fonction glisser-déposer. Il suffit de sélectionner tous les fichiers images que
vous souhaitez à l’aide de votre gestionnaire de fichiers préféré (par exemple Rox, Konqueror, Nautilus), puis
de les faire glisser sur la fenêtre principale de mtPaint et de relâcher le bouton de la souris. mtPaint chargera
alors chacun des fichiers comme un nouveau calque.

8.2 Manipulation

Vous  pouvez  déplacer  n’importe  quel  calque  en  le  cliquant  et  en  le  faisant  glisser  dans  la  fenêtre  de
visualisation, ou en appuyant sur CTRL et en utilisant les touches fléchées (+SHIFT permet de déplacer le
calque comme un collage). Vous pouvez également utiliser les rotations de coordonnées dans la fenêtre des
calques. Il existe également un bouton dans la fenêtre des calques qui replace le calque au centre de l’image de
fond.

La fenêtre  des  calques  vous permet  de nommer chaque calque pour  plus  de commodité  et  de le  masquer
temporairement en décochant le bouton à bascule à droite du nom du calque. Elle vous permet également de
dupliquer, de supprimer, d’élever ou d’abaisser les calques, et de modifier leur opacité.

Lorsque  vous  décidez  d’enregistrer  cette  image  composite,  vous  utilisez  le  menu  Calque.  Vous  pouvez
également placer l’image composite dans un nouveau calque. Si vous souhaitez enregistrer les informations
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relatives  aux  calques,  vous  devrez  utiliser  l’option  « Calque→Enregistrer  sous… »  qui  enregistre  un  petit
fichier texte contenant des informations sur chaque calque.

Vous pouvez ensuite recharger ces calques dans mtPaint en chargeant le fichier texte. Veuillez noter que lorsque
vous enregistrez l’image composite  ou le  fichier  texte,  vous n’enregistrez pas  chaque couche individuelle.
Comme mentionné précédemment, chaque calque est considéré comme son propre fichier et doit être enregistré
avec le menu Fichier ou Ctrl-S comme d’habitude. L’avantage de traiter les couches séparément est le suivant :

• Moins d’espace disque est nécessaire car les calques ne sont pas regroupés dans un nouveau fichier.
• Les couches d’images peuvent être modifiées avec n’importe quel autre éditeur d’images.
• Si vous utilisez une image standard pour plusieurs images composites (par exemple, un logo standard ou

un morceau de texte pour le filigrane des photos), vous ne devez modifier qu’une seule image et toutes
les  autres  images  composites  seront  mises  à  jour  automatiquement  la  prochaine  fois  que  vous  les
enregistrerez.

Après avoir enregistré le fichier texte des calques, vous ne devez pas le déplacer ailleurs, à moins de déplacer
également les fichiers image avec lui, car ces références de fichiers sont relatives. La méthode la plus simple
consiste à conserver toutes les images originales et les fichiers texte dans un seul répertoire.

8.2.1 Espace d’annulation commun

Lorsque vous utilisez des calques, la limite de mémoire d’annulation définie dans la fenêtre des préférences doit
être divisée par le nombre de calques pour déterminer la limite par calque. Par exemple, avec une limite de
32MB et 4 couches, il y a une limite de 8MB par couche pour l’annulation. Cela s’explique par le fait que dans
mtPaint, l’annulation de chaque calque fonctionne indépendamment ; vous pouvez annuler et refaire des actions
sur un calque même si vous en éditez un autre simultanément.

Lorsque  vous  utilisez  de  nombreux  calques,  la  mémoire  d’annulation  est  divisée  en  petits  morceaux
inconfortables. Certains calques peuvent n’utiliser qu’une petite partie de l’espace d’annulation qui leur est
alloué, tandis que d’autres sont à l’étroit. Pour pallier ce problème, mtPaint utilise ce qu’on appelle « l’espace
d’annulation commun ». Il s’agit d’une part de la mémoire d’annulation qui est disponible pour tous les calques,
le calque courant ayant la priorité. Par défaut, il prend 25 % de l’espace total d’annulation. De cette façon, quel
que soit le nombre de couches que vous avez, la couche avec laquelle vous travaillez peut utiliser plus de 25 %
de la mémoire d’annulation.

Cependant, l' « espace d’annulation commun » est une solution de compromis, et imparfaite comme tous les
compromis. Si la couche actuelle a besoin de plus d’espace commun que ce qui reste inutilisé par les autres
couches, alors les cadres d’annulation d’une autre couche devront être libérés pour obtenir cet espace (les cadres
d’annulation les plus anciens des couches les  plus  « gourmandes » sont  libérés en premier).  Ainsi,  lors de
l’utilisation de l’espace commun, l’annulation par couche n’est plus absolument indépendante. En général, ce
n’est pas un problème, mais si c’est  le cas, vous pouvez réduire l’espace commun à 0 dans la fenêtre des
préférences.  Alternativement,  vous  pouvez  l’augmenter,  pour  permettre  au  calque  courant  d’utiliser  plus
d’espace d’annulation.
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8.3 Exemples

Voici quelques  exemples d’images composites  créées à l’aide des fonctions de calque.  Cliquez sur chaque
image pour télécharger les fichiers sources :

8.4 Trucs et astuces

8.4.1 Créer un album en utilisant les calques

• Créez une nouvelle image d’arrière-plan suffisamment grande pour contenir toutes vos images.
• Sélectionnez un groupe de fichiers d’images (par exemple des photos ou des images clip art) à l’aide de

votre gestionnaire de fichiers préféré, puis faites-les glisser et déposez-les sur la fenêtre principale de
mtPaint pour les charger en tant que nouveaux calques.

• Positionnez les images dans la fenêtre d’affichage de façon à ce qu’elles soient toutes visibles et posées
sur l’image de fond.

• Créez de nouveaux calques afin de contenir les éléments de texte individuels.
• Enregistrez le fichier de calques afin de pouvoir modifier les calques ultérieurement, puis enregistrez le

fichier de l’image composite afin de pouvoir le distribuer comme une image PNG/JPEG standard.

8.4.2 Pochoirs de dégradé

Si vous combinez la fonction de calques avec des dégradés et des canaux alpha, vous pouvez créer des images
utiles à base de pochoirs. Par exemple, vous pouvez faire des choses comme ceci :

Si vous cliquez sur l’image ci-dessus, vous pouvez télécharger un fichier zip contenant les différentes images de
calque que vous pouvez ensuite étudier pour voir comment elles ont été créées et comment elles fusionnent
pour créer l’image composite finale.
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Chaque objet possède son propre calque, ce qui permet de le déplacer indépendamment des autres objets. De
plus, vous pouvez réutiliser tous les calques dans n’importe quel autre projet en utilisant n’importe quel éditeur
d’images, car il s’agit simplement de fichiers PNG RGBA.

Les objets texte utilisent un gradient linéaire (ou un noir plat pour l’ombre) comme canal d’image RVB. Le
pochoir de texte est créé en utilisant un canal alpha et en collant du texte dessus.
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9. Animation

mtPaint  est  capable  d’éditer  des  cadres  d’animations  et  aussi  de générer  des  cadres  d’animations  avec les
facilités des calques. Si vous avez installé le programme Gifsicle, vous pouvez également créer un fichier GIF
animé. Si vous n’avez pas encore Gifsicle, vous pouvez le télécharger sur http://www.lcdf.org/gifsicle/.

9.1 Chargement des fichiers GIF animés

Lorsque vous essayez de charger un fichier GIF qui a plusieurs images, mtPaint chargera la première image,
détectera qu’il y en a d’autres et vous donnera ensuite un message pour vous demander ce que vous voulez faire
avec le fichier. Vous pouvez soit en rester là, soit charger jusqu’aux 100 premières images de l’animation dans
des calques, soit exporter (exploser) toutes les images dans un répertoire pour les éditer comme des fichiers
séparés, soit visualiser l’animation dans la gifview de Gifsicle.

Les images peuvent être chargées, ou exportées, de l’une des trois manières suivantes :

• Les images composées (par défaut) sont des images d’animation telles qu’elles sont affichées.
• Les images brutes sont les images telles qu’elles sont stockées dans le fichier d’origine.
• Images composées avec un délai non nul signifie que seules les images d’animation ont une chance

d’être vues : certains fichiers GIF composent plusieurs images sans aucun délai pour produire une image
visible.  Ce n’est  pas  la  valeur  par  défaut  car  certains  (anciens)  GIFs utilisent  un délai  nul  tout  en
contenant des animations.

Si  vous  choisissez  « Explode  frames »,  mtPaint  vous  demandera  de  choisir  un  répertoire  temporaire  pour
stocker ces images. Il est conseillé de créer un nouveau dossier (via le sélecteur de fichiers) près du fichier GIF
original pour faciliter la navigation.

Après que mtPaint ait créé ces cadres, un nouveau processus mtPaint sera lancé avec les noms de fichiers des
cadres dans la fenêtre de la ligne de commande. Vous cliquez sur le nom d’un cadre et celui-ci sera chargé pour
que vous puissiez l’éditer comme une image normale.

Une fois  que vous avez fini  d’éditer  les  images  et  que vous voulez créer  le  nouveau fichier  d’animation,
sélectionnez « Exporter une animation GIF... » dans le menu fichier pour faire apparaître la boîte de dialogue du
fichier. La zone de délai de trame définit le délai en 1/100e de seconde entre chacune des trames. Cette valeur
devrait être mémorisée à partir du moment où l’animation a été chargée, mais elle peut ne pas être exacte si le
fichier d’entrée a plusieurs valeurs de retard différentes. Dans la case du nom de fichier, entrez le nouveau nom
de fichier, par exemple « new.gif », puis enregistrez le fichier à l’endroit de votre choix.
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9.2 Création de fichiers GIF animés

Voici un exemple des étapes que vous pouvez suivre pour créer un simple fichier GIF animé :

• Utilisez le menu Fichier pour créer une nouvelle image de palette indexée de 320x240 pixels avec 8
couleurs. Pour créer un GIF animé, il doit s’agir d’une palette indexée et non d’une image RVB.

• Utilisez le menu Fichier pour sélectionner « Enregistrer sous... ». Naviguez vers un endroit approprié et
créez un nouveau dossier pour vos images d’animation. Entrez dans ce dossier, sélectionnez le format
GIF et nommez le fichier « frame-001.gif ».

• Appuyez sur T pour faire apparaître la fenêtre de saisie du texte à coller et tapez Animating. Appuyez sur
Entrée et collez ce texte en haut de l’image. Utilisez Fichier→Enregistrer sous pour enregistrer cette
image sous le nom de « frame-002.gif ».

• Appuyez à nouveau sur T et collez le texte « is » au centre de l’image. Enregistrez cette image sous le
nom de « frame-003.gif ».
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• Appuyez à nouveau sur T et collez le texte fun !!! en bas de l’image. Enregistrez cette image sous le
nom de « frame-004.gif ».

• Sélectionnez « Exporter un GIF animé » dans le menu Fichier pour faire apparaître la boîte de dialogue
du fichier. Saisissez 100 dans la zone de délai d’affichage, ce qui crée un délai d’une seconde entre
chaque image. Dans le champ du nom de fichier, entrez « final.gif » et appuyez sur la touche Entrée
pour créer le fichier.

9.3 Animer des calques

L’utilisation de couches pour créer une animation peut vous faire gagner beaucoup de temps et d’efforts. Au lieu
d’éditer chaque image pixel par pixel, vous définissez des images clés qui déterminent la position de toutes les
couches. Une fois que vous êtes satisfait de la configuration, vous pouvez créer toutes les images en appuyant
sur un bouton, car mtPaint calculera toutes les images « intermédiaires ». Vous devez être très à l’aise avec les
calques, si vous ne l’êtes pas, je vous suggère de lire la section sur les calques.

9.3.1 Préparation des idées

Une fois que vous avez trouvé une idée d’animation, vous devez préparer vos plans avant d’utiliser mtPaint. Par
exemple,  vous devez décider de questions telles que la taille finale de l’image, les images par seconde, le
nombre de couleurs utilisées et la durée totale de l’animation.

9.3.2 Initialisation du projet

Avant de commencer à travailler sur l’animation, il est conseillé de créer un nouveau répertoire pour y placer
tous les fichiers d’images, car cela facilite grandement la gestion des fichiers. Vous créez ensuite une image de
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fond qui déterminera la taille de l’animation finale. Enfin, vous créez et enregistrez chacun des calques d’image
que vous souhaitez utiliser dans l’animation.

Une fois que les couches d’image sont en place, vous pouvez configurer l’animation à l’aide de l’option de
menu « Calque→Configurer l'animation... ». Vous déterminez ici les numéros de la première et de la dernière
image, le nom du répertoire dans lequel se trouvent les images, et divers autres détails.

9.3.3 Configuration des positions et des données de cycle

Après  avoir  positionné  chacun  des  calques  pour  la  première  image,  vous  sélectionnez  l’option  de  menu
« Image→Définir l’image clé ». Vous pouvez ensuite faire de même pour les autres images clés de l’animation.
Dans l’onglet positions de la fenêtre de configuration, vous pourriez avoir les 2 lignes suivantes :

1 10 10 255 0
10 20 20 128 0

Cette couche commencera à la position (10,10) dans l’image 1 et se déplacera à (20,20) à l’image 10 avec une
opacité changeant de 100 % (255) à 50 % (128). Chacune des images 2 à 9 est calculée par mtPaint comme une
image intermédiaire. Le 0 à la fin signifie que ce sera une ligne droite. Une valeur de 1 signifierait que mtPaint
déplace ce calque sur une courbe légèrement plus douce entre les points donnés.

L’onglet Cycles est utilisé pour déterminer quels calques sont visibles à un moment donné. Jusqu’à 100 lignes
peuvent être saisies dans le format suivant :

frame1 frame2 layer1, layer2, layer3,…, couche50

Jusqu’à 100 couches peuvent être listées sur chaque ligne. Entre les 2 images de l’animation, une seule de la
séquence sera visible,  les autres étant désactivées. Au fur et  à mesure que l’image s’incrémente, la couche
suivante de la séquence sera affichée, et la précédente sera cachée.

Par exemple :

1 10 1, 2, 3

Permet de faire varier la visibilité des couches 1, 2 et 3 entre les images 1 et 10.

Normalement,  l’image 2  sera supérieure  à  l’image 1,  mais  si  elles  sont  égales,  vous  pouvez  alors  définir
manuellement quelles couches sont visibles ou invisibles à cette image. Par exemple :

15 15 10, 11, 12, -1, -2, -3

Affiche les couches 10, 11, 12 et cache les couches 1, 2, 3 à l’image 15.
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Vous pouvez ensuite prévisualiser cette animation en appuyant sur le bouton de prévisualisation (ou en utilisant
le menu Frames) et en faisant glisser le curseur pour visualiser l’animation. Vous pouvez également utiliser les
touches fléchées, les touches page précédente/suivante, ou les touches + ou – pour changer d’image.

9.3.4 Exporter des images pour un encodage GIF ou MPEG

Lorsque vous êtes satisfait de l’animation que vous avez créée, vous pouvez exporter les images en cliquant sur
le bouton « Créer des trames » (menu Calque→Configurer l'animation). Si vous avez sélectionné l’option GIF,
mtPaint générera des fichiers GIF à palette indexée, sinon il générera des fichiers PNG RVB. Vous pouvez
ensuite utiliser un logiciel d’encodage tel que Gifsicle ou mencoder pour transformer ces cadres en un fichier
d’animation. Si vous encodez vers des fichiers GIF, mtPaint tentera d’appeler Gifsicle automatiquement et de
créer le GIF animé pour vous. Sur les systèmes GNU/Linux, gifview sera également utilisé pour afficher le
résultat.

Voici un exemple de comment faire pour que mencoder crée un fichier MPEG avec des fichiers PNG RVB :

mencoder mf://*.png – mf fps=25 – ovc lavc – lavcopts vcodec=mpeg4 – o output.avi

Pour  plus  d’informations  sur  l’utilisation  de  mencoder,  consultez  la  page  d’accueil  de  mplayer
http://www.mplayerhq.hu/

Pour plus d’informations sur l’utilisation de gifsicle, consultez la page d’accueil http://www.lcdf.org/gifsicle/.

9.3.5 Notes supplémentaires

Si vous composez une animation particulièrement longue qui nécessite plus de 100 lignes dans la table de
position ou de cycle,  vous pouvez simplement copier le  fichier layers et  avoir  des fichiers différents  pour
chaque section de l’animation. Par exemple, 'layers00001-00500.txt' peut être utilisé pour les 500 premières
images et 'layers00500-01000.txt' pour les 500 secondes. Vous créez ensuite les images comme d’habitude dans
chaque cas et vous les tricotez ensemble avec votre logiciel d’encodage préféré.

9.4 Exemples d’animations de palettes indexées

Voici  quelques  exemples  d’animations  créées  avec  mtPaint  et  Gifsicle.  Cliquez  sur  chaque  image  pour
télécharger les fichiers sources :
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9.5 Exemples d’animations RVB

Bien que mtPaint soit principalement orienté vers le pixel art à palette indexée, il est également capable de créer
des animations RVB qui utilisent un canevas plus grand, une fréquence d’images plus élevée et une opacité
variable pour les couches. Voici quelques exemples :

Lorsque  vous  créez  les  images  de  cette  animation,  il  est  conseillé  d’utiliser  une  faible  valeur  pour  la
compression  PNG,  par  exemple  1.  Voir  la  section  A.2 pour  plus  d’informations  sur  les  paramètres  de
compression PNG.

9.6 Déplacement de palette

Le décalage de palette est une technique ancienne utilisée pour créer l’illusion du mouvement en déplaçant les
couleurs de la palette entre des limites définies. Comme elle est basée sur la palette, elle ne fonctionne que sur
des images de palette indexées. Le décalage de palette dans mtPaint est invoqué en utilisant l’option Cycles du
menu Palette, qui vous montrera le dialogue suivant :

Chaque ligne représente un décalage de palette dans la séquence, les deux premiers chiffres représentant le
premier et le dernier numéro des couleurs de la palette à décaler. En inversant les chiffres, vous inversez le sens
du décalage. Le délai est le nombre d’images à attendre avant le prochain décalage, zéro signifiant aucun délai.
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Voici deux images :

Si vous chargez la première image dans mtPaint, et que vous appelez ensuite le dialogue de décalage de palette,
vous pouvez reproduire l’animation en entrant les données suivantes :

13,6,0

50,19,0

51,82,0

Afin  de  rendre  plus  claire  la  façon dont  j’ai  créé  l’image,  voici  une  version  de  l’image avec  une  palette
légèrement différente pour exposer les couleurs cachées :

Une fois que vous avez créé une animation dont vous êtes satisfait, vous pouvez créer un GIF animé en suivant
les étapes suivantes :

• Chargez l’image originale, afin d’effacer l’historique des annulations.
• Configurez le changeur de palette avec les valeurs que vous souhaitez, et utilisez le bouton de lecture

pour prévisualiser les résultats.
• Appuyez sur le bouton « Créer des trames » et fermez la fenêtre du changeur de palette.
• Annulez une image en appuyant sur Ctrl-Z.
• Sélectionnez « Exporter les tampons d'annulation... » dans le menu Ficier et placez les fichiers dans un

nouveau répertoire en utilisant le préfixe de nom de fichier « out ». Veillez à sélectionner le type de
fichier GIF.

• Chargez l’une de ces images d’annulation, par exemple out001.gif.
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• Sélectionnez « Exporter une animation GIF » dans le menu Fichier et choisissez un nom de fichier et un
délai appropriés.

Voici d’autres exemples de décalage de palette, avec l’image source et les entrées nécessaires pour les créer :

1,60,0

1,16,0

1,16,0
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Annexe A – Divers

A.1 Raccourcis

La liste complète de tous les raccourcis clavier et souris de mtPaint fait partie de l’aide intégrée, appelée par la
touche  F1  ou  par  l’option  de  menu  « Aide→A  propos » ;  voir  les  sections  « Raccourcis  clavier »  et
« Raccourcis souris ».

De plus, plusieurs des options de menu ont leurs raccourcis clavier étiquetés à côté de l’option.

En plus de ceux-ci, il existe un raccourci facultatif que vous pouvez trouver utile : La touche Q permet de
quitter le programme, si elle est activée dans la section Interface de la fenêtre Préférences.

A.2 Types de fichiers supportés

mtPaint peut gérer les formats de fichiers suivants :

Format Load Save Image Type

BMP All
Palette  indexée.  24  bit  RVB.  Canal  alpha
inclus.

Any

GIF
All  single  images.
Animation  frames  via
Gifsicle.

Indexed palette including transparency index.
Animations via Gifsicle.

Indexed

JPEG All. 24 bit RVB. RGB

JPEG2000 All. 24 bit RVB. RGB

LSS16
(*.lss)

All.
Indexed  palette  (16  colours),  18  bits  per
colour (6 per RVB channel).

Indexed  with  16
colours or less

PNG All.
Indexed  palette.  24  bit  RVB.  Including
transparency  index,  alpha/selection/mask
channels.

Any

TGA All.
Palette  indexée.  24  bit  RVB.  Canal  alpha
inclus.

Any

TIFF All.
Palette  indexée.  24  bit  RVB.  Canal  alpha
inclus.

Any

XBM All. 2 colour indexed palette including hotspot.
Indexed  with  2
colours

XPM
All with 4096 colours or
less

Indexed palette. 24 bit RGB images with up to
4096  colours.  Including  transparency  index
and hotspot

Indexed, or RGB with
4096 colours or less

Les types de fichiers PNG, JPEG, JPEG2000, TIFF et GIF sont gérés par des bibliothèques externes : libpng,
libjpeg, libopenjpeg, libtiff et libungif/giflib. De ce fait, l’efficacité de ces opérations de fichiers dépendra de la
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version de ces  bibliothèques  installée  sur  votre  système.  Par  exemple,  libtiff  est  incapable de lire  certains
anciens fichiers TIFF compressés en JPEG. Pour plus d’informations sur ces bibliothèques, consultez leurs sites
web respectifs :

libpng http://www.libpng.org/pub/png/libpng.html

libjpeg http://www.ijg.org/

libopenjpeg http://www.openjpeg.org/

libtiff http://www.libtiff.org/

libungif / giflib http://libungif.sourceforge.net/doc/

A.2.1 Fichiers PNG

Lorsque vous enregistrez un fichier PNG, vous pouvez utiliser la fenêtre des préférences ou la boîte de dialogue
« Enregistrer sous… » pour définir une valeur de compression comprise entre 1 et 9 (0 = aucune compression).
Une valeur de 9 est celle qui compresse le plus, mais elle a pour inconvénient d’augmenter l’utilisation du
processeur et le temps nécessaire à la création du fichier. Par conséquent, pour les grandes images, il peut être
judicieux d’utiliser une valeur inférieure. Une sauvegarde plus rapide peut être très importante pour certaines
tâches, comme la sauvegarde des images d’une animation. Voici un tableau comparant le temps qu’il me faut
pour  enregistrer  une  photo  de  4096x4096.  À  titre  de  comparaison,  le  format  d’image  de  base  BMP est
également inclus :

Format Seconds to Save % of PNG 9 KB file size % of PNG 9

BMP 1 0.6 49,236 514.7

PNG 1 6 3.8 13,055 136.5

PNG 5 10 6.4 10,656 111.4

PNG 9 156 9,566

A.2.2 Fichiers JPEG 2000

Le format de fichier JPEG est actuellement le format de fichier le plus couramment utilisé pour stocker des
photos numériques. Cependant, il existe également un format plus moderne et de meilleure qualité appelé JPEG
2000 que mtPaint peut utiliser. Malheureusement, ce format plus récent n’est pas encore supporté par tous les
visualiseurs d’images (par exemple les navigateurs web) et les éditeurs, mais il reste un excellent choix pour
stocker des images lorsque la qualité est le facteur le plus important.

Les fichiers JPEG 2000 (JP2) présentent deux avantages principaux par rapport à un fichier JPEG ordinaire :

• Pour la même taille de fichier, les fichiers JP2 sont normalement d’une qualité supérieure.
• Les photos peuvent être stockées sans perte, de sorte qu’aucune information n’est perdue.
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A.2.2.1 Comparaison d’images avec perte – JPEG vs JP2

Dans cet exemple, j’ai utilisé la photo de la  section 6.8.3, puis je l’ai enregistrée en tant qu’image JPEG au
niveau 95, et je l’ai comparée à un fichier JPEG 2000 enregistré au niveau 6. La taille du fichier JPEG était de
15 172 octets, celle du fichier JP2 de 14 438 octets.

L’analyse pixel par pixel de la différence entre l’image originale et les fichiers compressés révèle les erreurs
suivantes :

Channel JP2 (6) JPEG (95)

Maximum Error

Red 19 84

Green 12 46

Blue 21 104

Average Error

Red 2.78 4.17

Green 1.87 2.54

Blue 2.62 5.15

Ces données ont  été  créées  en utilisant  le  programme micmp de libmtpixel,  disponible  sur  le  site  web de
mtPaint.

Dans cet exemple, l’image JP2 de gauche est beaucoup plus proche de l’original au centre que le JPEG de
droite. Le passage de roue du JPEG en haut est beaucoup plus flou et a complètement perdu son bord lumineux.

Dans cet exemple, le toit de la voiture rouge semble être d’une nuance différente sur l’image JPEG du bas par
rapport à l’original du centre et l’image JP2 du haut.

A.2.2.2 Comparaison des images sans perte – PNG vs JP2

Pour  stocker  une  image  photographique  sans  perte,  il  est  possible  d’utiliser  un  fichier  PNG  compressé.
Cependant, pour la plupart des photos, le format JP2 produit des fichiers plus petits d’environ 5 à 25 %. À titre
d’exemple, voici les résultats pour l’image photographique de la section 6.8.3 :
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Format Taille du fichier (octets)

BMP non compressé 87 222

PNG sans perte (niveau 9) 56 297

JP2 sans perte (niveau 1) 51 731

Il convient de noter que le format de fichier PNG produit toujours des fichiers plus petits que JP2 lors de la
compression d’images avec moins de couleurs, comme le pixel art, de sorte que les avantages sont strictement
limités aux images photographiques.

A.3 Captures d’écran

mtPaint  peut  être  utilisé  pour  faire  une  capture  d’écran  soit  avec  « Fichier→Nouveau »,  soit  en  utilisant
« mtpaint –s » depuis la ligne de commande. Si vous êtes un utilisateur d’IceWM, vous pouvez assigner la
touche « Print Screen » pour faire une capture d’écran en éditant le fichier ~/.icewm/keys pour y inclure :

key "Print" mtpaint –s

A.4 Préférences

Les préférences que vous choisissez dans la fenêtre des préférences sont stockées dans le fichier .mtpaint.

Sur  les  systèmes GNU/Linux,  il  est  placé dans  le  répertoire  personnel  de l’utilisateur,  et  sur  les  systèmes
Windows, dans le répertoire de profil de l’utilisateur. Sous Windows 9x, le répertoire racine du lecteur actuel est
utilisé à la place (généralement, C:\).

A.4.1 Tablettes tactiles

Il est possible d’utiliser la fenêtre des Préférences pour permettre l’utilisation de tablettes tactiles dans mtPaint.
Tout  d’abord,  ces  périphériques  doivent  être  configurés  et  testés  à  l’aide  des  pilotes  de  votre  système
d’exploitation. Ensuite, vous pouvez configurer la section Tablette de la fenêtre des Préférences afin d’affecter
la taille, le flux et l’opacité des outils. Vous devez activer un seul des périphériques répertoriés, généralement
celui appelé stylet. Pour tester si cela fonctionne, utilisez la tablette pour appliquer une pression sur la zone de
test et vous verrez combien de pressions ont été enregistrées.

A.4.2 Traductions localisées

mtPaint  peut  être compilé  pour utiliser des traductions localisées afin  d’aider les  personnes ne parlant pas
anglais.  Si  votre  copie  de  mtPaint  possède  cette  fonctionnalité,  il  y  aura  une  section  de  la  fenêtre  des
préférences appelée Langue que vous pourrez utiliser pour choisir une autre langue.

Chacune de ces traductions a été réalisée volontairement par plusieurs utilisateurs de mtPaint qui souhaitent
rendre  ses  fonctionnalités  plus  accessibles.  Certaines  de  ces  traductions  ne  sont  pas  complètes.  Si  vous
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souhaitez compléter l’une de ces traductions, ou en créer de nouvelles, il vous est conseillé de visiter le site web
de mtPaint afin de pouvoir contacter le mainteneur pour obtenir des instructions à ce sujet.

A.5 Limitations

La géométrie maximale de l’image est de 16384x16384. La géométrie minimale est de 1x1.

Après le chargement d’une nouvelle palette, le canevas peut contenir des références à des couleurs qui ne sont
pas définies. Je les appelle des pixels orphelins. Si vous examinez les informations de l’image via le menu
Image, vous verrez combien de pixels ont été rendus orphelins. Vous pouvez récupérer ces pixels en étendant la
palette à 256 éléments, puis en cliquant sur « Palette→Supprimer les couleurs non utilisées ».

Lorsque vous utilisez l’éditeur de couleur A/B avec une image indexée, si la couleur A = couleur B, vous devez
éditer la couleur B pour modifier son RVB.

Certaines combinaisons  de touches peuvent  ne pas  fonctionner sous certains  gestionnaires  de fenêtres,  par
exemple Shift+F1-F12 ou Ctrl+bouton de la souris.

L’utilisation  des  éléments  de  la  barre  d’état  « Curseur  X,  Y »  et  « Pixel  [I]  {RGB} »  peut  entraîner  une
utilisation élevée du processeur sur les anciens matériels lorsqu’on déplace vigoureusement le curseur.

Le nombre maximal de couches est de 100.

La rotation du texte GTK+ ne fonctionne pas sous Windows ME/95.

Les fichiers avec des noms de chemin trop longs ne peuvent pas être affichés ou ouverts dans Windows (s’ils
dépassent 259 octets dans le codage ANSI du système).

A.6 Personnalisation de mtPaint

L’un  des  avantages  des  logiciels  libres  est  que  vous  avez  accès  au  code  source,  ce  qui  vous  permet  de
personnaliser le programme en fonction de vos besoins.

A.6.1 Créer des motifs

Chaque  motif  est  simplement  une  grille  8x8  que  vous  pouvez  modifier  dans  le  fichier  de  code  source
./src/icons1/xbm_patterns.xbm. Pour utiliser ces nouveaux motifs, vous devez enregistrer le nouveau fichier
dans un endroit sûr, puis faire référence à ce fichier dans la section Chemins de la fenêtre Préferences.
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A.6.2 Création de brosses

Si vous avez une préférence particulière pour certains types de brosses, comme les cercles ou les sprays, vous
pouvez  modifier  manuellement  les  sources  pour  répondre  à  vos  besoins.  Editez  memory.c  et  trouvez
mem_brush_list qui définit toutes les brosses. Chaque entrée est définie par un type d’outil, une taille d’outil et
un débit.

A.6.3 Icônes personnalisées

Le répertoire./src/icons1 contient des icônes et des pointeurs de souris qui sont compilés dans mtPaint. Il est
possible de créer des jeux d’icônes personnalisés pour répondre à des goûts personnels. Par exemple, pour créer
et construire un nouveau jeu, essayez :

cd src
cp –r icons1 icons-new

Modifiez les icônes et les pointeurs dans icons-new comme vous le souhaitez

./configure icons-new
make

De plus, le jeu d’icônes peut être partiellement ou totalement remplacé au moment de l’exécution grâce au
mécanisme de thématisation de GTK+. Pour chaque icône « xpm_whatever.xpm » dans le jeu d’icônes, il y a un
stock ID correspondant « mtpaint_whatever », et mtPaint affichera n’importe quelle autre icône que vous avez
assignée à ce stock ID dans un fichier de ressources, si vous faites référence à ce fichier comme « Default
Theme » dans la section Chemins de la fenêtre Préférences.

Exemple de fichier de ressources :

gtk-icon-sizes="gtk-small-toolbar=22,22"
style "mtPaint" {
stock["mtpaint_brcosa"] = {{ "color-brightness-contrast.png", *, *, * }}
# D’autres définitions d’icônes vont ici
}
widget_class "*" style "mtPaint"

Une documentation complète sur la syntaxe des fichiers de ressources GTK+ se trouve ICI, sous la rubrique
Styles.

A.6.4 Paramètres par défaut

mtPaint permet de remplacer les paramètres de configuration par défaut, en utilisant un fichier de préférences
global. Sur les systèmes GNU/Linux, le fichier /etc/mtpaint/mtpaintrc est utilisé ; sur les systèmes Windows, le
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fichier mtpaintrc doit être situé dans le sous-répertoire etc\mtpaint sous le répertoire d’installation de mtPaint
(c’est-à-dire,..\c\mtpaint\mtpaintrc par rapport à l’endroit où se trouve le fichier mtpaint.exe).

Les empaqueteurs et les constructeurs de distributions peuvent utiliser ceci pour préconfigurer mtPaint d’une
manière  spécifique  à  la  distribution ;  démarrez mtPaint,  modifiez  les  préférences  que vous voulez,  quittez
mtPaint, et copiez le fichier ~/.mtpaint résultant dans /etc/mtpaint/mtpaintrc.

Le domaine où une telle préconfiguration est la plus nécessaire est celui des actions sur les fichiers – différentes
distributions  fournissent  une  sélection  différente  de  logiciels  préinstallés,  et  certains  des  programmes  que
mtPaint exécuterait par défaut peuvent être indisponibles sur une distribution spécifique. Dans de tels cas, il est
préférable  de  substituer  un  autre  programme  similaire,  ou  de  désactiver  entièrement  l’action,  plutôt  que
d’embrouiller les utilisateurs avec des actions qui ne fonctionnent pas.

L’empaqueteur d’une version entièrement portable peut utiliser mtpaintrc pour déplacer le fichier de préférences
de l’utilisateur (~/.mtpaint) de son emplacement par défaut dans le répertoire personnel de l’utilisateur actuel à,
disons, quelque part sous le répertoire d’installation. Pour ce faire, ajoutez la ligne « userINI = /path/filename »
à mtpaintrc.

Les  chemins  commençant  par  « ~ »,  comme  « ~/.mtpaint »,  pointent  vers  le  répertoire  personnel.  Sous
Windows, les chemins commençant par une lettre de lecteur sont absolus, et ceux commençant par un \ ou / sont
considérés comme étant relatifs au paquetage, tout comme « /etc/mtpaint/mtpaintrc » lui-même. Aucun chemin
(juste « userINI = ») signifie que les préférences de l’utilisateur seront sauvegardées dans le fichier mtpaintrc
comme nouvelle configuration par défaut.

A.7 Actions sur les fichiers

La  section  Actions  du  menu  Fichier  peut  être  utilisée  pour  envoyer  le  fichier  image  actuel  à  un  autre
programme, tel qu’un navigateur web ou un client de messagerie. L’implémentation varie entre les systèmes
GNU/Linux et Windows en raison des différentes structures de système sous-jacentes. Dans les deux cas, vous
pouvez configurer jusqu’à 25 éléments, chacun ayant une description textuelle (Action), une commande et un
répertoire dans lequel la commande sera exécutée. Les 15 premiers éléments seront placés dans le menu en tant
que présélections. Si vous ne voulez pas qu’un élément apparaisse comme un préréglage, vous pouvez placer un
caractère # au début de l’action. Vous pouvez réorganiser les éléments de la liste en les faisant glisser et en les
déposant dans la liste.

Lors de l’édition de la commande, le fichier image actuel est représenté par l’utilisation de '%f' qui est substitué
lorsque la commande est exécutée.

En  outre,  si  un  autre  programme exige  ou  préfère  un  format  de  fichier  image et/ou  un  format  de  pixels
spécifique, vous pouvez commencer la commande par des instructions de conversion : Le caractère > suivi du
nom de ce que vous voulez et d’un espace. Pour un format de fichier, utilisez soit son extension, soit le nom
utilisé pour le format dans mtPaint, par exemple  ">jpg  " ou  ">jpeg  " pour JPEG ; soit  ">jp2  ",  ">jpc  ", ou
">jpeg2000  " pour JPEG2000. Pour effectuer une conversion indexée vers RVB, ajoutez  ">rgb  " ; sinon, la
conversion sera effectuée si  le format du fichier est  uniquement RVB. Les requêtes demandant des choses
impossibles, comme l’enregistrement d’une image RVB en tant que fichier XBM, seront ignorées.
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A.7.1 Systèmes GNU/Linux

La version GNU/Linux de mtPaint est livrée préchargée avec quelques exemples d’actions sur les fichiers. La
commande est exécutée en utilisant la commande shell sh, donc dans le cas de bash vous pouvez utiliser plus
d’une commande en les séparant par un point-virgule. Par exemple, cette commande attend 5 secondes et fait
une capture d’écran :

sleep 5 ; mtpaint –s &

Comme les commandes sont exécutées par l’intermédiaire de l’interpréteur de commandes, vous pouvez utiliser
toutes  les  fonctions  de  l’interpréteur  de  commandes  comme  les  pipes,  les  redirections  et  les  caractères
génériques.

A.7.2. Systèmes Windows

Pour lancer un programme en utilisant la version Windows de mtPaint, vous devez placer le chemin complet du
programme dans la boîte de commande. Par exemple, la commande suivante lance MS Paint en éditant l’image
courante (sous Windows XP ou Window 98 respectivement) :

C:\WINDOWS\system32\mspaint.exe %f

C:\Program Files\Accessories\MSPAINT. EXE %f

A.8 Chargement et enregistrement d’images

Ces fonctions peuvent sembler évidentes, mais elles sont plus nombreuses qu’il n’y paraît.

Tout d’abord, le sélecteur de fichiers prend en charge la complétion de tabulation et les caractères génériques.
Par exemple, si vous tapez p dans la zone de saisie et appuyez sur la touche de tabulation, seuls les fichiers
commençant par p seront affichés. Si vous tapez « dsc*.jpg » dans le champ de saisie et appuyez sur la touche
de tabulation, la liste des fichiers n’affichera que les fichiers commençant par dsc et se terminant par « .jpg ».
Comme vous pouvez vous y attendre, le caractère générique * représente un nombre quelconque de caractères
et le caractère générique ? représente exactement un caractère.

Ensuite, il y a le chargement indéfini. Si vous l’activez, le chargement d’un nouveau fichier image est traité
comme une modification d’image ordinaire – vous pouvez l’annuler et revenir à l’image avec laquelle vous
travailliez auparavant. De cette façon, si vous voulez ajouter à l’image courante un morceau d’une autre image,
vous n’avez pas besoin d’ouvrir une instance séparée de mtPaint pour cela ; il suffit de charger la seconde image
en mode annulable, de copier la partie nécessaire dans le presse-papiers, d’annuler le chargement, et de coller le
presse-papiers dans la première image.
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La comparaison d’images est une autre utilisation du chargement non modifiable. Vous pouvez charger deux
images (ou plus) l’une après l’autre, puis passer rapidement de l’une à l’autre en utilisant les raccourcis clavier
pour annuler et rétablir (Ctrl+Z et Ctrl+R).

En ce qui concerne l’enregistrement, le choix des formats de fichiers image que mtPaint vous propose dépend
de l’image que vous souhaitez enregistrer, de son type (RVB ou indexé) et  du nombre de couleurs qu’elle
contient. S’il n’est pas possible d’enregistrer l’image dans un format donné, celui-ci n’est tout simplement pas
proposé – ce qui ne signifie pas que le format n’est pas disponible, mais que vous devez convertir l’image en un
type et/ou un nombre de couleurs acceptables. Voir la colonne « Type d’image » du tableau de la  section A.2
pour les exigences des formats d’image spécifiques.
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Annexe B – L’historique de ce document

Décembre 2011 – Edition 3.40 (par Dmitry Groshev)
• Mise à jour des sections 3.2.7, 3.3.1, 3.3.2, 3.3.8, 3.5.4, 3.5.6, 3.5.7, 4, 4.1, 5.3, 5.6, 6.5, 6.6.5, 7.1, 7.1.1,

9, 9.1, 9.3.3, A.4.1, A.5, A.6.3, A.6.4, A.7.
• Réécriture des sections 4.1, A.1.
• Ajout des sections 2.4.5, 3.3.9, 3.3.10, 5.7, 6.10, 6.10.1.
• Sections A.1.1, A.1.2 supprimées.

Avril 2009 – Edition 3.31 (par Dmitry Groshev)
• Mises à jour des sections 3.3.1, A.2, A.4.
• Ajout des sections 5.6, 7.5.14, A.6.4, A.8.

Janvier 2009 – Edition 3.30 (par Dmitry Groshev)
• Conversion au format txt2tags.
• Mise à jour des sections 3.1, 3.2, 3.3.1, 3.3.6, 3.3.7, 3.3.8, 3.5, 3.5.6.5, 3.5.7, 4.3, 4.6, 6.8.1, 6.9, 8.2.
• Réécriture des sections 5.5, 8.1.
• Ajout des sections 6.6.5, 6.6.6, 8.2.1.

Décembre 2008 – Edition 3.29
• Mises à jour de la section : 5.3, A.1.1, A.1.2, A.5.
• Image 5.3 mise à jour.
• Sections  3.3.7,  3.3.8,  3.5.6.5,  4.8,  4.9,  5.5,  6.9  ajoutées  (y  compris  les  références  dans  la  page de

contenu).
• Section A8 supprimée (y compris les images et le fichier).

Décembre 2007 – Edition 3.20
• Image 2.4a mise à jour.

Novembre 2007 – Edition 3.19
• Mises à jour de la section : 3.3.2, 3.4, 3.5.1, 6.8.1, 6.8.3, 9.5, A.2, A.5, A.6.1.
• Sections 3.2.7.1, 3.5.7, 7.1.2, A.2.1, A.2.2, A.7, A.8 ajoutées (y compris les références dans la page de

contenu).
• Images 3.4, 3.5, 6.8.3e mises à jour.
• Images 3.5.1, 6.8.3f ajoutées.
• L’image A.6.1 a été supprimée.

Mars 2007 – Edition 3.11
• Chapitre 1 Année de copyright mise à jour pour 2007.
• Mises à jour de la section : A.2.
• Section 6.4.1 ajoutée (y compris la référence dans la page de contenu).

Janvier 2007 – Edition 3.10
• Appendice B modifié.
• Mises à jour des sections : 7.5.8, 6.8.4.2.
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Décembre 2006 – Edition 3.09
• Mises à jour des sections : 2.4, 2.4.4, 3.2.3, 3.3.2, 3.5, 4, 4.3, 4.6, 6.5, 6.6, 7.5.1, 7.5.10, A.1.1, A.1.2,

A.2.
• Images 2.4a, 3.5 mises à jour.
• Image 2.4b supprimée.
• Section 2.5 supprimée.
• Sections 3.5.6, 4.5.1, 6.2.1, 6.6.1, 6.6.2, 6.6.3, 6.6.4, 6.8, 7.5.12, 7.5.13, 8.4.2, 9.6, A.4.1, A.4.2 ajoutées

(y compris les références dans la page de contenu).

Octobre 2006 – Edition 3.02
• La version est passée à 3.02

Juillet 2006 – Edition 3.01
• Traduction tchèque ajoutée par Pavel Ruzicka.
• 8.1.1 Référencé dans chap_00.html.
• & Les références aux symboles ont été nettoyées.

Juin 2006 – Edition 3.00

Mars 2006 – Edition 0.1
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Annexe C – Le fichier « NEWS » de mtPaint
------------

mtPaint NEWS
------------

Voici un résumé des principaux changements dans cette version (voir le manuel pour plus de détails) :

3.40 2011-12-30
* Traduction en tagalog ajoutée par Anjelo delCarmen
* Traduction en hongrois ajoutée par Ur Balazs
* Traduction tchèque mise à jour par Roman Hornik
* Traduction allemande mise à jour par B. Clausius
* Traduction italienne mise à jour par Angelo Gemmi
* Traduction japonaise mise à jour par Norihiro YONEDA
* Traduction suédoise mise à jour par Daniel Eriksson
* Traduction espagnole mise à jour par Adolfo Jayme
* Traduction en portugais brésilien mise à jour par Valter Nazianzeno
* Traduction en chinois (simplifié) mise à jour par Cecc
* Traduction en russe mise à jour
* Élimination du scintillement lors du positionnement d’une ligne, d’un côté de polygone ou d’un dégradé dans
la version Windows.
* Le défilement est plus fluide dans la version Windows.
* La zone du dock contient maintenant la barre d’outils des paramètres et la boîte de dialogue des couches
lorsque leurs fenêtres sont fermées.
* La barre d’outils  principale et la barre d’outils  des outils  se réorganisent maintenant pour s’adapter à la
fenêtre.
* La fenêtre des préférences a maintenant des barres de défilement lorsque l’écran est trop petit pour l’afficher
en entier.
* Le bouton de prévisualisation sur les sélecteurs de couleur est maintenant un bouton à bascule pour activer les
prévisualisations interactives.
* L’outil Ligne affiche désormais des informations sur la géométrie dans la barre d’état.
* L’effet de flou gaussien est désormais plus rapide de 20 à 35 %.
* La mise à l’échelle des images est désormais plus rapide de 10 à 35 %.
* Le bouton « Protéger les détails » a été ajouté au flou Kuwahara-Nagao.
* Les effets de mise à l’échelle de l’image, de flou gaussien, de masque flou et de différence de gaussiennes
utilisent désormais le multithreading pour exploiter tous les cœurs de processeur disponibles.
* Le déplacement du pointeur avec les touches fléchées fait maintenant défiler le canevas lorsqu’il se déplace
au-delà de la fenêtre d’affichage.
* Faire glisser le cadre de sélection dans la fenêtre du canevas, le calque dans la fenêtre d’affichage, ou la
couleur dans la fenêtre de la palette, au-delà de la fenêtre d’affichage fait maintenant défiler la fenêtre.
* View→Snap To Tile Grid restreint les positions des outils aux points de la grille des tuiles – la touche B
permet d’activer/désactiver cette fonction.
* Génération de l’échelle de couleur sRGB ajoutée à l’éditeur de palette.
* Gradients sRGB ajoutés
* L’outil Ligne utilise désormais un dégradé de trait lorsqu’il n’existe pas de placement de dégradé.
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* L’option « Palette→Pick Gradient permet d’obtenir un dégradé A→B en utilisant les couleurs de la palette
actuelle (voir la section 3.3.9 du manuel).
* Nouveau mode de tri de la palette ajouté – Luminosité
* Ajout de Image→Segment : Voir la section 6.10 du manuel pour plus de détails.
* Ajout d’une fenêtre popup de sélection des couleurs – appuyez sur E pour l’ouvrir.
* La fonction Posterize dans la fenêtre Transformer la couleur a maintenant 3 types – Bitwise,  Truncated,
Rounded.
* Ajout d’un bouton pour transformer l’image RVB du presse-papiers dans la fenêtre Transformer la couleur.
* La fenêtre Convertir en index se souvient maintenant des paramètres précédents de la session mtPaint.
* Les outils de collage de texte supportent maintenant les textes multilignes (utilisez Ctrl+Enter pour insérer des
sauts de ligne).
* Le répertoire ~/.fonts a été ajouté aux chemins de polices par défaut pour l’outil de texte FreeType sous
Linux.
* Les fichiers GIF animés et les fichiers TIFF multipages peuvent maintenant être chargés en couches (une
image/page par couche).
* L’explosion des fichiers d’animation GIF se fait maintenant en interne dans mtPaint, et non dans Gifsicle.
* L’action « exploser les images » peut maintenant enregistrer les images dans n’importe quel format de fichier
supporté.
* Les actions sur les fichiers peuvent maintenant spécifier la conversion du format de fichier : voir la section
A.7 du manuel pour plus de détails.
* Enregistrement/chargement des formats de fichier Netpbm (PBM/PGM/PPM/PAM) ajouté
* Ajout de l’enregistrement/chargement du format de fichier PCX
* Ajout de l’importation du format de fichier SVG (en utilisant librsvg ; nécessite GTK+ 2.4 ou plus)
* Meilleure prise en charge du chargement des fichiers TIFF CMYK en tant que RGB/RGBA.
* Les profils de couleur ICC intégrés aux images PNG, JPEG et TIFF peuvent désormais être appliqués au
chargement (à l’aide de LittleCMS).
* Le support du format de fichier JPEG2000 peut maintenant être compilé avec la bibliothèque JasPer ou
OpenJPEG.
* Le chargeur GIF est plus tolérant envers les fichiers GIF tronqués ou malformés.
* Les chargeurs PNG et TGA convertissent maintenant l’alpha basé sur la palette en un canal alpha.
* Palette→Ouvrir peut maintenant extraire la palette des images indexées dans n’importe quel format de fichier
supporté.
* Scale Canvas a maintenant 3 modes d’extension des limites – Mirror, Tile, Void.
* Le nom de fichier et le statut modifié font maintenant partie du système d’annulation.
* La couleur transparente fait maintenant partie du système d’annulation.
* Le tri de la palette, le déplacement d’une couleur ou la suppression des couleurs en double ne perdent plus la
couleur transparente.
* Nouveaux raccourcis clavier ajoutés – J pour l’outil lasso, D pour l’outil ligne, F pour l’outil de remplissage.
* Les icônes de la barre d’outils et du menu sont maintenant thématisables (Préférences→Paths→Thème par
défaut).
* Possibilité d’utiliser l’option – w en ligne de commande, par exemple mtpaint – w "*.jpg".
*  Le  chargement  des  paramètres  par  défaut  depuis  /etc/mtpaint/mtpaintrc  est  maintenant  supporté  dans  la
version Windows.
* Le nom et l’emplacement du fichier des paramètres de l’utilisateur sont maintenant configurables : Voir la
section A.6.4 du manuel pour plus de détails.
* La « grille intelligente » et la correction gamma sont maintenant activées par défaut.
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* La « propagation sélective des erreurs » pour le dithering est maintenant à 85 % par défaut.
* Les outils de dessin et de remplissage sont maintenant 2 à 3 fois plus rapides.
* Support de la compilation avec libpng 1.4, libjpeg 8a, et zlib 1.2.5 ajouté.
* Le script de configuration a été réécrit, il  comprend maintenant les variables et options standard pour les
chemins d’installation et les paramètres de compilation (croisée).
* La version minimale requise de GTK+2 peut maintenant être spécifiée comme option de configuration (par
exemple, « ./configure gtk2.8 »).
* Correction d’un bogue dans les versions 2.14.0 – 2.14.2, 2.16.0, 2.16.1 de GTK+ (les boutons de rotation
avaient des valeurs maximales incorrectes).
* Ajout d’une solution pour un problème inconnu dans la version 2.24.4 de GTK+ (le programme se bloquait en
essayant d’enregistrer un fichier lorsque la liste des calques était active).
*  BUGFIX – Les  problèmes d’édition  de grandes  images  à  des  niveaux de zoom élevés  sont  maintenant
éliminés.
* BUGFIX – La barre de titre affiche maintenant le nom de fichier de la nouvelle image après le chargement du
fichier des calques, comme il se doit.
* BUGFIX – La liste des calques affiche désormais correctement le calque sélectionné après le chargement du
fichier de calques.
* BUGFIX – La fenêtre des calques affiche désormais correctement la couleur transparente après avoir été
modifiée ailleurs.
* BUGFIX – Les autres calques affichés sur le canevas sont maintenant redessinés correctement lorsque le
calque courant est déplacé.
* BUGFIX – Le chargement de fichiers TIFF avec un miroir X ou Y ne provoque pas de crash.
* BUGFIX – Les fichiers TIFF planaires avec alpha se chargent désormais correctement.
* BUGFIX – La transparence dans les fichiers TGA indexés est maintenant lue correctement.
* BUGFIX – Les opérations échouées ne marquent pas l’image comme modifiée.
* BUGFIX – Les couleurs des dégradés sont maintenant correctement mises à jour après la conversion d’une
image indexée en RVB.
* BUGFIX – L’opération de découpe en mode dégradé lorsqu’il n’existe pas de placement dessine désormais le
dégradé de forme comme il se doit.
* BUGFIX – Le dessin de pointes de flèches avec la tablette activée fonctionne désormais correctement.
* BUGFIX – Le dessin de pointes de flèches ne produit plus de cadres d’annulation corrompus.
* BUGFIX – Le sélecteur de fichiers intégré gère désormais correctement les modifications manuelles dans la
boîte de répertoire.
* BUGFIX – Le problème de la boîte de dialogue de texte FreeType qui se cachait parfois derrière la fenêtre
principale a été éliminé.
* BUGFIX – Les listes de la boîte de dialogue Texte FreeType ne manquent plus de se mettre à jour ou de
défiler.
* BUGFIX – Le moteur de rendu de texte FreeType peut désormais gérer les polices bitmap PCF.
* BUGFIX – Le moteur de rendu de texte FreeType gère désormais correctement les polices TTF avec des
bitmaps intégrés.
* BUGFIX – Le moteur de rendu de texte FreeType ne confond plus certaines polices Unicode avec des polices
non-Unicode.
* BUGFIX – Les chemins de polices : unscaled dans xorg.conf sont maintenant analysés correctement.
* BUGFIX – Le délai de redécoupage lors du déplacement d’une boîte de dialogue au-dessus de la fenêtre
principale sous Windows est maintenant considérablement réduit (corrigé dans GTK+).
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* BUGFIX – La touche Ctrl+T dessine maintenant le contour de la sélection comme il se doit – le raccourci
clavier pour l’outil texte est maintenant Shift+T.
* BUGFIX – Le manuel installé dans un chemin contenant des espaces ne s’ouvre plus dans un navigateur autre
que celui par défaut sous Windows.
* BUGFIX – L’internationalisation n’échoue plus  sous  Windows lorsque le  répertoire  courant  n’est  pas  le
répertoire d’installation.
* BUGFIX – Les problèmes de redécoupage dans le sélecteur de fichiers intégré sous Windows sont désormais
éliminés.
*  BUGFIX  –  Le  glisser-déposer  de  fichiers  dont  le  nom  contient  des  caractères  non  ASCII  fonctionne
désormais sous Windows.
* Le mode de tri de la palette « Distance to A+B » a été supprimé en raison de son inutilité totale.

3.31 2009-4-15
* Traduction japonaise mise à jour par Norihiro YONEDA.
* Traduction suédoise mise à jour par Daniel Nylander et Fredrik Forsmo.
* Traduction française mise à jour par Plume
* Le sélecteur de fichiers intégré utilise les icônes de fichiers et de répertoires de GTK+2.
* Les paramètres par défaut sont chargés depuis le fichier /etc/mtpaint/mtpaintrc s’il existe.
* BUGFIX – La compilation avec le sélecteur de couleurs de GTK+ fonctionne maintenant.
* BUGFIX – La touche Escape fonctionne maintenant correctement dans le sélecteur de fichiers intégré dans
GTK+1
* BUGFIX – La longueur des noms de fichiers dans le sélecteur de fichiers intégré n’est plus limitée à 100
caractères.
* BUGFIX – Le redimensionnement de la fenêtre du canevas n’entraîne plus le déplacement de la marque de
polygone.
* BUGFIX – La marque de polygone rétrécie par le redimensionnement du canevas est maintenant redessinée
correctement.
* BUGFIX – Le problème des fenêtres de message qui ne répondaient pas à la souris dans certains cas a été
éliminé.

3.30 2009-2-12
* Traduction en chinois (simplifié) mise à jour par Cecc
* Traduction néerlandaise ajoutée par Hans Strijards
* Traduction italienne ajoutée par Angelo Gemmi
* Traduction suédoise ajoutée par Daniel Nylander
* Traduction espagnole mise à jour par Miguel Anxo Bouzada, Francisco Jose Rey.
* Traduction en galicien mise à jour par Miguel Anxo Bouzada.
* Traduction tchèque mise à jour par Martin Petricek
* Traduction française mise à jour par Johan Serre
* Mise à jour de la traduction portugaise par Tiago Silva
* Traduction turque mise à jour par Tutku Dalmaz
* Traduction russe mise à jour
* Nouveau sélecteur de couleurs (l’ancien était disponible comme option de configuration)
* Nouveau sélecteur de fichiers (l’ancien était disponible comme option de configuration)
* Certains éléments du menu peuvent avoir une icône (si défini dans les préférences).
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* Ajout d’une zone de dock qui contient maintenant l’ancienne fenêtre de ligne de commande (View→Show
Dock)
* La gestion de la fenêtre des couches a été retravaillée pour la rendre plus réactive.
* Fenêtre des couches : la position est maintenant modifiable via les boutons rotatifs.
* Fenêtre des couches : suppression du bouton de couleur transparente
* La touche L permet maintenant de désactiver la fenêtre des calques (si la fenêtre principale a le focus).
* L’opération « Composite to New Layer » a été ajoutée au menu Layers.
* La palette peut être copiée depuis ou vers le canevas à l’aide du menu Édition.
* Le presse-papiers du système peut être importé ou exporté à l’aide du menu Édition.
* Des rampes horizontales et verticales peuvent être créées à l’aide du menu Sélection.
* Le gradient Shapeburst est maintenant utilisé pour remplir les gradients lorsqu’il n’y a pas de placement (voir
la section 3.5.6.5 du manuel).
* Ajout de dégradés angulaires et coniques
* La création d’une nouvelle image peut maintenant être annulée.
* Une nouvelle image ou un nouveau calque peut maintenant être créé à partir du presse-papiers du système ou
du presse-papiers interne.
* Les captures d’écran peuvent maintenant être saisies dans un nouveau calque.
* L’outil Lasso coupe maintenant le presse-papiers existant si aucune sélection n’est présente.
* Image→Skew incline l’image dans une ou deux directions
* View→Configure Grid définit les préférences de couleur de la grille
* L’option « Smart Grid » montre les limites du calque autour des pixels transparents.
* Ajout de « View→Tracing Image » : Voir la section 5.5 du manuel pour plus de détails.
* L’effet  de flou gaussien pour les images avec alpha est maintenant 40 % plus rapide et utilise moins de
mémoire.
* Ajout de l’effet de flou Kuwahara-Nagao (flou préservant les bords)
* Ajout des effets de dilatation et d’érosion
* Sept nouveaux filtres de détection des contours ont été ajoutés : Sobel, Prewitt, Kirsch, Gradient, Roberts,
Laplace et Morphologique.
* L’effet d’inversion respecte désormais le masquage
* Les opérations de dessin sur les canaux utilitaires respectent désormais l’opacité de l’outil.
* Le dessin dans un canal d’image avec alpha couplé ignore maintenant les modes de dessin pour le canal alpha.
* L’outil d’estompage fonctionne maintenant environ deux fois plus vite
* 12 nouveaux modes de fusion ajoutés – Multiplier, Diviser, Écran, Dodge, Brûler, Lumière dure, Lumière
douce, Différence, Assombrir, Éclaircir, Extraire le grain, Fusionner le grain.
* Ctrl+Double clic sélectionne la couleur moyenne sous le carré de la brosse ou la marque de sélection.
* L’option « Convertir en index » en utilisant la palette actuelle ne tronque désormais la palette que si cela est
demandé.
* Les quantificateurs PNN et Wu « Convert to indexed » ont maintenant une option de pondération basée sur le
diamètre.
* La zone d’aperçu du pinceau, le canevas, la vue et la fenêtre de la palette ne perdent plus les événements de
relâchement du bouton de la souris dans GTK+1.
* La bordure de la zone de prévisualisation du pinceau ne peut plus être altérée par les moteurs de thèmes.
* Les Makefiles respectent maintenant DESTDIR
* Le script de configuration respecte maintenant CC
* Shift+Enter pendant le collage échange le presse-papiers avec le canevas (voir manuel section 4.9)
* L’espace mémoire commun est maintenant implémenté pour les couches (voir manuel, section 8.2.1).
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* Support de l’utilisation d’ImageMagick pour l’animation GIF, au lieu de Gifsicle – « ./configure imagick ».
* BUGFIX – La sélection des lignes de polygone est maintenant plus claire dans la version Windows.
*  BUGFIX –  Suppression  des  problèmes  occasionnels  de  redécoupage  dans  les  aperçus  de  collage  et  de
dégradés.
* BUGFIX – « Supprimer tous les calques » avec la fenêtre des calques fermée ne provoque pas de crash.
* BUGFIX – Le collage en mode teinte dans les canaux utilitaires des images indexées fonctionne désormais
correctement.
* BUGFIX – L’aperçu des dégradés montre désormais correctement l’effet du canal de masque sur le canal
alpha.
* BUGFIX – La touche Alt+S ouvre désormais le menu Sélection comme il se doit.
* BUGFIX – Le répertoire des cadres d’animation est créé par rapport au fichier des calques, comme il se doit.
* BUGFIX – L’enregistrement des cadres d’animation au format PNG ne provoque pas de crash.
* BUGFIX – Lorsque vous collez un nouveau calque, il est créé sans titre, comme il se doit.
* BUGFIX – Les fichiers JPEG CMYK sont maintenant chargés correctement en RGB.
* BUGFIX – Le dessin avec un gradient de A à B dans les canaux utilitaires respecte désormais le bouton
gauche/droite.
*  BUGFIX  –  L’enregistrement  d’images  PNG  avec  plus  d’un  canal  utilitaire  fonctionne  maintenant
correctement.

3.21 2008-6-8
* Traduction russe ajoutée par Sergey Irupin.
* Mise à jour de la traduction espagnole par Antonio Sanchez Leon
* Traduction en galicien ajoutée par Miguel Anxo Bouzada.
* Utilisation de 'xdg-open' si disponible pour ouvrir l’aide HTML dans le navigateur par défaut sous Linux.
* Contrôle d’intégrité assoupli dans le chargeur XPM pour accepter les fichiers avec des en-têtes malformés.
* L’option « Conversion exacte » a été ajoutée à Palette→Créer Quantifié.
* Le comptage des couleurs utilisées est maintenant deux fois plus rapide.
* Contournement d’un bogue dans les versions 1.2.17 – 1.2.24 de libpng (perte de canaux supplémentaires lors
du chargement).
* BUGFIX – Les bordures du canevas, de la vue et de la palette ne peuvent plus être modifiées par les moteurs
de thèmes.
* BUGFIX – La sélection persistante d’un rectangle ne vole plus les touches fléchées de l’outil de placement
des dégradés.
* BUGFIX – L’internationalisation fonctionne maintenant correctement dans GTK+1.
* BUGFIX – La qualité du rendu du texte FreeType a été améliorée sous Windows.
* BUGFIX – Le texte des éléments de menu actifs ne devient plus invisible sous Windows Vista (corrigé dans
GTK+).
*  BUGFIX – Les  disques  amovibles  sont  maintenant  visibles  dans  le  sélecteur  de fichiers  sous  Windows
(corrigé dans GTK+)

3.20 2007-12-27
* mtPaint est maintenant sous licence GPL version 3 (ou ultérieure)
* Ajout du chinois (simplifié) par puppychinese(Cecc)
* Traduction japonaise ajoutée par Norihiro YONEDA.
* Traduction polonaise mise à jour par Groszek150(LucaS)
* Ajout d’une fonction de collage de texte FreeType
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* Section Actions ajoutée au menu Fichier
* Bouton de réduction de l’image plus nette ajouté à « Scale Canvas ».
* L’espacement des outils non-continus est maintenant configurable – cliquez avec le bouton droit de la souris
sur le mode continu.
* Ajout du mode de dessin Blend.
* L’opération « Unassociate Alpha » a été ajoutée au menu Channels.
* La palette est maintenant stockée dans des fichiers PNG RVB.
* Le niveau de compression PNG est maintenant configurable
* Enregistrement/chargement du format de fichier TGA ajouté
* Enregistrement/chargement du format de fichier JPEG2000 ajouté (EXPERIMENTAL)
* Les fichiers XPM avec jusqu’à 4096 couleurs peuvent maintenant être sauvegardés et chargés comme des
images RGB.
* Palette→Dither A définit la couleur A/B et le motif en fonction de la couleur A actuelle et de la palette.
* Ajout d’un quantificateur Max-min – crée de petites palettes avec une saturation et un contraste plus élevés.
* Un quantificateur PNN plus rapide et plus performant remplace l’ancien quantificateur DL3.
* Ajout d’une option de précision d’erreur complète à la page des paramètres de la fenêtre « Convertir en
index ».
* Élimination du scintillement lors du défilement du canevas dans GTK+1 et GTK+2/Windows.
* Le déplacement du séparateur de la fenêtre principale/de la fenêtre d’affichage se comporte désormais comme
dans GTK+1.
* Le menu principal se réorganise maintenant pour s’adapter à la fenêtre.
* Système d’annulation basé sur les tuiles introduit pour économiser de la mémoire lorsque les changements
n’affectent que de petites zones du canevas.
* Le nombre maximum de niveaux d’annulation est maintenant configurable (de 10 à 1000).
* Le chargement des images peut maintenant être annulé.
* mtPaint peut maintenant être compilé comme une bibliothèque (libmtpaint).
* Rotation de l’image plus rapide et plus nette
* Ajout d’un effet de différence de Gauss
* Les motifs sont passés à 100 et sont maintenant stockés dans le fichier xbm_patterns.xbm.
*  Édition→Créer  des  motifs  supprimés  car  les  motifs  sont  maintenant  enregistrés  dans  un  fichier  XBM
standard.
* Préférences→Paths : Palette et motifs par défaut maintenant sélectionnables.
* BUGFIX – Le mode sélectif de couleur avec un zoom < 100 % ne provoque pas de crash
* BUGFIX – L’aperçu du dégradé montre maintenant correctement l’effet du canal de masque.
* BUGFIX – L’option « Resize Canvas » avec un décalage négatif fonctionne désormais correctement.
* BUGFIX – La rotation du presse-papiers gère désormais correctement l’alpha du presse-papiers.
* BUGFIX – La transparence des fichiers PNG en niveaux de gris est désormais lue correctement.
* Le filtre de remise à l’échelle Lanczos3 a été supprimé en raison de résultats défavorables.
* Le quantificateur DL1 a été supprimé pour la même raison.

3.11 2007-4-2
* Traduction slovaque ajoutée par Jozef Riha
* Traduction française mise à jour par Sylvain Cresto
* Chargement/enregistrement du format de fichier LSS16 ajouté pour supporter les écrans de démarrage de
syslinux.
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* L’alpha du presse-papiers est maintenant utilisé comme masque du presse-papiers lors du collage dans une
image sans canal alpha.
* L’option « Resize Canvas » peut maintenant être utilisée pour décaler une image, avec ou sans modification
de sa taille.
* Les fichiers TIFF avec canal alpha enregistrés par Photoshop se chargent désormais correctement.
* Les idiomes spécifiques à Bash dans le script de configuration sont remplacés par des équivalents POSIXy.
* Les boîtes combo de zoom se comportent mieux dans GTK+1.
* Le quantificateur DL3 est maintenant plus rapide d’environ 30 %.
* BUGFIX – Les  valeurs  négatives  dans  les  dialogues  « Transformer la  couleur » et  « Redimensionner  le
canevas » sont à nouveau lues correctement.
* BUGFIX – Dessiner une ellipse remplie de 2 pixels de haut ne provoque pas de crash
* BUGFIX – Le curseur de l’outil ne revient pas à son état par défaut après avoir affiché ou masqué la fenêtre
d’affichage.
* BUGFIX – Le raccourci clavier pour échanger les couleurs A et B fonctionne maintenant dans GTK+1.
* BUGFIX – Cliquer sur la grille de la palette dans l’éditeur de gradient fonctionne maintenant correctement en
GTK+1.
* BUGFIX – Tous les boutons de rotation sont maintenant assez larges dans GTK+1.
*  BUGFIX –  Plus  de  problèmes  de  redécoupage  lors  de  l’activation  et  de  la  désactivation  de  la  fenêtre
d’affichage dans GTK+1.

3.10 2007-1-22
* Ajout d’un mode de dessin en dégradé
* Fonction de déplacement de la palette ajoutée au menu Palette
* Traduction turque ajoutée par Muhammet Kara, Tutku Dalmaz.
* Traduction en chinois taïwanais ajoutée par Wei-Lun Chao.
* Ajout d’un mode de tuilage d’image à « Redimensionner le canevas ».
* L’effet de niveaux de gris respecte désormais le masquage
* Ajout d’un effet de niveaux de gris corrigé en gamma
* L’effet de flou gaussien remplace l’ancien effet de flou.
* Ajout d’un effet de masque flou
* Plus de modes de tri de la palette ajoutés
* Contrôles pour alpha/sélection/masque A/B ajoutés à « Edit colour A & B ».
* Génération d’échelles de couleurs RVB et HSV intégrée à l’éditeur de palette
* Nouveaux modes de tramage avancés  avec de nombreuses  options  de configuration  ajoutés  à la  fenêtre
« Convert To Indexed ».
* Correction gamma optionnelle pour la mise à l’échelle, la rotation, le flou gaussien et le masque flou de
l’image.
* L’outil d’estompage peut être configuré pour ignorer le mode d’opacité – clic droit sur l’icône de l’outil.
* L’outil d’estompage respecte l’opacité de l’outil pour les images RVB.
* La suppression des canaux est plus facile à utiliser
*  La  fenêtre  de  visualisation  peut  maintenant  être  placée  sous  la  fenêtre  de  dessin  en  utilisant  le  menu
Visualisation ou la touche H.
* L’option « Blend A to B » avec une couleur A identique à B fonctionne maintenant comme le filtre Color To
Alpha de GIMP.
* Les flèches et Shift+flèches permettent maintenant de déplacer le curseur sur la toile.
* Enter simule maintenant le clic gauche de la souris, et Backspace, le clic droit.
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* Les touches '[' ']' et '{' '}' sont maintenant utilisées pour changer de couleur A/B.
* Ctrl+molette de défilement fait maintenant défiler le canevas de gauche à droite (GTK+2 seulement).
* Les touches Shift-+/- permettent d’agrandir ou de réduire la fenêtre d’affichage.
* Les touches Shift-1… Shift-4 permettent de basculer vers le canal image/alpha/sélection/masque.
* Le marquage de sélection persiste maintenant à travers les changements d’outils.
* L’outil Lasso fonctionne maintenant aussi pour les sélections rectangulaires.
* Le presse-papiers indexé peut maintenant être collé dans une image RVB.
* Enregistrement/chargement d’images entièrement réécrit, avec un meilleur support des formats TIFF, BMP,
XPM et XBM.
* Les canaux, les images composites et  les images d’annulation peuvent maintenant être sauvegardés dans
n’importe quel format de fichier approprié.
* Le canal d’image peut maintenant être enregistré et chargé comme les autres canaux.
* L’outil de peinture en mode teinte respecte désormais le bouton +/- de la teinte et le bouton gauche/droit de la
souris.
* L’option de remplissage par inondation « par canal d’image » fonctionne désormais aussi en mode non flou.
* BUGFIX – Les sélections polygonales respectent désormais le canal de sélection
* BUGFIX – Les éléments du menu Effets restent désormais activés pour les canaux utilitaires des images
indexées.
* BUGFIX – L’option 'Focus View Window' ne provoque plus d’accrochage lors des déplacements de calques.
* BUGFIX – Smudge ne rend pas les pixels plus sombres qu’ils ne le devraient.

3.02 2006-10-14
* Traduction polonaise ajoutée par Simek
* Traduction espagnole mise à jour pour la version 3 par Antonio San
* Mise à jour de tous les éléments de menu dans toutes les traductions
* Enregistrement de fichiers GIF compressés maintenant supporté (en utilisant libgif)
* Amélioration de la détection des bibliothèques dans le script de configuration
*  BUGFIX  –  La  mise  à  l’échelle  et  la  rotation  de  l’image  en  mode  « nearest-neighbour »  fonctionnent
maintenant correctement.
* BUGFIX – L’outil Lasso gère maintenant correctement l’alpha du presse-papiers.
* BUGFIX – Le chemin d’enregistrement du presse-papiers peut désormais être modifié dans les préférences.
* BUGFIX – Les fichiers XPM plus petits que 4*4 pixels peuvent maintenant être chargés.

3.01 2006-7-15
* Traduction allemande mise à jour pour la version 3
* BUGFIX – Problèmes d’alignement de la mémoire sous Windows corrigés (pouvant affecter la vitesse)
* BUGFIX – Les éléments de menu spécifiques à RGB sont maintenant désactivés en mode indexé.

3.00 2006-6-21
* Ajout de fonctionnalités pour les canaux
* Les menus et les barres d’outils ont été retravaillés pour être plus orientés vers les tâches.
* Les barres d’outils peuvent maintenant être activées et désactivées via le menu Affichage.
* Le glisser-déposer à partir de gestionnaires de fichiers est pris en charge pour le chargement de nouveaux
calques.
* L’aperçu de l’animation a un bouton de lecture
* Cliquer sur les numéros de palette ouvre la fenêtre « Palette Editor ».
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* L’aperçu du collage respecte désormais le masque de protection de la palette.
* Fenêtre Transformer la couleur – Ajout du contrôle de la teinte
* Fenêtre Transformer la couleur – Option de palette sélective
* L’annulation est moins gourmande en mémoire lors de l’ajustement de la palette.
* Réécriture majeure du code back-end pour améliorer les performances.
* L’éditeur de couleurs A/B utilise désormais le dialogue de couleurs de GTK+.
* Ctrl+Flèches redimensionne la zone de sélection
* Le remplissage par déluge a un mode flou – icône de clic droit pour les contrôles.
* L’enregistrement/le chargement des presse-papiers inclut désormais les données de masque.
* L’enregistrement d’une image de calque composite est maintenant découplé de l’enregistrement du fichier de
données de calque.
* La plupart de la documentation a été retirée de l’aide F1 et se trouve maintenant sous forme HTML.
* La documentation HTML est disponible en téléchargement séparé
* Listes de diffusion mtPaint mises en place – http://sourceforge.net/mail/?group_id=155874
* Le script configure ne fait aucune supposition sur le CPU -./configure --help
* BUGFIX – L’enregistrement d’une image composite ne laisse pas toujours des zones transparentes.
* BUGFIX – La transformation de la couleur de la palette avec l’aperçu (images RVB) fonctionne désormais
correctement.
* BUGFIX – La barre d’état est maintenant mise à jour après avoir supprimé tous les calques.
* BUGFIX – La mise à l’échelle d’une image en largeur/hauteur 1/2 ne provoque pas de crash.

2.31 2006-5-31
* Traduction allemande réalisée par Oliver Frommel

2.30 2006-3-1
*  L’animation  des  couches  est  maintenant  possible  –  voir  Animation  dans  la  documentation  pour  plus
d’informations.
* Les fichiers GIF animés peuvent maintenant être ouverts image par image si vous avez installé Gifsicle.
* Fichier→Exporter un GIF animé… peut créer un fichier GIF animé si vous avez installé Gifsicle.
* L’image peut maintenant être centralisée dans la fenêtre – Préférences→Zoom à basculer.
* Les fonctions de mise à l’échelle des images ont été améliorées et étendues par Dmitry Groshev.
*  Edit→Tint  Mode  ajouté  par  Dmitry  Groshev –  voir  le  bas  de  la  section  Tools  dans  la  docs  pour  plus
d’informations.
* Code de contour d’ellipse amélioré par Dmitry Groshev
* Sélection→Alpha Blend A, B : voir le tutoriel du site web pour l’exemple.
* Divers tutoriels ajoutés au site web
* BUGFIX – L’outil Clone ne se comporte pas mal lorsqu’on le fait glisser au-delà du bord de l’image avec la
touche CTRL enfoncée.
* BUGFIX – La rotation du texte devrait maintenant fonctionner correctement sous Windows XP.
* BUGFIX – Les fichiers avec des caractères UTF8 dans les noms de fichiers peuvent maintenant être ouverts
sous Windows.
* BUGFIX – Résolution de l’oscillation de la barre d’état avec certains systèmes Windows
* BUGFIX – Collage de texte + masque de sélection + zoom ne perd pas le masque
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2.20 2006-1-1
* Le site web de mtPaint est maintenant sur http://mtpaint.sourceforge.net/
* La fenêtre de visualisation fait maintenant partie de la fenêtre principale – la touche V permet d’activer ou de
désactiver la fenêtre.
* Ctrl+flèches ou Ctrl+Shift+flèches déplace un calque.
* View→Set Zoom window définit le zoom de la fenêtre principale/de la fenêtre de vue + focus toggle – la
touche Z permet d’activer/désactiver le zoom.
* La mise à l’échelle de la palette utilise désormais la couleur A/B comme couleur et index de début et de fin.
* Les fichiers de palette Gimp (*.gpl) peuvent maintenant être chargés/enregistrés via le menu Palette.
* Si le fichier ~/mtpaint.gpl existe, il est chargé comme palette par défaut au démarrage.
* Les informations GIF transparentes peuvent maintenant être chargées/sauvegardées + améliorations générales
de l’importation GIF.
*  Les  pixels  transparents  dans  la  zone  d’édition  principale  sont  maintenant  des  damiers  gris  en  mode
monocouche.
* Le comptage de toutes les couleurs RVB nécessite désormais 2 Mo et non plus 16 Mo.
* Les icônes personnalisées peuvent maintenant être compilées pour mtPaint – voir./src/icons1/README pour
plus de détails.
* Le nombre maximum de couches est passé à 100
* L’installation du binaire Windows a été simplifiée avec le setup.exe standard.
* BUGFIX – Quand on change d’outil avec la touche fonction, le périmètre de la brosse est maintenant effacé
correctement.

2.10 2005-11-20
* Support des tablettes sensibles à la pression via la fenêtre Préférences, voir Outils dans la documentation.
* Histogramme de couleur ajouté à la fenêtre d’information (Ctrl-I)
* Ajout de la méthode Palette→Create Quantized (Wu) – Bonne pour les petites palettes, par exemple 32.
* Amélioration de la fenêtre Convert to Indexed
* La fenêtre d’affichage a maintenant une bascule de mise au point pour rester verrouillé sur la position centrale
de la fenêtre principale.
* La fenêtre d’information compte maintenant toutes les couleurs dans les images RVB – si 16 Mo de mémoire
sont disponibles.
* La fenêtre des préférences est maintenant non-modale et possède un bouton d’application.
* Simplification du fichier./src/Makefile
* Traduction en portugais brésilien réalisée par Paulo Trevizan
* BUGFIX – fuite mémoire corrigée avec DL1 Quantize & Floyd-Steinberg
* BUGFIX – erreur de segmentation corrigée lors de l’appui simultané sur les touches * et – dans la fenêtre
panoramique
* BUGFIX – Correction d’une erreur de segmentation lors de l’utilisation de systèmes de fichiers en lecture
seule sans accès en écriture à ~/.mtpaint.
* BUGFIX – segfault corrigé lors du chargement de certains GIFs animés – message d’avertissement à la place.

2.03 2005-9-23
* BUGFIX – Résolution d’une erreur de segmentation rare lors du déplacement d’un calque vers le haut/bas
sans fenêtre de visualisation affichée

2.02 2005-9-19
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* Les fichiers PNG avec une transparence peuvent maintenant être chargés et sauvegardés – Voir Limitations.
* View→Show zoom grid – Paramètres définis dans la fenêtre Préferences→Zoom
* La fenêtre « Enregistrer sous » a été améliorée avec de nouveaux widgets d’attributs de fichiers.
* Changements dans la barre d’état – (T= ?) pour les transparences, x dans la géométrie de sélection.
* Projet mtPaint enregistré avec Launchpad/Rosetta pour aider avec les traductions :
https://launchpad.net/products/mtpaint/+traductions
* Traduction partielle en français par Nicolas Velin.
* Traduction partielle en portugais par Israel G. Lugo.
*  BUGFIX –  Le copier/coller  en  mode  auto  commit  suivi  de  l’outil  de  peinture  ne  dessine  pas  de  ligne
supplémentaire.

2.01 2005-8-14
* BUGFIX – Résolution d’une erreur de segmentation occasionnelle lors du chargement et de l’affichage de
tous les calques dans la fenêtre principale.
* BUGFIX – Version Windows : la capture d’écran masque maintenant la nouvelle fenêtre d’image.

2.00 2005-8-7
* Affichage→Fenêtre des calques – Voir Calques dans la documentation pour plus d’informations.
* Edition→ Coller vers un nouveau calque
* Outil de sélection de polygone ajouté – Voir Sélections dans la documentation pour plus d’informations.
* Sélection→Lasso Sélection & Coupe
* Outil de clonage ajouté – Voir Outils dans la documentation pour plus d’informations.
* La fenêtre d’affichage dispose désormais d’une fonction de zoom
* L’outil Ligne permet maintenant de dessiner une pointe de flèche – Voir Outils dans la documentation pour
plus d’informations.
* Les noms de fichiers relatifs passés à la ligne de commande sont maintenant convertis en absolus.
* GTK+2 : La capture d’écran via la nouvelle fenêtre d’image réduit d’abord la fenêtre principale.
* Basculement des préférences pour valider le collage lors du changement d’outil
* Raccourcis clavier pour les fichiers récemment utilisés – Shift+Ctrl+F1 = Revenir en arrière
* Icônes de la barre d’outils retravaillées pour accueillir les fonctions les plus couramment utilisées.
* BUGFIX – Les fichiers PNG en niveaux de gris sont maintenant chargés correctement.

0.97 2005-6-4
* Outil Texte : Anti-crénelage sans couleur de fond maintenant possible (bords mélangés par alpha)
* Outil Texte : Le changement de couleur/motif pendant le collage met à jour le texte
* Outil Texte : Commandes indépendantes pour la couleur de fond et la rotation
* Les modifications sont signalées dans la barre de titre
* Brosses et motifs augmentés à 81
* Taille/flux maximal des outils porté à 200
* La logique de l’éditeur A/B de couleurs a été améliorée pour les images RVB.
* Les documents d’aide sont désormais pris en charge avec les fichiers po internationaux.
* Amélioration de la précision de la brosse circulaire en mode continu
* La spécification d’un CPU est maintenant plus générique – voir « ./configure --help ».
* BUGFIX – Le chargement d’une grande image ajuste maintenant correctement les barres de défilement.
* BUGFIX – Amélioration des caractères tchèques sous Windows
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0.95 2005-5-4
* Outil texte ajouté – Voir Outils pour l’utilisation.
* La fenêtre d’affichage est maintenant disponible via le menu Affichage ou la touche V.
* Les présélections de pinceaux sont maintenant disponibles via le menu Edition, F3, l’icône de la barre d’outils
ou la zone d’aperçu.
* Possibilité de faire des captures d’écran – « mtpaint – s » ou File→New – Voir la section Tips.
* Le bouton droit de la souris permet de peindre avec A/B inversé.
* Palette→Echanger A & B
* La molette de la souris permet d’effectuer des zooms avant/arrière si cela est défini dans les préférences –
GTK+2 uniquement.
* Les touches de fonction ne zooment plus – utilisez les chiffres 1-9 à la place.
* Divers nouveaux raccourcis clavier ajoutés/changés
* La refonte du site web a été réalisée par Abdulla Al Muhairi.
* BUGFIX – Xine ne ferme plus le popup de la fenêtre panoramique et du sélecteur de modèle.
* BUGFIX – Les collages sont parfois éliminés.
*  BUGFIX  –  La  fenêtre  d’édition  de  toutes  les  couleurs  fonctionne  maintenant  correctement  lorsque  la
profondeur d’écran est inférieure à 24 bpp.

0.90 2005-4-12
* L’internationalisation est maintenant supportée avec « ./configure intl ».
* Traduction en espagnol par l’équipe Guadalinex
* Traduction tchèque réalisée par Pavel Ruzicka.
* La fenêtre des préférences permet de sélectionner manuellement les traductions des langues.
* Page de manuel contribuée par l’équipe Guadalinex – « ./configure man » pour l’installation
* Le collage avec une opacité inférieure à 100 % montre maintenant un aperçu de la transparence résultante.
*  Amélioration  du comportement  des  widgets  dans  les  fenêtres  de  quantification  et  de transformation  des
couleurs.
* Les touches Page Up/Down fonctionnent maintenant comme prévu dans la fenêtre de la ligne de commande.
* L’outil de modification ne sollicite pas autant le CPU sur les matériels plus anciens.
* Amélioration de la précision de l’outil ligne et du cercle en mode continu lorsque la taille est supérieure à 1.
* La géométrie maximale est maintenant de 16384x16384.
* Nouvelle police de caractères pour les numéros de palette
* Plusieurs options supplémentaires du script de configuration ont été ajoutées – « ./configure --help » pour plus
de détails.
* BUGFIX – Les remplissages par inondation de motifs fonctionnent maintenant dans toutes les conditions.
*  BUGFIX –  Dans  GTK+2,  les  noms  de  fichiers  avec  des  caractères  non  ASCII  sont  maintenant  traités
correctement.
* BUGFIX – La tentative de remplissage sur une couleur protégée ne fixe pas l’opacité à 100 %.
* BUGFIX – Ctrl -/+ ajuste l’opacité comme prévu initialement
* BUGFIX – Undo/Redo sur une image indexée avec smudge ne provoque pas de segfault.

0.75 2005-2-15
* Ajout d’une fenêtre panoramique – Voir Outils pour l’utilisation.
* Le masque de protection des couleurs fonctionne maintenant avec les images RGB.
* Sélection→Ellipse de contour + Nouvelle icône : Epaisseur = taille de l’outil
* Amélioration de la conversion des images RVB en images indexées :
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* i) L’option Exact utilise maintenant moins de mémoire et est légèrement plus rapide.
* ii) La précision de la méthode Dither est maintenant meilleure.
* iii) Ajout de l’option Floyd-Steinberg
* iv) Options de quantification de palette DL1 & DL3 ajoutées avec [out] Floyd-Steinberg
* Palette→Créer une quantification (DL1 & DL3) : Images RVB uniquement
* Palette→Sort→Frequency : Trie une palette indexée par fréquence de pixels sur le canevas
* La fenêtre de tri de la palette possède un bouton d’application
* Fichier→Exporter des images annulées (inversé)
* Amélioration de la fenêtre Transformer la couleur :
* i) Ajout d’un bouton d’application
* ii) Commutateurs pour transformer l’image RVB et/ou la palette
* iii) Le gamma a été déplacé vers le haut et est maintenant la première opération à effectuer.
* iv) La fenêtre s’ouvre maintenant là où le pointeur de la souris est positionné.
* v) Les touches Retour/Entrée appuient maintenant sur le bouton OK.
* Ajout d’une section de conseils dans le fichier README et l’aide
* La fenêtre de progression est maintenant mobile et ne reste pas au-dessus des autres fenêtres.
* Le script de configuration a été amélioré pour tenir compte des systèmes sans pkg-config, c’est-à-dire GTK+1
uniquement.
* BUGFIX – Les fuites de mémoire dans read_png & read_jpeg ont été nettoyées.
* BUGFIX – Les fichiers PNG et JPEG corrompus sont maintenant gérés correctement.
* BUGFIX – L’invisibilité de la mise à jour de la zone de la palette sur certains systèmes a été corrigée
* BUGFIX – Le saccadage des barres de défilement verticales/horizontales lors du zoom a été éliminé
* BUGFIX – Le zoom dans GTK+1 respecte désormais le centre de zoom spécifié.
* BUGFIX – Lors du collage, le scintillement du curseur sur du matériel lent a été éliminé

0.50 2005-1-1
* Outil d’estompage – images RVB uniquement, modes continu ou non continu.
* Image→Rotation libre : Rotation de l’image à n’importe quel angle
* Sélection→Masquage de la couleur A, B : Voir Sélections dans README/Help pour un exemple.
* Sélection→Démasquer la couleur A, B.
* Sélection→Masquer toutes les couleurs
* Sélection→Clear Mask : Retour à la pâte rectangulaire opaque normale.
* Le comptage des pixels RVB uniques est plus rapide (particulièrement dans GTK+2).
* La géométrie de la sélection sur la barre d’état montre maintenant aussi l’angle de la diagonale de la sélection
et sa longueur.
* Préférences→Forcer le zoom à 100 % ou le zoom actuel avec un nouveau fichier.
*  Les  chiffres  1-9  définissent  le  zoom,  Insert=Transformation  des  couleurs,  Delete=Crop,  Page
Up/Down=Scale/Resize.
* Les touches 1-9, +, –, =, Q, Home, Insert, etc. fonctionnent lorsque la fenêtre Command Line est sélectionnée.
* La compilation fonctionne maintenant avec gcc-2.95 et libpng-1.0.
* Le script de configuration contient un exemple de la façon de compiler avec Slackware 8.0.
* Undo/Redo arrête le collage en cours uniquement lors du passage de/à Indexed/RGB.
* BUGFIX – Des avertissements Pango occasionnels dans GTK+2 au démarrage ont été arrêtés.
* BUGFIX – Lorsque undo/redo efface le collage, le curseur n’est pas bloqué en tant que flèche à 4 voies.
* BUGFIX – Le dernier pixel d’une ligne droite est maintenant peint si la taille est égale à 1

Page 103/113



0.47 2004-12-11
* View→10 %, 25 %, 50 % : les touches +, -/= peuvent être utilisées pour obtenir un zoom inférieur à 100 %.
* View→Toggle Image View (Home key) : Affiche/masque la palette, le menu, la barre d’état, etc.
* View→Command Line Window : Affiche les fichiers passés en ligne de commande (si > 1).
* Effets→Transformations isométriques
* Palette de couleurs : Shift + clic/déplacement déplace une couleur vers un nouvel index.
* Effet de postérisation fusionné avec la fenêtre de luminosité/contraste/saturation→Transformer la couleur.
* Gamma ajouté à la fenêtre Transformer la couleur
* L’utilisation de « mtpaint – v » ou l’appel à partir d’un autre nom binaire permet d’afficher l’image complète.
* Méthode de redimensionnement de la sélection améliorée + bouton droit = effacer
* Limitation relative à la couleur de remplissage de l’inondation résolue pour la plupart des situations.
* L’utilisation des touches fléchées pendant la peinture change la couleur A/B.
* Edit→Opacity Undo Mode (F12) remplace l’option Préférences.
* Les niveaux de gris sont maintenant dans le menu Effets
* La touche Escape sélectionne maintenant le premier bouton de la boîte d’alerte.
* L’outil par défaut est maintenant la sélection
* Les icônes de la barre d’outils de couleur ont été regroupées
* Raccourcis clavier ajoutés pour le recadrage, la transformation des couleurs, l’inversion et l’échelle de gris.
* Options du compilateur modifiées – binaire plus rapide/plus petit
* BUGFIX – Undo/Redo vers indexé/RGB pendant que coller RGB/indexé ne cause pas de segfault.

0.45 2004-11-21
* L’opacité des outils est maintenant variable, ce qui permet de peindre subtilement en RVB.
* Effets→Détection des bords, Accentuation, Adoucissement, Flou, Embossage.
* La mise à l’échelle d’une image RVB 24 bits est maintenant plus fluide.
* Image→Convertir en index : Conversion exacte, Palette quantifiée, Dithering, Scattered.
* Enregistrement de fichiers TIFF (RVB non compressé)
* Sauvegarde des fichiers GIF (non compressé indexé 256 couleurs)
* Sauvegarde des fichiers BMP (non compressés indexés et RGB)
* Fichier→Exportation d’images défaites
* Fichier→Exportation de l’art ASCII
* Palette→Add Colours a été changé en Set Palette Size, c’est-à-dire que la réduction est maintenant possible.
* Fichier→Enregistrer sous : Si l’image a un nom de fichier, mettez-le dans la case du nom de fichier.
* Lors du chargement d’un png/tiff/jpeg/gif, n’utilisez la barre de progression que si l’image est grande.
* Le bouton du milieu de la souris définit le centre du zoom
* Image→Préférences : La touche Q peut maintenant quitter mtPaint
* Amélioration de la cohérence des pointeurs de la souris (Spray/shuffle)
* BUGFIX – La rotation de l’image sans mémoire d’annulation ne provoque pas de corruption de l’image.
* BUGFIX dans GTK+2.4 – Appuyer sur entrée pendant le collage n’appuie pas sur le bouton de la barre
d’outils.

0.40 2004-11-8
* Fichier→Nouveau : Créer une image RVB 24 bits
* La plupart  des fonctions/outils  fonctionnent maintenant  sur un canevas RVB 24 bits  (sauf le masque de
protection des couleurs)
* Chargement/enregistrement de fichiers PNG 24 bits RVB
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* Chargement de fichiers JPEG 24 bits RGB/Greyscale, enregistrement de fichiers JPEG 24 bits RGB – Qualité
définie par les préférences.
* Chargement de fichiers TIFF
* Chargement de fichiers BMP non compressés
* Image→Convertir en RVB
* Image→Convertir en indexé
* Edition→Charger le presse-papiers→1-12
* Edition→Sauvegarder le presse-papiers→1-12
* De nouvelles icônes ont été ajoutées à la barre d’outils.
* Le menu Fichier contient maintenant une liste des fichiers récemment utilisés – Définir la limite dans la
fenêtre Préférences (0-20)
* Hauteur/largeur maximale de la toile fixée à 8192, minimum fixé à 1.
* Le dernier répertoire chargé depuis la ligne de commande est maintenant correctement mémorisé.
* Palette→Charger par défaut
* BUGFIX – Le redimensionnement et la mise à l’échelle sans mémoire d’annulation ne provoquent pas de
défaut de segmentation.
* BUGFIX – L’utilisation d’un outil statique après un redimensionnement, une mise à l’échelle ou une rotation
ne crée pas de formes indésirables.
* BUGFIX – Un crash occasionnel lors de l’utilisation du sélecteur de couleur GTK+ a été corrigé.

0.37 2004-10-25
* Image→Luminosité-Contraste-Saturation
* Image→Scale Canvas
* Image→Redimensionnement du canevas
* Image→Préférences : L’utilisateur peut spécifier quelles informations sont affichées dans la barre d’état.
* Image→Rotation dans le sens des aiguilles d’une montre
* Image→Rotation dans le sens inverse des aiguilles d’une montre
* Sélection→Rotation dans le sens des aiguilles d’une montre
* Sélection→Rotation dans le sens inverse des aiguilles d’une montre
* Aide→A propos (F1) : Reflète le fichier README actuel
* Fichier→Nouveau : L’utilisateur peut maintenant créer une image en niveaux de gris.
* Palette→Éditer toutes les couleurs
* Palette→Create Scale : Créer des couleurs mélangées d’un index à l’autre.
* Palette→Trier
* Image→Effet Bactérie : Essayez-le plusieurs fois avec « mtpaint graphics/bacteria.png ».
*  Géométrie  de  la  fenêtre  de  sélection  de  fichier  stockée  indépendamment  de  la  géométrie  de  la  fenêtre
principale
* BUGFIX – La fenêtre de progression apparaît maintenant au-dessus du sélecteur de fichiers dans GTK+2
Windows/Gnome.
* BUGFIX – La maximisation de la fenêtre de l’éditeur de couleur A/B ne provoque pas de segfault ou de
corruption de la fenêtre.

0.35 2004-10-16
* Les sources peuvent maintenant être compilées avec MinGW/MSYS pour créer une version Windows de
mtPaint.
* Les images XPM et XBM peuvent maintenant être chargées et sauvegardées.
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* Fichier→Préférences : L’utilisateur peut voir/régler la transparence/les points chauds des images XPM/XBM.
* Outil de ligne droite ajouté à la barre d’outils
*  Le  menu  Image  contient  maintenant  les  options  suivantes :  Convertir  en  niveaux  de  gris,  Postériser,
Information, Préférences et Recadrage.
* Image→Flip Vertical
* Image→Flip Horizontal
* Image→Inverser
* Sélection→Inversion verticale
* Sélection→Inversion horizontale
* Les niveaux d’annulation et de rétablissement sont affichés dans la barre d’état.
* La barre de progression est maintenant utilisée pour le chargement, l’enregistrement et le retournement – utile
pour les grandes images ou les machines lentes.
* La taille minimale de la fenêtre principale a été fixée pour que les écrans 640x480 puissent utiliser mtPaint.
* Le réglage du centre du zoom nécessite maintenant le bouton Shift+Droit – Evite les collisions avec les outils
de collage/traçage.
* BUGFIX – L’échec de la sauvegarde n’efface plus le drapeau mem_changed.
* BUGFIX – La précision des niveaux maximum d’annulation a été améliorée dans la fenêtre d’information.
* BUGFIX – Mise à jour des menus lors du chargement d’un fichier depuis la ligne de commande (pas d’option
pour recadrer en 1x1)

0.30 2004-10-4
* Les images GIF peuvent maintenant être chargées dans mtPaint.
* Amélioration des pointeurs de souris pour les formes statiques
* Le menu Sélection contient maintenant « Select All », « Select None ».
* Selection→Outline Rectangle : Dessine un contour de pixels de taille outil autour de la sélection courante.
* Selection→Filled Rectangle : Remplit la zone de sélection actuelle.
* Selection→Filled Ellipse : Dessine une ellipse remplie à l’intérieur de la zone de sélection actuelle.
* Selection→Line – Slash : Dessine une ligne droite sur la sélection du haut à gauche au bas à droite.
* Selection→Line – Backslash : Dessine une ligne droite sur la sélection de haut en bas à droite.
* Edit→Continuous Painting : Rend la peinture des 6 formes statiques continue et lisse.
* La barre d’état contient CON pour indiquer si le programme est en mode de peinture continue.
* La fenêtre d’information contient maintenant des détails sur les données actuelles du presse-papiers.
* Ctrl+Bouton de gauche pendant le survol de la palette définit  la couleur B (utile pour les utilisateurs de
stylet/tablette).
* Le script de configuration a été étendu – utilisez « /configure --help » pour plus de détails.
* BUGFIX – La sélection de None pendant le collage avec un zoom élevé n’utilise pas le CPU
* BUGFIX – Le changement d’outil pendant le collage avec un zoom élevé ne sollicite pas le processeur.
* BUGFIX – Coller alors que l’on est déjà en train de coller avec un zoom élevé ne provoque pas la fin du
programme.
* BUGFIX – Le périmètre de sélection/collage n’est pas corrompu dans GTK+2 lors de l’utilisation de barres
de défilement.

0.25 2004-9-24
* Palette→Convert To Greyscale : Convertit la palette courante en échelle de gris.
* Edit→Crop : Recadre le canevas selon la sélection actuelle
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* La boîte de sélection rouge/blanche peut maintenant être redimensionnée en cliquant sur les coins et en les
faisant glisser.
* La géométrie de la sélection est maintenant affichée dans la barre d’état.
* Démarrer avec une toile vierge si le fichier n’a pas été chargé avec succès depuis la ligne de commande.
* Enter/Return commet maintenant un collage même si Shift/Ctrl sont pressés.
* Le chargement d’une palette peut maintenant être annulé ou refait.
* BUGFIX – Les erreurs lors de la tentative d’enregistrer sous sont maintenant traitées correctement.
* BUGFIX – Appuyer sur CTRL et déplacer la souris sans appuyer sur un bouton ne taxe pas le CPU
* BUGFIX – Le chargement d’une palette de 256 couleurs est maintenant possible.
* BUGFIX – L’élément de menu Paste To Centre se comporte désormais comme prévu.
* BUGFIX – L’indicateur mem_changed est maintenant effacé correctement après la sauvegarde – plus de faux
avertissements.
* BUGFIX – Correction d’une erreur de segmentation lors de la découpe pendant un collage (amélioration de la
logique du menu d’édition).
* Select/Paste utilise maintenant moins de CPU et ne scintille pas autant
* Le système d’annulation a été réécrit :
* Accepte les changements de géométrie dus au recadrage
* La mémoire n’est mallocée qu’en fonction des besoins, pas en masse au début.
* Le périmètre de l’outil montre la position correcte quand la souris est sur le fond gris.

0.24 2004-9-19
* Makefile – Les options du compilateur par défaut ont été changées pour ne pas faire d’optimisations.
* Préférences→Option pour montrer le curseur de la souris comme forme de l’outil.
* Préférences→Confirmation de l’alerte de sortie maintenant optionnelle
* Si vous quittez/ouvrez/nouveau fichier sans sauvegarder les modifications, l’utilisateur est averti.
* Liste TODO dans le README mise à jour avec mes projets pour les prochains mois.
* Fichier→Enregistrer sous : raccourci Shift+Ctrl-S.
* Outil de sélection ajouté à la barre d’outils
* Édition→Couper
* Édition→Copier
* Édition→Coller au centre
* Edition→Coller
* Edit→Select All
* Edit→Select None
* Préférences→Option pour ne pas afficher l’image du presse-papiers lors du collage.
* README mis à jour avec des détails sur la sélection, copier, couper, coller, etc.
* BUGFIX dans memory.c – la postérisation correcte se produit maintenant, que l’on utilise – ffast-math ou
non.
* BUGFIX dans GTK+1 – les raccourcis CTRL ne sont plus bloqués par les boutons de taille et de vaporisation.
* Première version publique de mtPaint sur gnomefiles.org

0.23 2004-9-13
Première version publique de mtPaint sur freshmeat.net

0.21 2004-9-6
Début des tests bêta !
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0.20 2004-9-5
9 outils de base + palette edit/add/posterize/merge/load/save terminée

0.16 2004-8-31
Undo/Redo implémenté – par défaut MAX_UNDO = 100

0.15 2004-8-28
Implémentation des motifs avec l’outil carré + implémentation du masque de protection des couleurs

0.05 2004-8-14
Chargement PNG + fonctions d’affichage et de zoom des images

0.04 2004-8-12
Correction de la structure du programme

0.02 2004-8-7
Correction de l’interface graphique

0.00 2004-7-4
Début du projet – Conception de l’interface graphique et du back-end sur papier et dans Glade.
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Annexe D – Le fichier README de mtPaint
--------------------------------------------------

mtPaint 3.40 – Copyright (C) 2004-2011 Les Auteurs
--------------------------------------------------

Voir la section Crédits pour la liste des auteurs.

mtPaint est  un logiciel  libre ;  vous pouvez le redistribuer et/ou le modifier selon les termes de la Licence
Publique Générale GNU telle que publiée par la Free Software Foundation ; soit la version 3 de la Licence, soit
(à votre choix) toute version ultérieure.

mtPaint est distribué dans l’espoir qu’il sera utile, mais SANS AUCUNE GARANTIE ; sans même la garantie
implicite de COMMERCIALISATION ou d’ADÉQUATION À UN USAGE PARTICULIER. Voir la Licence
Publique Générale GNU pour plus de détails.

mtPaint est un simple programme de peinture GTK+1/2 conçu pour créer des icônes et des œuvres d’art basées
sur des pixels. Il peut éditer des palettes indexées ou des images RVB 24 bits et offre des outils de base pour la
peinture et la manipulation des palettes. Il dispose également de plusieurs autres fonctionnalités plus puissantes
telles que les canaux, les couches et l’animation. En raison de sa simplicité et de l’absence de dépendances, il
fonctionne bien sur GNU/Linux, Windows et les anciens matériels PC.

Il existe une documentation complète des fonctionnalités de mtPaint, contenue dans un manuel. Si vous ne
l’avez pas encore, vous pouvez le télécharger sur le site web de mtPaint.

Si vous aimez mtPaint et que vous voulez rester au courant des nouvelles versions, ou si vous voulez donner
votre avis, alors les listes de diffusion peuvent vous intéresser :

http://sourceforge.net/mail/?group_id=155874

-----------
Compilation

-----------

Afin de compiler mtPaint sur un système GNU/Linux, vous devez disposer des bibliothèques et des en-têtes
pour GTK+1 et/ou GTK+2, libpng et zlib. Si vous voulez charger ou sauvegarder des fichiers GIF, JPEG et
TIFF,  vous  aurez  également  besoin  de  libungif,  libjpeg  et  libtiff.  Si  vous  voulez  compiler  la  version
internationale,  vous  devrez  avoir  installé  le  système  gettext  et  les  en-têtes.  Vous  pouvez  alors  ajuster  le
Makefile/sources pour répondre à vos besoins et ensuite :

Pour GTK+2
=========

./configure
make
su –c "make install"
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Pour GTK+1
=========

./configure gtk1
make
su –c "make install"

Si vous voulez désinstaller ces fichiers de votre système, vous devez taper :

su –c "make uninstall"

Il y a plusieurs options de configuration qui peuvent être utiles pour certaines personnes. Utilisez « ./configure
--help » pour découvrir les options disponibles. Si vous compilez un binaire pour le distribuer sur d’autres
systèmes, l’option asneed est particulièrement utile (si l’option gcc –Wl,--as-needed est disponible, c’est-à-dire
binutils >=2.17), car elle ne crée que des liens vers les bibliothèques qui sont absolument nécessaires à mtPaint.
Par  exemple,  sans  cette  option,  si  vous  compilez  mtPaint  avec  GTK+2.10,  vous  constaterez  qu’il  ne
fonctionnera pas sur les systèmes GTK+2.6 car Cairo n’existe pas sur l’ancien système.

Utilisez « ./configure release » pour compiler mtPaint avec les mêmes optimisations que nous utilisons pour les
paquets de distribution ; ceci inclut l’option asneed. Pour activer l’internationalisation, ajoutez l’option intl.

Si  vous  compilez  mtPaint  sur  un  ancien  système  sans  gtk-config,  vous  devrez  peut-être  ajuster  le  script
configure pour que les réglages de GTK+1 soient faits manuellement. J’ai fourni un exemple dans le script
configure pour le démontrer.

Vous pouvez appeler mtpaint avec l’option –v et le programme démarrera en mode visualisation, il n’y aura
donc pas de palette, de barre de menu, etc. Vous pouvez restaurer ces éléments en appuyant sur la touche Home.
Après l’installation vous pouvez créer un lien symbolique pour ajouter une commande de visualisation, par
exemple

su –c "ln –s mtpaint /usr/local/bin/mtv"

Ensuite vous pouvez ouvrir des fichiers graphiques avec « mtv *.jpg ». C’est un raccourci pour écrire « mtpaint
–v *.jpg ». mtPaint ne peut éditer qu’une image à la fois, mais lorsque vous avez plus d’un nom de fichier dans
la ligne de commande, une fenêtre apparaîtra avec tous les noms de fichiers dans une liste. Si vous sélectionnez
un des noms, il sera chargé. Je trouve cela utile pour éditer plusieurs icônes ou photos numériques.

Après avoir  lancé mtPaint  pour la  première fois,  un nouveau fichier est  créé pour stocker  vos  paramètres
préférés et les fichiers précédemment utilisés, etc. Ce fichier est nommé « mtpaint » et stocké dans le répertoire
personnel de l’utilisateur. Si vous renommez ou supprimez ce fichier, la prochaine fois que mtPaint sera lancé,
il utilisera les paramètres par défaut.

La façon la plus simple de compiler mtPaint pour Windows est d’utiliser le compilateur croisé MinGW sur un
système GNU/Linux, et le script shell « winbuild.sh » inclus. Le script compilera mtPaint et tous les fichiers
d’exécution  nécessaires  à  partir  du  code  source,  et  préparera  un  paquetage  binaire  et  un  paquetage  de
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développement séparé, avec les en-têtes et les bibliothèques de développement ; voir « gtk/README » pour
plus de détails.

Une autre alternative est de faire une construction manuelle avec MinGW sur GNU/Linux, pour laquelle vous
devrez  avoir  installé  les  bibliothèques  et  les  fichiers  d’en-tête  requis,  correspondant  aux  bibliothèques
d’exécution que vous avez l’intention d’utiliser. Depuis la version 3.40, le paquetage officiel de mtPaint pour
Windows utilise des fichiers d’exécution personnalisés, ainsi que des bibliothèques de développement et des en-
têtes,  produits  dans  le  processus  de construction  automatique décrit  ci-dessus ;  avec la  version 3.31 et  les
versions  antérieures,  vous  pouvez  utiliser  les  paquets  listés  ci-dessous  pour  la  construction  avec
MinGW/MSYS. Dans tous les cas, une fois que les en-têtes et les bibliothèques sont installés là où MinGW les
attend, vous configurez mtPaint pour la compilation croisée, puis exécutez make comme d’habitude. Comme
ceci :

PATH=/usr/i586-mingw32/bin:$PATH./configure --host=i586-mingw32 [options]
make

Il devrait également être possible de compiler mtPaint pour Windows à l’ancienne, en utilisant MinGW/MSYS
sur un système Windows. Cependant,  cela n’a pas été fait  depuis un certain temps, donc la description ci-
dessous  se  réfère  toujours  aux  anciennes  versions  de  MinGW,  MSYS  et  des  paquets  de  bibliothèques.
mtpaint.exe  compilé  selon  cette  description,  ne  sera  compatible  qu’avec  les  bibliothèques  du  runtime
empaquetées avec mtPaint 3.31 ou plus ancien ; pour utiliser le runtime plus récent (de la version 3.40+), vous
devrez utiliser les fichiers de bibliothèques et d’en-têtes produits lors de la compilation croisée du runtime (voir
ci-dessus).

Si  vous  voulez  faire  cela,  vous devez d’abord  télécharger  le  programme d’installation  de  mtPaint  3.31 et
installer les fichiers dans « C:/Program Files/mtPaint/ » et ensuite :

1) Installer MinGW et MSYS – http://www.mingw.org/
MinGW-3.1.0-1.exe – vers c:/MinGW/
MSYS-1.0.10.exe – dans c:/msys/

2)  Installer  les  paquets  du  développeur  GTK+2  (et  les  dépendances  comme  libpng)  –
ftp://ftp.gtk.org/pub/gtk/v2.6/win32/ et http://gnuwin32.sourceforge.net/packages.html

Pour GTK+2, vous devrez télécharger et extraire les fichiers zip suivants dans c:/msys :
• gtk+-dev-2.6.4.zip
• pango-dev-1.8.0.zip
• atk-dev-1.9.0.zip

Vous devrez également télécharger et extraire les fichiers zip suivants vers c:/msys :
• glib-dev-2.6.4.zip
• libpng-1.2.7-lib.zip
• zlib-1.2.1-1-lib.zip
• libungif-4.1.4-lib.zip
• jpeg-6b-3-lib.zip
• tiff-3.6.1-2-lib.zip
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Si vous voulez compiler  la  version internationnalisée,  vous devrez télécharger  et  extraire  dans c:/msys les
fichiers zip suivants depuis http://sourceforge.net/projects/gettext :

• gettext-runtime-0.13.1.bin.woe32.zip
• gettext-tools-0.13.1.bin.woe32.zip
• libiconv-1.9.1.bin.woe32.zip

Pour une raison quelconque, j’ai dû déplacer c:/msys/bin/msgfmt & xgettext vers c:/msys/local/bin/ afin de les
faire fonctionner correctement. Si vous avez des difficultés à faire fonctionner msgfmt, vous devrez peut-être
faire de même.

3) Téléchargez les dernières sources de mtPaint et décompressez-les dans c:/msys.

4) Pour compiler le code, vous devez ensuite utiliser MSYS pour « ./configure », puis « make » et « make
install ».

5) Si tout va bien, vous devriez avoir mtpaint.exe que vous pouvez exécuter en utilisant la même méthode que
celle décrite ci-dessus. Il se peut que vous ayez compilé mtPaint en utilisant des versions plus récentes des
bibliothèques, donc vous devrez peut-être changer les noms de fichiers, comme libpng12.dll→libpng13.dll et
libungif.dll→libungif4.dll.

Comme j’utilise très rarement Windows, je suis malheureusement incapable de supporter une autre version de
GTK+ que celle du paquetage officiel. En d’autres termes, alors que mtPaint devrait en principe être capable de
compiler et de fonctionner avec n’importe quelle version de GTK+2, seule la version packagée a subi de vrais
tests sous Windows, et a été corrigée pour corriger tous les bogues connus spécifiques à Windows.

-------
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-------
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